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About This Manual

About MCACES for Windows

MCACES for Windows is a Microsoft Windows-based software tool for
estimating construction costs.  MCACES has been developed by Building
Systems Design, Inc. as a component of the Tri-Service Automated Cost
Engineering System.

How to Use this Manual

For information on... See

Setup and Installation Chapter 1

An overview of MCACES Chapter 2

A step-by-step tutorial on building a
sample estimate

Chapter 3

Working with project databases Chapters 4-8

Working with supporting databases Chapters 9-14

Generating Reports Chapters 15

Toolbar and Menus Chapter 16

The on-line Help system Chapter 17

Microsoft Windows User Interface

MCACES for Windows runs in conjunction with Microsoft Windows.  The user
interface is based on and consistent with the industry standards for Windows
application programs.

For an introduction to Microsoft Windows, refer to your Windows documentation.
For practice on working with Windows programs, refer to the Windows Tutorial.
You can access this tutorial from the Program Manager Help Menu within
Windows.
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Chapter 1

Getting Started

Definition

MCACES (Micro Computer Aided Cost Engineering System) for Windows is a
Microsoft Windows-based software tool used to prepare detailed cost estimates for
construction projects.  It was developed by Building Systems Design, Inc. as a
component of the Tri-Service Automated Cost Engineering System (TRACES).
MCACES for Windows includes the same basic functionality and database structures
as the current DOS version, MCACES GOLD 5.30.  Please refer to Chapter 2,
MCACES Overview, for additional information on new features and differences from
MCACES GOLD 5.30.

 Throughout this document, MCACES for Windows will be referred to simply as
MCACES, except when it is being distinguished from MCACES GOLD 5.30.

In This Chapter

This chapter provides instructions for setup and initial use of MCACES.  The
following sections are included:

1.1  System Requirements

1.2  Installing MCACES

1.3  Starting and Operating MCACES

1.4  SHARE.EXE Considerations
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1.1  System Requirements
MCACES runs under the Microsoft Windows environment on IBM-compatible
personal computers.  Listed below are the hardware and software requirements for
operation of MCACES. As with any Windows application, faster system
components and more system memory will enable faster performance of the
software.  A higher resolution video card and monitor will enable more
information to be displayed on the screen.  See examples below to see the
difference resolution makes in a typical MCACES window.

Hardware Requirements

IBM-compatible 486-33 MHz or Faster Computer capable of running Microsoft
Windows applications.

16 MB System RAM

VGA or Higher Resolution Video Display Card and Monitor

Microsoft or Compatible Mouse

12 MB Available Disk Space

Windows-compatible Printer

Software Requirements

Microsoft Windows Version 3.1, Windows for Workgroups 3.11, Windows 95 or
Windows NT

Windows Driver for Video Card

Windows Driver for Printer

Notes:

• When installing or running any application under Windows 3.1 or Windows
for Workgroups 3.11, you can significantly increase performance by enabling
Microsoft’s Smartdrive disk caching for all hard and floppy drives.  Windows
95 and Windows NT automatically provide disk caching for all hard and
floppy drives.

• Other Windows applications should be closed before proceeding with the
installation.  This is because certain types of system software used in many
applications can interfere with the installation process.
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Figure 1.1 MCACES Screen in VGA (640x480) Resolution

Figure 1.2 MCACES Screen in Super VGA (800x600) Resolution
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Figure 1.3 MCACES Screen in Higher Resolution (1024x768)
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1.2  Installing MCACES

Subdirectories and Location of Files

During installation, you are prompted to specify the drive and directory where the
program will be installed.  By default, MCACES will be installed in
subdirectories under the C:\TRACES directory.  The installation process creates
the following:

TRACES - contains the following subdirectories:

TRACES\MCACES - stores the MCACES program files.

TRACES\ MCACES\PROJECT - recommended subdirectory for storing  your
project databases.

TRACES\ MCACES\DATA - recommended subdirectory for storing  your
supporting databases.

. TRACES\ MCACES\SYSDATA - contains files used by the software, not
directly accessed by the user.

TRACES\MCACES\TABLES - contains ASCII text files which are accessible
to the Get From Table capability.  Additional ASCII files may be placed there
by the user.

TRACES\ MCACES\EQTABLES - contains Appendix D ASCII text files used
in adding new equipment items.

Note: MCACES also copies certain files to the WINDOWS\SYSTEM directory.

4 example projects/templates are loaded into TRACES\MCACES\PROJECT:

CHAPEL, MILTMP2, CIVTMP, and HTWTMP.

Appendix B contains a list of all files used by MCACES, their location, and
approximate size.

Installation Procedure

MCACES is distributed on a set of 4 diskettes.  To install on a single user’s
computer, follow the instructions below.  Installation will take approximately 7
minutes to complete using the recommended hardware and software components
described above.  An installation transactions log is written to the file
MFWSETUP.LOG in the MCACES software directory and can be reviewed using
any text viewer.

Note: Please close any other applications during the installation process. This
applies especially to anti-virus software, as some anti-virus routines have
interfered with the MCACES installation process.  You may, of course, scan the
installation disks for viruses prior to running the install program.
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NOTE: If you are running a network-based version of Windows, and you receive
a message that the setup program cannot copy to the network Windows System
directory, you will need to contact your network administrator.  The probable
cause of this message is a write-protected Windows System directory.  The
MCACES application uses OLE2 technology and other common features of the
Microsoft Windows environment.  Support for these features must be installed in
the directory designated by Windows as the Windows System directory.  This
directory is identified at the start of the installation process shown in Fig. 1.4.
The network administrator will need to temporarily disable write-protection to
allow installation.  The MCACES installation does not erase or copy over any
files in the System directory.  A log of all installation transactions is maintained as
described above.

Single User Installation (or First Network User)

1. Start Microsoft Windows and access Program Manager.

2. Place the first Installation diskette in a floppy drive.

3. Choose Run from the Program Manager File Menu.

 Result:  The Run dialog box is displayed.

4. In the Command Line field, type A:\SETUP, (or B:\SETUP if you are using
floppy drive B), then press the Enter key.

 The MCACES installation window appears. Use the Tab key or mouse to
move to the New Installation Path entry box if you want to change the default
installation directory (for example to enter the network directory).  The
window defaults to the "New Installation from Floppy Disk" option in the
C:\TRACES\MCACES directory.  If you are installing the first network user
of a shared application setup, you will need to change the default directory to
a common network directory that can be accessed by all users.

5. Click the "Continue" button to begin copying files from the floppy disks to
the hard drive.
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Figure 1.4 MCACES Installation Application Selection Window

Additional Network User Installation

1. Make sure the selected applications have been installed to a network directory
using the "New Installation" option as described above.  This will install the
first network user.

2. Insert Disk 1 in the second user's floppy drive and start the setup program as
described above for a New Installation.

3. Click the Additional Network User option button.  Enter the network path
used to install the first user in the Existing Installation Path box.

4. Click the "Continue" button.

5. The setup program will check to see that the MCACES program resides in the
directory identified as the Existing Installation Path.  If MCACES is found,
the setup program will request Disks 1 and 2, and will copy common
Windows files to the additional user’s Windows System directory if they are
not already present.  Remaining Disks will not be needed.
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1.3  SHARE.EXE Considerations

Loading SHARE.EXE

To operate MCACES properly, you must have the DOS program SHARE.EXE
loaded prior to starting the software.  SHARE.EXE provides local hard disk
protection when running in an environment supporting multiple applications
simultaneously, as Windows does.  To run SHARE.EXE, exit Windows and type
the line shown below.  If you intend to run SHARE often, you may wish to add
the SHARE command to your AUTOEXEC.BAT file:

C:\DOS\SHARE.EXE /L:500 /F:5100

VSHARE.386 may be used instead of SHARE.EXE, provided that Windows 386
Enhanced Mode is selected, and that the version of VSHARE.386 used is
compatible with your operating environment (Windows 3.1, Windows for
Workgroups 3.1, or Windows for Workgroups 3.11).  VSHARE.386 is installed
as follows:

• Copy VSHARE.386 to C:\WINDOWS\SYSTEM (or the Windows System
subdirectory in use on your computer), if necessary.

• Using a text editor, add the following line to the [386Enh] section in your
SYSTEM.INI file in C:\WINDOWS (or the Windows directory in use on your
computer):

DEVICE=VSHARE.386

If you use VSHARE, you should remove the SHARE.EXE command from your
AUTOEXEC.BAT file, unless SHARE.EXE is required by any DOS applications
you use.
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1.4  Starting and Operating MCACES

Starting the Program

Once the installation procedure has been completed, the MCACES Program,
Help, and Release Notes icons will be inserted in a Windows Group called
TRACES Applications.  This group can be accessed by the Windows Program
Manager, normally the first application to appear when Windows is started.

To start MCACES, double-click on its Program Icon:

Result:  The program is loaded into memory and the opening screen is displayed
(Figure 1.5).

Figure 1.5  MCACES Opening Screen
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Note: The MCACES Help System can also be started from the Windows Program
Manager by double-clicking on the MCACES Help Icon, but Help is normally
accessed from within the MCACES software.

Operation of MCACES

The first step in MCACES operation usually is to open an existing project or to
begin a new project.

To open an existing project (or database of another type) either click on the File

Open button on the Tool bar   or select the Open choice from the File menu.
The Open dialog box which appears will help you navigate to the correct project
file (figure 1.6).  See chapter 8 for further information on the File Open process.

Hint: As a shortcut the last 4 projects or other databases you have already used
are displayed on the File Menu and may be opened by choosing from that menu.

Figure 1.6 Open Project Dialog Box
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To create a new project either click on the File New button on the Tool bar   or
select the New choice from the File menu.   The dialog box which appears will
help you create a new project file (figure 1.7).  See chapter 5 for further
information on creating new projects.

Note: Chapter 3 contains a quick start guide to building a sample estimate.

Figure 1.7 New Project Dialog Box

Saving Data

Data is automatically saved as changes are made (specifically once you have
moved the grid panel cursor off the line of data changed), so that a separate save
function is not necessary.  If use of the system is to be suspended for a period of
time, it is advisable to close the active MCACES databases or exit the software.

Exiting MCACES

Operation of the software may be terminated by selecting Exit under the File
Menu, or by double clicking the control menu box.  The control menu box in the
Windows 3.1 user interface is a bar symbol at the upper left of the MCACES
application window.  In the Windows 95 user interface, it is an “x” symbol at the
upper right corner.
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Chapter 2

 MCACES Overview

In This Chapter

Chapter 2 provides an introduction to the features in MCACES for Windows.
Section 2 includes a discussion of new features and differences between
MCACES for Windows and DOS-based MCACES GOLD 5.30.  Section 3 describes
ways to navigate throughout the software for most efficient operation, while
section 4 provides a look at other applications in the TRACES family of software
applications for Cost Engineers.

The following sections are included in this Chapter:

2.1  Introducing MCACES for Windows

2.2  What’s New

2.3  Navigation

2.4  Related TRACES Applications
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2.1  Introducing MCACES for Windows

Welcome to MCACES for Windows, the detailed cost estimating component of
the Tri-Service Automated Cost Engineering System.  This system has been
designed to make estimating software as easy to use as possible, while still
retaining the flexibility and power to handle the most demanding estimating tasks.

History

The U.S. Army Corps of Engineers and Department of Defense have over 15
years of investment in the development, testing, training, fielding, implementation
and support of the Computer Aided Cost Engineering System (CACES).  The last
nine years have been devoted to MCACES, the microcomputer-based version of
the system.  Districts and Divisions, both civil and military, have accepted and
adopted the MCACES system as their bread and butter cost engineering support.

Current Implementation

MCACES for Windows enhances the MCACES system to utilize the latest
graphical interface and state-of-the-art Microsoft Windows features.  MCACES
for Windows version 1.1 contains the basic functionality found in MCACES GOLD

version 5.30 (the latest DOS version), and is compatible with databases created in
5.30.

Some of the MCACES GOLD advanced options are not part of this release of
MCACES for Windows. MCACES GOLD 5.30 can continue to be used to
accomplish those tasks.  In fact, MCACES for Windows and MCACES GOLD may
be run concurrently under Windows and operate on the same databases
simultaneously.  See section 2.2 for a breakdown of the differences in capability
between MCACES for Windows version 1.0 and MCACES GOLD version 5.30.

3-Panel Display

The primary MCACES window is the 3-panel display, an example of which is
shown in Figure 2-1.  The three panels are known as Outline Panel, Grid Panel,
and Notes / Reference Panel.  Each database opened in MCACES will contain a
3-panel display.
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Toolbar

Menu Bar

Notes Panel

 

  Outline Panel   Grid Panel

Figure 2-1  3-Panel Display

Outline Panel

The MCACES Outline Panel (normally in the upper left of the display)
implements an outline view of the titles for the database selected.  Titles can be
expanded or contracted to aid in navigation and provide a view of  hierarchy
breakdown.  Descriptive data is displayed to identify unique features of each line.
See section 4.1 for a further description of the Outline Panel.
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Grid Panel

The Grid Panel normally occupies the bottom panel of the 3-panel display
scheme.  The contents may be either titles or details.  The Grid Panel is the
primary panel for performing work with a database.  An item must be highlighted
in the Grid Panel before modifications can be made to that item.  Items
highlighted in the Grid Panel are always one level below whatever is highlighted
in the Outline Panel.  Section 4.2 provides further information on the Grid Panel.

Notes/Reference Panel

The Notes/Reference Panel brings any of several different features within easy
reach in the upper right portion of the screen.  In addition to Notes, this panel can
also show Cost Summary, Owner Markups or Adjust Pricing at various title
levels. See section 4.3 for a further description of the Notes/Reference Panel.

Modifications

The 3-Panel display can be modified by the user as desired.  Section 4.4 describes
various ways to customize the organization and appearance of the display. This
can include resizing each of the panels to the most convenient size and
eliminating one or more of the panels from view.  The 3-panel display for a
particular database may also be minimized for later retrieval.

Menu Bar

The Menu Bar contains groups of selections which can be “pulled down” by
mouse or hot key. This provides a convenient way to choose the functions
necessary to operate MCACES.  The Menu Bar is further described in sections
16-2 through 16-8.

Toolbar

The Toolbar is a row of buttons which can be used as shortcuts to commonly used
functions.  These provide a faster way to access these functions than by using the
menu system.  Moving the mouse cursor slowly across the toolbar displays “tool
tips” boxes, which will assist you in remembering the functions included on the
toolbar. Consult section 16.1 for more details on the Toolbar.

MCACES Databases

The information used to produce MCACES estimates is stored in a series of
related databases. The Project Database is the work area in which the estimate is
developed.  Titles and detail items entered here represent the various costs for a
project, including Direct, Indirect, and Owner costs.

The other types of databases available with MCACES support the Project
Database.  Those databases are all used to store cost data that can be incorporated
into an estimate by copying it into the Project Database.  The supporting database
types are Unit Price, Crews, Labor Rates, Equipment Rates, and Assemblies.
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Display of Multiple Databases

More than one database can be displayed at the same time by using a horizontal or
vertical “tile” function to fit the multiple 3-panel displays.  Figure 2.2 shows an
example of a Unit Price Database and a Project database displayed in a
horizontally tiled screen.  This configuration is especially useful when using “drag
and drop” to copy between databases, for example when building a project
database from unit price items.  Use of a higher resolution video display system
will allow more detail to be displayed when using a tiled multiple database
display.

Figure 2-2  Multiple Database Display

Dialog Boxes

Additional information is added or modified by use of dialog boxes, which
display on top of the 3-panel display.  Two commonly used dialog boxes are the
Item Form and Summary Information.  The Item Form (see Figure 2-3) is used to
add or modify information for a title or detail item.  Summary Information (see
Figure 2-4) is used to add or modify overall information for the database.  See
sections 4.5 and 4.6 for further information on the Item Form and Summary
Information dialog boxes.
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Figure 2-3  Item Form Dialog Box

Figure 2-4  Summary Information Dialog Box
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Reports

MCACES provides extensive and flexible reporting capabilities.  You can use
these capabilities to produce detailed estimates and a wide range of summary and
backup reports for the projects created in MCACES.  You can also print listings
of the contents of the supporting databases.  Reports can be sent to any available
Windows printer or to a disk file.  A Print Preview feature allows you to review
the report results on-screen as they would appear when printed. Chapter 15
provides a detailed description of the report options available.

Help System

A comprehensive on-line Help System is available in MCACES.  This help
system will serve as your guide to answer questions you may have while using
MCACES.  On-line help is available in a number of ways:

• A Help Table of Contents can be used to find help on a specific topic by
starting with a broad subject and working down through more specific levels
of the Table of Contents outline to the particular topic desired.

• A search capability allows you to enter the name of a topic which will be
looked up in an alphabetized list of all MCACES help topics.  Once the topic
is found, you may examine it.

• A context-sensitive help feature will allow you to ask for help in the particular
area of MCACES in which you are working.  Help buttons will be available at
many points in the software, or you may press the F1 key to bring up context-
sensitive help.  Context sensitive help may also be obtained by clicking a
toolbar button and then pointing the mouse to the on-screen feature you are
interested in.

• An extensive cross-reference system will guide you to related topics. It
includes hotspots, which are similar to see also references in a printed
document, except that you click on the hotspot to view the referenced
information.

See chapter 17 for further information on the Help System.
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2.2  What’s New

MCACES for Windows has been developed to make full use of the many
advantages of the Windows environment.  This section reviews areas which will
be new to users of previous versions of MCACES.

A Windows Application

MCACES for Windows is a full Microsoft Windows application which can run
under Windows 3.1, Windows for Workgroups 3.11, Windows 95, or Windows
NT.  As such, it shares many important new features common to Windows
applications:

• A graphical user interface which permits more information to be displayed on
a screen than DOS applications

• The ability to run a number of applications concurrently

• An improved use of your computer’s RAM memory compared to the DOS
environment, wherein software is no longer constrained by the DOS 640K
program size limitation, and software tasks which cannot fit in memory are
automatically copied to disk

• The ability to exchange data with other Windows applications via the
Windows clipboard and Object Linking and Embedding 2.0 (OLE)

• Standard Windows menus, buttons, tool bars, and scroll bars for easier
learning of the software

• Windows Help with topic cross-reference (hypertext)

• Similar look and feel to other standard Windows applications such as Excel,
Project and Word

• Tool Tips (pop-up help text for Toolbar buttons)

• Resizing of windows within screens

 New Features

 MCACES for Windows incorporates many new features which increase the
productivity of users beyond previous DOS versions:

• More information content displayed on each screen, e.g. 3-panel display
which permits toolbar-selected options for display

• New Outline Panel to help with navigation, expanded outline view

• Color-coded highlights in Outline Panel to indicate the currently selected item
and parents of current item

• Cost to Prime, Cost to Owner, or Project Cost totals available in Outline Panel
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• Notes, Contractor, Cost Override, Overtime Cost, Owner Cost, Adjustments
symbols in Outline Panel - provide “hot spots’ for going directly to where a
cost feature is entered

• Grid Panel with customizable display and freeze columns

• Multi-purpose panel for Notes, Cost Summary, Owner Costs and Adjust
Pricing

• Save Panel Layout feature

• Easier to follow methodologies, e.g. tabbed dialog boxes for item
adding/editing, summary information, and report setup

• Common dialog boxes for easier selection of files and databases

• Enhanced Find (keyword search) feature which allows searching titles and
details simultaneously and recalling previous searches

• Drag and drop functionality for copying data items

• Cut / Copy / Paste capabilities

• Creating a new project from any existing project

• Push button hierarchy level selection

• Multiple databases concurrent display, including two or more of the same
database type, e.g. two projects

• Easy access to supporting databases via toolbar selections

• Print Preview and other printing improvements

• Updated backup and restore feature, compatible with previous save/load
compressed structure

• Customize Tools function, which allows you to add frequently used
applications to your Tools Menu

 Differences from MCACES GOLD

 MCACES for Windows offers improved usability in a number of areas compared
to MCACES GOLD:

• Use of the Outline Panel as opposed to the title box display in MCACES GOLD

for improved ways to navigate an estimate.  See section 4.1 for a detailed
writeup on the Outline Panel.

• Use of the Grid Panel to display full information detail for an item versus the
Browse Screen in MCACES GOLD.  For additional information on the Grid
Panel, see section 4.2.

• Use of the Item Form Dialog Box for editing/adding title and detail items
instead of the MCACES GOLD Edit Screen.  See section 4.5 for more
information on Item Form.
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• The ability to have multiple databases displayed simultaneously, each in its
own window, compared with using the Database Menu to select individual
databases in MCACES GOLD.  See “Display of Multiple Databases”, earlier in
this chapter.

• The ability to copy the same detail or title item repeatedly without going back
to the original.

• The use of Customize Grid Panel, which enables the user to determine which
columns will be displayed in the Grid Panel.

• Find Keyword in MCACES for Windows can look at details and titles
simultaneously.  It will also remember the list of items found, allowing you to
“Go To” a different item on the list.

• The new Export Calculations feature creates new fields so that additional
calculations may be performed in a report writer, spreadsheet, database, or
other application.

 MCACES for Windows version 1.00 does not implement certain MCACES GOLD

5.30 features, in particular those described in Volume 2 of the MCACES GOLD user
manual.  Those features include:

• Smart Assemblies

• Digitizer Module

• 2nd View

• Material Backup and Vendor data entry in the Project

• Database Utilities: Merge/Extract/Compare/Update with Material Indicators

• Conversion From CACES and MCACES Plus

• Some ARA Capabilities

 MCACES GOLD 5.30 can continue to be used to accomplish those tasks.  In fact,
MCACES for Windows and MCACES GOLD may be run concurrently under
Windows and operate on the same databases simultaneously.

 Memory Requirements

 MCACES for Windows has higher memory and disk space requirements than
MCACES GOLD.  In particular, you should have 16MB of RAM and 12MB of free
disk space for installation and operation.  Additional space is required for storage
of MCACES databases files.  See section 1.1 for additional information.
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 2.3  Navigation

 Overview

 As mentioned in section 2.2, the basic display of MCACES information takes
place in three data panels: the Outline, Grid, and Notes/Reference Panels.  As few
as one, or as many as three, of these panels may be displayed for any database
which is open in the software.  Most navigation involves movement within, and
manipulation of, these three panels, as well as dialog boxes which “pop-up” on
top of the 3-panel display.

 The mouse or pointing device is the basic tool of navigation in MCACES.  Using
the mouse, you can access menus, select toolbar buttons, click to select rows in
the Outline and Grid Panels, manipulate scroll bars, and make other selections as
necessary to navigate throughout MCACES.  The keyboard can be used instead of
a mouse for most operations, but users typically prefer a pointing device in
Windows-based applications.

 Changing the Panel Display

 The boundaries between panels in the 3-panel display can be changed so that any
panel can be reduced or increased in size, or hidden altogether. If all the
information on a panel cannot be shown in the area available, then scroll bars will
appear to allow the user to scroll through the information using the mouse.

 To remove or show the Outline Panel, choose the Outline Panel selection under
the View Menu or click on the Outline Panel button on the toolbar.

 

 To remove or show the Grid Panel, choose the Grid Panel selection under the
View Menu or click on the Grid Panel button on the toolbar.

 

 To remove or show the Notes/Reference Panel, choose the Notes/Reference
selection under the View Menu or click on the Notes Panel button on the toolbar.

 

 To change the size of any of the panels, move the mouse cursor to a border
between two of the panels until the cursor changes from a pointer to double
separator.  This indicates that you can now drag and change the size of the panels
by clicking and holding the left mouse button while you move it in the direction
desired.  Note that scroll bars will appear on any of the panels when the size is
reduced to less than the information displayed.
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 Navigating the Outline Panel

 On the Outline Panel, the currently selected item is highlighted in blue.  Items in
the hierarchy above the current item are highlighted in green.  All other lines are
shown as black.

 

 Navigation within the Outline Panel can be performed in the following ways:

• Click the left mouse button on an item to be selected. The Selection Indicator
moves to the beginning of that item, and the line is highlighted in blue. Use
the scroll bar to move the desired item into view if only a portion of the items
in the Outline Panel are visible.

• Go To Parent button - Click to position the Outline Panel and Grid Panel
highlights to the respective parent items.

 

• Go To Child button - Click to position the Outline Panel highlight to the item
currently highlighted in the Grid Panel.

 

• Find button - Click to perform a keyword search of the database matching on
ID and/or text.  This will allow you to quickly find a title or detail item
located anywhere within the database.  See section 6.3 for more information.

 

 Whenever the outline is longer than the available panel space, a scroll bar
appears.  The mouse or up and down arrow keys can be used to operate the scroll
bar.  Note that the scroll bar does not cause the highlight to be repositioned.

 Line items may have a prefix of a plus or minus sign.  A plus sign in front of a
line indicates that there is additional breakdown below this line that is not shown.
A minus sign in front of a line indicates that at least one additional level of
breakdown below this line is shown.  A line with no prefix indicates that there is
no further breakdown below.  Clicking on the plus or minus sign, respectively,
expands or collapses the outline.

 Line items at the lowest title level which have detail items as children will have a

special indicator displayed in front of the line. 
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 Expand/Collapse

 Using commands shown below, the hierarchy of items displayed on the Outline
Panel can be expanded or collapsed in various ways.

• To fully expand one branch of the database, click on the item to be expanded
(if not already selected), then Click the Expand Branch button on the Tool Bar.

 

 Alternatively, choose Expand Branch from the Outline Menu.  Double clicking on
the Plus Sign next to the item to be expanded also expands the branch fully.

 To expand a branch one level, click on the item to be expanded (if not already
selected), then do one of the following:

• Click on the Plus Sign next to the item to be expanded

• Click on the item to be expanded (if not already selected), then choose Expand
Title from the Outline Menu.

 To fully collapse a branch of the estimate, do one of the following:

• Move the pointer to the desired branch heading and click on the minus sign.

• Click on the item to be expanded (if not already selected), then choose
Collapse Branch from the Outline Menu.

 Outline Panel Symbols (Hot Spots)

 Symbols (Hot Spots) will display to the right of each title if information is
available on the following: Notes, Contractor, Cost Override, Overtime Cost,
Owner Cost, and Cost Adjustments.  Clicking on one of the visible buttons will
display appropriate information in the Notes/Reference Panel, or Item Form as
appropriate.  You may also click in the column even if the symbol is not showing
for quick access to the appropriate location for data entry.

 See section 4.1 for additional information to help you navigate in the Outline
Panel.

 Navigating the Grid Panel

 Navigation within the Grid Panel can be performed in the following ways:

 Note: To use any of the following, first click on an item in the Grid Panel.

• Use the scroll bar to move an item into view if only a portion of the items in
the Grid Panel are visible.

• Down Arrow Key - moves highlight to next Grid item.

• Up Arrow Key - moves highlight to previous Grid item.

• Page Up Key - move to top item in Grid Panel.

• Page Down Key - move to bottom item in Grid Panel.
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• Right Arrow Key - moves highlight to next field in a Grid item.

• Left Arrow Key - moves highlight to previous field in a Grid item.

• To see columns to the right, use the scroll bar to scroll items to the left.

• Home Key - move highlight to first (leftmost) field in a Grid item.

• End Key - move highlight to the last (rightmost) field in a Grid item.

Arranging Multiple Database Windows

Three selections under the Window menu choice provide ways to arrange
multiple databases on the screen:

Cascade - Nests windows beginning at upper left corner

Tile Vertically - Arranges windows vertically as non-overlapping tiles

Tile Horizontally - Arranges windows horizontally as non-overlapping tiles

Menus

To choose a menu item, click on the menu name (or hold down the Alt key and
press the character underlined in the menu).  The menu will “pull down” and
show all selections within.  Click on the selection desired (or use up and down
arrow keys to move to the selection desired and press Enter).  “Hot Key”
combinations which can be used to quickly select a given menu item are
displayed next to the menu choice when available.

Note: the menu may not be selected using the Alt key when a dialog box is
displayed.

Scroll Bars

To use scroll bars for navigation, click the mouse on the arrows at either end for
small moves, or within the scroll bar on either side of the placement button for
large moves.  The placement button may be dragged directly for movement
relative to the beginning or end.

Tabbed Dialog Boxes

Navigation in tabbed dialog boxes consists of clicking the left mouse button on
the appropriate tab.  You may also use the Alt key plus the character underlined in
the Tab.

Maximize Window

The Maximize button in the upper right of an application or database window is
used to expand the window selected to take up the entire display area on your
monitor.  As an aid to navigation, this will present the maximum amount of
information for that window.  Use of a higher resolution video display card and
monitor will enable more information to be displayed.  MCACES will detect and
utilize higher resolution devices for display of additional information.
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Minimize Window

The Minimize button next to the Maximize button in the upper right of a window
is used to reduce an application or database window to an icon.  This will permit
display of other information, while allowing the minimized window  to be
recalled upon a click on the icon.
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2.4  Related TRACES Applications

MCACES is part of a family of software applications collectively known as the Tri-
Service Automated Cost Engineering System (TRACES).  Below are descriptions of
some of the other TRACES applications.

MCACES GOLD

MCACES GOLD is the DOS-based detailed estimating system used as the starting point
for development of MCACES for Windows.  Section 2.2 of this manual describes the
differences between MCACES GOLD and MCACES for Windows.

PC-Cost  Budget Estimating System

PC-Cost is a Microsoft Windows-based software tool for preparing and submitting
budget estimates for construction projects.  The PC-Cost Module permits estimates to
be prepared in electronic format compatible with the ENG3086 and DD1391 Modules
on the mainframe-based PAX system.  The system includes an automated
communications facility to upload and download data between the PAX system and
the PC-Cost Module.  Other features include: search/retrieval of DOD Cost Guide
data, Category Codes, Installation Lists, Area Cost Factors, and MCP Indices; an
option to import data from MCACES project estimates and site assemblies; various
adjustment and escalation factors; and report generation.

Historical Analysis Module (HAG)

HAG is a software tool for analyzing and reporting historical cost data of past
construction projects.  It is a Microsoft Windows-based system which uses a
Microsoft Access database format.  Tables within its database contain data on type of
facility, location, year of construction, award date, number of bidders, size and unit
cost at award, the responsible agency abbreviation, and other data which may be
useful in analyzing a particular facility’s cost as part of a larger group.  An extensive
reporting capability using Crystal Reports is included.

Parameter Based Modeling (PBM)

The PBM software is a parametric estimating tool which develops systems cost for
military and site work type construction.  The PBM software is capable of generating
MCACES - compatible estimate files.  These files can then be used in MCACES in
the same manner as MCACES project files.

Scheduling Interface (SI)

The Scheduling Interface Module is a DOS program that provides project scheduling
capabilities for MCACES cost estimates.  The SI Module produces a basic schedule
of project activities and projects the overall duration and end date.  It also allows the
user to export project data to Primavera P3, Primavera Finest Hour, Open Plan and
Microsoft Project for Windows scheduling software packages for more detailed
scheduling functions.  Additional features include the ability to override computed
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durations as required, and to define schedule relationships among activities using
either PDM or ADM methodologies.

Life Cycle Cost Module (LCC)

The LCC Module is a DOS program that produces life cycle cost (LCC) analyses of
facility components.  The term “LCC analysis” refers to an analysis of the total
ownership costs of two or more components over the projected life of the facility.
The LCC Module can also be used to perform net present worth calculations for
individual facility components, and to look up maintenance and repair costs for
components in a supplied M&R database.  To calculate life cycle costs and produce
reports, the present version of the LCC Module uses the Life Cycle Cost in Design
(LCCID) economic analysis program developed by the U.S. Army Construction
Engineering Research Laboratories in Champaign, Illinois.

Material Reprice Module (MAT)

MAT is a DOS program that allows the user to efficiently update the material prices
of cost items in the Unit Price Database used by MCACES for Windows and
MCACES Gold.  The module allows the Assigned Responsible Agency or its
designates to periodically update the material prices for the National UPB.  The
module also allows individual districts and other MCACES users to develop site-
specific UPBs with material prices as appropriate to particular localities.
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Chapter 3

Building a Sample Estimate

3.1  Quick Start

This section presents a step-by-step explanation of the process of creating a new
project.  This example covers entry of a very basic project, and illustrates the steps
used to create titles and details, as well as adding Contractor and Owner Cost
markups.

You must first install the MCACES software before beginning the steps in this Quick
Start.  See Installation Instructions for details.

Before beginning this project, please take a minute to familiarize yourself with the
diagram below so that you will understand the terms used in the exercise.

Toolbar

     Menu Bar Notes Panel

  Outline Panel   Grid Panel
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Creating the Project

1. Start Windows by entering WIN at the DOS command line. Once in
Windows, open the TRACES Applications Group and double click on the
MCACES icon.

 

 Result:  The MCACES software is started and the About MCACES for
Windows dialog box is displayed.  This will disappear in a few seconds.  You
can begin working at any time.  Next the MCACES application (with no
project or other database selected) is displayed.

2. Create a new project by selecting New from the File menu or by selecting the
New Project button.

 

 Result:  The Create Project As dialog box is displayed.

3. Type in a six-character name for the new project in the highlighted File Name
field at the upper left of the dialog box.  Use MFW001.  Then click on the
OK button.

 Result:  The Begin a New Project dialog box is displayed.

4. Click twice on the down arrow in the Spin Button to the right of the Levels to
Copy field.  In this sample project we will create all of the titles from scratch,
rather than copying the titles from the template.

Result:  The Levels to Copy field reads 0.

5. Leaving the Military template highlighted, click on the Locate Selected
Template button.

Result:  The Locate Selected Template Dialog box is displayed.

6. Click on the CHAPEL (installed in the TRACES\MFWBETA2\PROJECT
subdirectory) project in the File Name box and then click the OK button.

Result:  The path and ID of the template is displayed to the right of the
template ID in the Begin a New Project dialog box.

7. Click OK.

Result:  The new project MFW001 is created and the project is opened.

Note:  The title that is called the Project Information Record in MCACES
GOLD is the top line in the Outline Panel and now has the name of the
project description.
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Creating Level 1 Titles

1. To create your first level 1 title, Click on the Edit menu and then click on
Add New Record.  Alternatively, you can click on the Add New Record

button on the Toolbar:  

Result:  The Title Item Form is opened.

2. The cursor defaults with the WBS (title) ID field highlighted.  Change the ID
to A_.

Note:  When a field you click on is highlighted, then anything you type will
replace the current data.  If you want to add to the data, or replace a part of it,
first use an arrow key to move to the correct position and then begin editing.

3. Tab to (or click on) the description field.  Type: Primary Facilities.

4. Tab to (or click on) the quantity field.  Input the number 17,175.

Note:  The commas should not be input.  They are displayed here for
readability only.

5. Change the Unit of Measure to SF.

6. Click on the Next Button to create another level 1 title.  The Next Button is
used to continue adding at the same level while in the Add mode.

7. Change the ID to B_.

8. Tab to the description field and change it to Support Facilities.

9. Tab to the quantity field and change it to 18.

10. Tab to the Unit of Measure field and change it to ACR.

11. Click on the Next Button.

12. Change the ID to E_.

13. Tab to the description field and change it to Category E Equipment.

14. Tab to the Quantity and change it to 1.

15. Tab to the Unit of Measure field and change it to LS.

16. Click on the Next Button.

17. Change the ID to G_.

18. Tab to the description field and change it to Installed Equipment.

19. Click on the Next Button.

20. Change the ID to H_.

21. Tab to the description field and change it to Design Cost.

22. Click on Close.
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23. Click on the Outline Panel.

You have created 5 level 1 titles.

Creating Level 2 and lower Titles

To create your first level 2 title, click on the first level 1 title in the Outline Panel so

that it is highlighted and the location indicator  is to the left.  This is A_ Primary
Facilities.

1. Click on the Edit menu and then click on Add New Record.  Alternatively,

you can click on the Add New Record button:  

2. When asked which type of item you wish to add, click on Subtitle.

3. Input 01 as the title ID.

4. Tab to the description and type in Chapel Family Life Center.

Note:  While you are still in the Add Mode, with this form still open, clicking
on the Go To Child button will enable you to add a subtitle to this title.  To
do this:

5. Click on the Go To Child button: 

6. When asked which type of item you wish to add, click on Subtitle.

7. Input 01 as the title ID.

8. Input Substructure as the description.

9. Click on the Next button to continue adding subtitles to the Chapel Family
Life Center.

 Note:  You can use the Keyboard shortcut of Alt+N to add another new record
at this level, rather than clicking on the Next button.

10. Add the following titles, clicking on the Next button after finishing each title
form:

Title ID Description Quantity UOM

02 Superstructure 17,175 SF

03 Exterior Closure 17,175 SF

04 Roofing 10,883 SF

05 Interior Construction 17,175 SF

06 Interior Finishes 63,874 SF
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08 Plumbing 17,175 SF

09 HVAC 456 MBH

10 Fire Protection 17,175 SF

11 Electric Power and Lighting 17,175 SF

12 Electrical Systems 17,175 SF

15 Special Construction 894 SF

 

11. After filling out the final title form, click on Close.

12. In the Outline Panel, click on the Plus Sign to the left of the title 01 Chapel
Family Life Center.

13. Click on the 01 Substructure title so that it is highlighted in the Outline Panel,
and click on the Add New Record button.

14. When asked which type of record you wish to add, click on Subtitle.

15. Add the following two subtitles:

01 Standard Foundations 17,175 SF

03 Slab on Grade 17,175 SF

16. When finished adding the titles, click on Close.

17. In the Outline Panel, click on the Plus Sign to the left of the title 01
Substructure.

18. With the 01 Standard Foundations title highlighted in the Outline Panel, click
on the Add New Record button.

19. Add the following two subtitles:

01 Wall Foundations   1,062 LF

03 Column Foundations and Pile Caps        18 EA

20. When finished adding the titles, click on Close.

21. In the Outline Panel, click on the Plus Sign to the left of the title 01 Standard
Foundations.

22. With the 01 Wall Foundations title highlighted in the Outline Panel, click on
the Add New Record button.

23. Add the following five subtitles:
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01 2’-0” Wide Continuous Footing    491 LF

02 2’-6” Wide Continuous Footing    571 LF

03 4” CMU Foundation Wall    716 SF

04 8” CMU Foundation Wall 2,879 SF

05 1” Thick Perimeter Insulation 1,576 SF

24. Click on Close.

In the Outline Panel, click on the Plus Sign to the left of the title 01 Wall
Foundations.

Your Outline Panel should now look like this:

Hint:  You may have to pull down the horizontal bar between the Outline Panel and
the Grid Panel to see more of your titles.  To do this, position your mouse over the bar
until it turns into a two-headed arrow.  Hold down the mouse button and drag to the
location desired.  Select the Save Panel Layout option from the Tools Menu to save
this configuration.
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Adding Detail Cost Items from the Unit Price Book
We will now bring detail cost items into our sample project, pulling in items from the
Unit Price Book.

1. To open the Unit Price Book, click on the File Menu and then click on Open.

Note:  Alternatively, you can click on the UPB Lookup button    on the
toolbar:  If you have already used this button, the UPB will be opened and
you can skip down to step 10.

2. On the bottom left hand side of the dialog box is a field called List Files of
Type.  Click on the down arrow of the Pulldown Box and select the type of
Unit Prices.  (You will need to use the down arrow to scroll down to make
the Unit Prices choice visible.)

3. If your Unit Price Book is not displayed in the window already, you will need
to change the drive and/or the directory in the Drives and Directories
windows.

Note:  MCACES for Windows can use the exact same databases that you are
currently using for MCACES GOLD, so it is not necessary to make a new copy
of the Unit Price Book for this example.

4. To find your Unit Price Book on a different drive, click on the down arrow
for the pull down box to the right of the drives field.  You will see a list of
the drives available to you.

5. Click on the drive where your Unit Price Book is.

6. To see a list of all of the directories on the new drive, double click on the
drive letter at the top of the directories list.

7. To see the subdirectories under a particular directory, double click on that
directory.

8. Continue double clicking on the directories until you get to the directory
where your Unit Price Book is located.

9. When your Unit Price Book appears in the File Name window, you can either
double click on it there or you can single click on it to bring it to the top box
of that window and then click on the OK button.

 Note:  You now have two database windows open: your project and the UPB.
The active window is the one that has the highlighted title bar.  In the Unit
Price Book (as in the project) you can drag down the horizontal bar between
the Outline Panel and the Grid Panel so that you can see more of the titles in
the Outline Panel.

10. Click on the Plus Sign to the left of the 02000 0000 Site Work title.

11. Click on the Plus Sign to the left of the 02200 0000 Earthwork title.
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12. Click on the Plus Sign to the left of the 02221 0000 Trenching, Backfilling
and Compaction title.

13. Click on the Plus Sign to the left of the 02221 1000 Trenching and
Continuous Footing Excavation title.

14. In the Outline Panel click on 02221 1700 By Hydr. Excav 2 1/2, 3, 4, & 5 CY
(This will display the cost items under this title in the Grid Panel.)

15. Click on the Window menu and then on Tile Vertically.

16. In your project, in the Outline Panel, click on the title 2’-0” Wide Continuous
Footing.

Note:  You should now have your project and the Unit Price Book open side
by side, with the detail level in the Grid Panel on both.  The Grid Panel in
your project is currently empty since we have not added any detail cost items
yet, and the first lowest title level (01 - 2”-0”  Wide Continuous Footing) is
highlighted in the Outline Panel so that we can begin adding detail cost items
under this title.

Your screen should now look like this:
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17. In the Unit Price Book, click on the very left box on the item 02221 1705.
The item should turn black to show that it has been selected.

18. Click on the description field of the same item and drag the item to the empty
grid panel in your project.  (Drag by clicking on description field of the item
and then holding the mouse button down as you move the cursor over to your
project.  Release the mouse button when the cursor is over the project Grid
Panel.)

Note:  When you are dragging the item from the Unit Price Book to the
project, the cursor becomes a circle with a slash through it to let you know
that you are over an area where you cannot drop it.  When the cursor becomes

a    that means that you are over an area where you can drop it.

Result:  You have added the first detail to your project.

19. In the Unit Price Book, click on the Plus Sign to the left of the 02222 0000
Structural Excavation title.  (You will need to scroll down the titles in the
Outline Panel to find this title.)

20. Click on the Plus Sign to the left of the 02222 3000 Pier and Other Isolated
Foundation Excavation title.

21. Click on the 02222 3400 Miscellaneous Hand Labor title.

22. Select the item 02222 3402 Trim Slopes/Sides of Excavation Hand Labor by
clicking on the blank box to the left of the detail.

23. Drag the item to your project by clicking on the description of the selected
item and dragging it to the detail section of your project.  Position the pointer
to be under the existing detail item there.

Note:  You can determine the position of the detail you are dropping into
your project by releasing the item when the pointer is on the item in front of
which you wish to insert the new item.

24. Back in the Unit Price Book, scroll down until you see the title 03000 0000
Concrete.

25. Click on the Plus Sign to the left of the 03000 0000 Concrete title.

26. Click on the Plus Sign to the left of the 03100 0000 Concrete Formwork title.

27. Click on the Plus Sign to the left of the 03110 0000 Structural Cast-in-Place
Concrete Formwork title.

28. Click on the Plus Sign to the left of the 03110 1000 Foundations (Plywood
Forms) title.

29. Click on the Plus Sign to the left of the 03110 1100 Footing Forms title.
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30. Click on the title 03110 1110 Wall Forms (Continuous).

31. Select the item 03110 1112 Cont Wall Footing Forms, 2 uses...

32. Drag it and drop it into your project.

33. In your project, double click on the Quantity field in your detail cost items
and input the following quantities:

Note:  After inputting the first quantity, use the keyboard down arrow to input
the next quantity.

02221 1705 Trench, 2-1/2 CY Hyd Excavator 216 CY
02222 3402 Trim Slopes/Sides of Excavation 982 SF
03110 1112 Cont Wall Footings, 2 Uses 982 SF
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Using Find Keyword and Marking items with a quantity

We will now use the Find button to find detail cost items in the Unit Price Book, and
will mark the detail cost items by inputting a quantity in the Unit Price Book.

1. Click in your Project panel, and highlight the title 2’-6” Wide Continuous
Footing in the Outline Panel.

2. Click in the UPB panel and then click on the Find button   .

3. In the Match ID field, input “02221”.

4. Uncheck the Titles field, so that you will be searching in the details only.

5. In the Find What: field, input “Trench 2 1/2 cy”.

6. Click on Find.

7. When presented with a list, highlight the item with the code of 02221 1705,
and then click on Go To.

8. Double-click on the quantity field and then input 349.

9. Click again on the Find button.

10. In the Match ID field, input “02222”.

11. Leave the titles field unchecked.

12. In the Find What: field, input “Trim Slopes”.

13. Click on Find.

14. When presented with a list, highlight the item with the code of 02222 3402,
and then click on Go To.

15. Double-click on the quantity field and then input 1427.5.

 Note: If the quantity field is not wide enough to input the number, you can
widen the field by dragging the border horizontally.

16. Click again on the Find button.

17. In the Match ID field, input “03”.

18. Leave the titles field unchecked.

19. In the Find What: field, input “Cont wall footings 2 uses”.

20. Click on Find.

21. When presented with a list, highlight the item with the code of 03110 1112,
and then click on Go To.

22. Double-click on the quantity field and then input 1142.

23. Click on the quantity field of any record in the UPB.

24. Select Copy from the Edit Menu, or use the copy button .
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25. Click on the Project window, with the highlight in the Outline Panel on the 2’-
6” Wide Continuous Footing title.

26. Select Paste from the Edit Menu, or use the paste button .

Result:  You have added the three items to your project.

27. Note: You may want to close the Unit Price database to make more room on
your screen for your project.  You can do this by clicking on the UPB title bar
and choosing File|Close.  Then choose Window|Tile Vertically to restore your
project to full screen.
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Adding Contractor Markups

To add Contractor Markups, we will first create the prime contractor by doing the
following:

1. Click on the Contractor button:  

Result:  The contractor window is opened.

2. Click on the Contractors title in the Outline Panel.

3. Click on the Add New Record button:    .

Result:  The Contractor Item Form is open:

 

4. Click on the Contractor ID field (the first field) and input the ID of AA.

5. Tab to the WBS field and input AA there too.

Hint:  Assigning the title ID the same as the contractor ID will cause your
contractors to be listed in alphabetical order.

6. Tab to the Description field and input Prime Contractor.

7. Click on the Pct % column to the right of the OVERHEAD column and input
8.

8. Use the Down Arrow to go to the Pct % column for the HOME OFC, and
input 3.5%.

9. Use the Down Arrow to go to the Pct % column for the Profit and input 7.

10. Use the Down Arrow to go to the Pct % column for the Bond and input 1.2.
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11. Click on the Go To Child button    to add a subcontractor to this prime.

12. On this sub, duplicate the following:

13. Click on Close.

14. Now that the contractors have been created, you need to apply them in your
estimate.  Pull down the Window menu and then click on your project, so that
your project becomes the active window again.

15. The 3 cost items that you just added under the title 2’6” Wide Continuous
Footing should be displayed in the Grid Panel.  If not, click open each parent
title in the Outline Panel by clicking on the plus sign, until the detail is
displayed in the Grid.

16. Click on the cost item 03110 1112 in the Grid Panel, and click on the Item

Form button  .

17. On the Options Tab, click on the down arrow on the pulldown to the far right
of the Contractor Field and select the Formwork Contractor.  Hit the Tab key
once so that the Contractor ID also appears in the form.

18. Click on the Next Group button  to bring the cost items of the 2’ Wide
Continuous Footing into the Grid Panel.

Hint:  You can leave the item form open while you navigate in the database.

19. With the highlight on the formwork cost item 03110 1112, select the
Formwork Contractor and Tab away from that field.  Close the item form.
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Result:  The Formwork Contractor ID FM is displayed in the contractor
column of the Grid Panel.  You could also have added the ID directly into this
column.

20. To apply Prime Contractor markups to all cost items not specifically selected
to be done by the Formwork Contractor, we will apply the Prime Contractor at
the top of the project.

21. Click on the very top line on the Outline Panel and then click on the Go To

Parent button.   .  (This is how we access the top of the project to the apply
the Prime Contractor to the entire project.).

22. Click on the Item Form button   and make sure you are on the Options Tab.
Select the Prime Contractor and close the form.
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Adding Owner Cost Markups

To add Owner Cost Markups, we will first make sure that the default Owner Cost
level is at Level One.

1. Click on the Summary Info Panel button .

Result:  The Summary Info Panel dialog box is opened.

2. Click on the WBS Definition tab.

3. Click on Level One as the Owner Cost Level.

4. Click on OK.

5. With the Primary Facilities title highlighted in the Grid Panel, click on the
pulldown next to the Notes field in the Notes/Reference Panel, and choose
Owner Costs.

Result:  The Notes/Reference Panel displays the Owner Cost information.

Hint: Depending on your screen layout, you will probably want to drag the
vertical bar between the Outline Panel and the Notes Panel to the left so that
you can see all of the Owner Cost screen.

6. Change the Escalation method of computation to Compute.

 Result:  The input form for the Escalation Indexes is opened.

7. Click on the Escalation Start date field and input 06/1993.

8. Down arrow to the Escalation End date field and input 02/1994.

9. Click on the Index field to the right of the Escalation Start date field and input
1852.

10. Down Arrow to the Index field for the Escalation End date and input 1882.

11. Leaving Contingency as a Percent of Running, click on the Percent field to the
right of the Contingency field and input 5.

12. Down Arrow to the SIOH percent and input 5.5.
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Your Owner Cost Panel should look like this:

13. Click on the Supporting Facilities title in the Grid Panel.

14. Input the same Owner cost information for the Supporting Facilities title.
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Printing Reports of the Project

We will now make a few more changes and then print some reports for this project.

1. To input project level notes, click on the down arrow next to the Owner Cost
field and switch it back to Notes.  Click on the down arrow for level and select
Project Level.

Alternatively, you can input Project Level Notes on the Notes Tab of the
Summary Info Panel.

2. Input the following:  “These are my Project Level Notes for this project”.

Result:  The Notes indicator  is displayed in the Outline Panel.

3. Click on the File Menu and then Summary Info... or click on the button for the

Summary Info Dialog Box. 

4. Click on the General Tab and type your name in the Estimated By field.  Click
on the Calculation Tab and make sure the Estimate Type is set to K - Crews
with Reprice Key.

5. Look at the other tabs in the Summary Info Dialog Box to see the functions
available there.

6. When finished, click on OK.

7. Click on the File menu and then Report Setup.

8. Look through the tabs in this dialog box to get a feel for where your report
formatting is done and where the reports are selected.

9. Select the Detail Report to be printed by clicking on the box next to the Print
Direct Cost Detail Report field in the upper right corner of the Select Reports
tab.  Also select the Project Indirect and Owner Cost reports at level 1.

Note:  If you will be printing these reports to a printer other than your default
printer in Windows, click on the Setup button at the bottom of this window to
change the printer for the upcoming report.  You will get better information if
you print your report in the landscape mode.

10. Click on the Preview button at the bottom of the window.

11. Follow the directions at the top of the window to navigate around the report.

12. When finished viewing on screen, click on the Print button at the top of the
window.

13. Change the Print Device field to Print to Printer.  Click OK.

Result:  You will print a detail report and two Project Summary reports to the
printer.  If you like, you can bring up this exact project in MCACES GOLD 5.30
and print the same report there to compare the results.
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Chapter  4

Project Database Overview

Introduction

The Project Database window is the work area where you develop an estimate.
The titles and detail items entered here represent the various costs for a project,
including Direct, Indirect, and Owner Costs.

The other databases available with MCACES are called supporting databases
because they support the Project Database.  Those databases are all used to store
cost data that you can incorporate into an estimate by copying it into the Project
Database.

Overview of the Estimating Process

The following steps outline the overall process of using MCACES to create an
estimate.  Some of the steps are optional, depending on your individual project.

1. You start by creating a new project in MCACES, or by copying an existing
estimate.  Refer to Section 5.1 for instructions.

2. Next, you modify preliminary information about the project as needed, by
performing the following tasks:

• Define the type of estimate.
• Name and format the project columns to appear on screens and reports.
• Set the breakdown structure.

These tasks are explained in Sections 5.2 through 5.5.

3. You then build the estimate by entering titles at one or more levels, and by
adding cost items for Project Direct Costs.  MCACES provides a number of
tools and methods you can use to accomplish this efficiently.  See Chapter 6
for instructions.

4. If you are working with contractor markups or other Indirect Costs, you also
need to define these costs and apply them throughout the project, as described
in Sections 7.1 through 7.4.

5. If you need to apply Owner Costs, you can do this while you are building the
estimate or later.  See Sections 7.5 and 7.6.

6. At any stage of the process, you may print summary and detail reports, either
to a printer or to a Print Preview window.  Printing instructions and sample
reports are presented in Chapter 15.

The following chapters describe the Project Database in detail and explain the
tasks involved in creating an estimate.
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• Chapter 5, "Starting a New Project," explains how you create a new Project
Database based on the structure of an existing project or project template.  It
also describes how MCACES controls the structure of a project, and how you
can use the software to modify that structure.

• Chapter 6, "Working With Project Direct Costs," discusses the basics of
adding, editing, and deleting titles and cost items, including the use of the
Lookup feature.  It also explains optional tasks, such as working with crews,
assemblies, shipping costs, and overtime adjustments.

• Chapter 7, "Working With Indirect and Owner Costs," explains how to use
MCACES to add percentage markups and distributed costs to the estimate.
These include contractor and other Indirect Costs, as well as Owner Cost
adjustments.

• Chapter 8, "Working With Existing Projects," provides instructions on
accessing Project Databases from disk, creating and using project templates
and repricing estimates from supporting databases.

In This Chapter

The following sections are included in this chapter:

4.1  Outline Panel
4.2  Grid Panel
4.3  Notes / Reference Panel
4.4  Modifying the Display
4.5  Item Form
4.6  Summary Information



Project Database Overview 4-3

4.1  Outline Panel

Background

The MCACES for Windows Outline Panel implements an outline view which is
similar in concept to outline capabilities in familiar products such as Microsoft
Word, Microsoft Project, and Microsoft Windows File Manager.  In this outline
view implementation, the presentation may be expanded to show all titles and
details for a specific hierarchy branch, collapsed to show level 1 titles, or any
gradation in between.

The upper left panel of the three-panel display of a project database is the Outline
Panel.  It provides navigation, a view of the hierarchy, and display of descriptive
and other data.  It cannot be edited directly.

Toolbar

          Menu Bar

  Notes Panel

  Outline Panel   Grid Panel

Figure 4.1 MCACES for Windows Three Panel Display
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Configuration Controls

The Outline Panel displays a small toolbar of its own on its top line.  Within the

Outline Toolbar, numbered buttons  provide for quick expansion
or collapse of the outline, showing titles only down to the level for which the
button is depressed. The software automatically will assure that the button

representing the deepest level currently displayed is depressed.  The  button
expands the current branch out to all levels.  The remaining two buttons  toggle

between the standard outline display  and the “parent titles only” 
display. When, as is typical, the left push button is depressed, the standard outline
view is displayed.  When the right push button is depressed (and the left pops up),
all the lines in the outline view become hidden, except for the chain of parent
titles under which the current item falls.

In the body of the outline, the text of the current line is in blue, and the text of its
“ancestors” is in green.  If the Grid Panel is open, the children, if any, of the
current line are displayed.

The body of the outline contains the following symbols:

The blue Selection Indicator, which further emphasizes which title line of
the outline is current.  The grid design serves as a reminder that this item is
the parent to any items displayed in the Grid Panel.

The Plus symbol, indicating a line is parent to further titles which may be
viewed by clicking on the symbol.  A double click on the symbol expands
the titles subordinate to the line so that all title levels are displayed.

The Minus symbol, indicating a line is parent to titles displayed beneath it.
These titles can be hidden by clicking the minus.  The Minus then becomes
a Plus.

The Page (Leaf) symbol, indicating detail exists beneath a title and may be
viewed when the grid panel is open.

The Outline menu provides another method for using the outline commands.

The Go to Parent  and Go to Child  commands, which appear as buttons on
the Toolbar and as menu choices in the Outline Menu, are helpful in navigating,
whether or not the Outline Panel is displayed.  "Go to Parent" moves the outline
selection to the parent of the former selection, and the grid highlight to the former
outline selection.  "Go to Child" reverses the action, placing the Outline selection
on the former Grid selection and the grid selection one level further down.

Data Display

The Outline Panel displays critical data about each title.  This includes part or all
of the item ID, the description, the total cost (either Cost to Prime, Cost to Owner
or Total Project Cost), a notes indicator, and other indicators.
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The indicators are marked by an abbreviated heading on the top line of the outline
(adjacent to the buttons described above).  For quick readability, the following
graphical symbols are used:

Notes are indicated by a notepad symbol.

AA Application of a contractor is indicated by its Contractor ID.

Cost Override is indicated by a price tag symbol.

Overtime is indicated by a clock symbol.

Owner Costs applied (at Owner Cost Level or lowest title level) is 
indicated by a checkbook symbol.

Adjust Pricing is indicated by a screwdriver symbol.
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4.2  Grid Panel

The Estimate Grid occupies the bottom panel of the 3-panel display scheme.  The
contents may be either titles or detail.  The Grid Panel is the panel in which you
will do much of your work in a database.  In general, an item (title or detail) must
be highlighted in the Grid Panel before you can edit that item.  Items highlighted
in the Grid Panel are always the children of (one level below) whatever is

highlighted (has the grid symbol   ) in the Outline Panel.

Note: When you go to the parent of the topmost item (project information record),
the grid symbol is changed to a blue arrow in the leftmost column and the Grid
Panel displays the totals information for the total estimate.

 

Figure 4.2 MCACES for Windows Grid Panel

Grid Title Bar

The parent of all the items displayed in the the Grid Panel is displayed in the Grid
Title Bar.  The item indicated in the Grid Title Bar and the title with the grid
symbol in the Outline Panel (if displayed) is the same item.

The first button on the Grid Title Bar is the Freeze button.  .  Use this to lock
all columns left of the current cell while allowing the remaining columns to be
scrolled horizontally.  For example, to lock the Database ID column, click on the
column to the right of the Database ID column.  Then click on the Freeze button.
Now when you scroll to the right, the Database ID will remain on screen.

The next two buttons: are used to go to the previous or next group of
details or titles in the estimate.

To the right of the buttons is the description of the title, which is the parent of
whatever is highlighted in the Grid Panel.  Following the title is the quantity, the
Unit of Measure and the Total Cost for that title.
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Configuration Controls

The Tools | Customize Grid command activates a dialog box used to configure the
Grid Panel layout. See below for further information about customizing the Grid
Panel.

As a further shortcut, any column may be removed from a layout by dragging its
width to zero.  This is accomplished by placing the mouse cursor on the boundary
to the right of the column just above the top row of the grid, then holding the
mouse button down while moving the mouse to the left.

The software will also remember the width that the description column is dragged
to, for any given database type.  An option in the Customize Grid dialog box
allows choosing whether the description wraps to multiple lines, or is simply
truncated when the column is too narrow.

Navigation Controls

The Grid Panel is itself a navigation control.   Moving the highlight bar to any
line positions the software to that item.  This is done by clicking on the item you
want to highlight.  When an item is highlighted in the Grid Panel, the blue arrow
will appear on the very left most column. 

The Down Arrow will change the highlight from one record to the next, staying in
the same column.

The Vertical Scroll Bar (displayed if all rows do not fit in the window) will
display the records that were previously off the screen.  You need to click on a
new record to actually change the highlight to a new record.

The Horizontal Scroll Bar allows you to scroll through the columns while staying
on the same record.

The  buttons on the Grid Panel Title Bar cause the previous or next group
of siblings to be displayed in the Grid Panel under their parent title.



4-8 MCACES for Windows

Grid Panel Display of Titles

Figure 4.3 Grid Panel Display of Titles

The following columns are in the Grid Panel when the item highlighted is a title:

Note: For additional information on these fields see Section 6.1.

• Empty Block The first column is an empty block that is used to 
select the title for purposes of moving and copying 
data.

• Title ID An alphanumeric ID that has been assigned to the 
title.

• Description A text description of the title. (up to 32 characters 
in length).

• Quantity The quantity that has been assigned to this title.

• Units The Unit of Measure that has been assigned to this 
title.
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• Cntr The ID of the contractor that has been assigned to 
this title.

• Crew The ID of the crew, if this title is using the Crew as
Assembly feature.

• Duration The duration of this task being performed, if this 
title is using the Crew as Assembly feature.

• HCAS This column displays whether HCAS information 
has been entered for this title.  

• Labor, etc. The next several columns (up to 5) display the 
extended cost totals of unit costs for cost each of 
the Direct Costs for this title that have been

defined for this project (Cost to Prime).

• Total Unit Cost The unit cost for this title.  This is the Cost to 
Prime for this title divided by the Quantity.

• Cost to Prime The total Cost to Prime for this title.  The Cost to 
Prime is the total of the defined direct costs, sales 
tax, overtime, any Adjust Pricing and any 
Subcontractor Markups that have been applied to 
this title.

• Cost to Owner This is the total of the Cost to Prime for this title 
and any Prime Contractor Markups that have been 
applied to this title.  This is also sometimes called 
the Contract Cost.

• Project Cost This is the total Project Cost for this title.  It 
includes all Direct Costs, Indirect Costs 
(Contractor markups) and Owner Costs.
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 Grid Panel Display of Details

 

 Figure 4.4 Grid Panel Display of Details

 The following columns are in the Grid Panel when the item highlighted is a detail:

 Note: For additional information on these fields see Section 6.2.

• Empty Block The first column is an empty block that is used to
select the detail.

• Src This prefix field reflects the source of the detail 
item in the supporting database from which it was 
copied.  Typical sources are MIL, CIV, HTW, etc.  
If the detail is created by the user the source will 
default to USR, but can be changed.

• Database ID An ID that has been assigned to the detail in the 
supporting database from which it was copied.  This
ID could be from the Unit Price, Labor or 
Equipment Database.

• Description A text description of the detail (up to 64 characters 
in length).

• Quantity The quantity of the detail in this estimate.
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• Units The Unit of Measure that has been assigned to this 
detail.

• Cntr The ID of the contractor that has been assigned to 
this detail.

• Note This column identifies whether a note is present for 
this detail.

• L/E Type The type of detail item (Crew, Labor or Equipment)

• Crew The ID of the Crew performing the work.

• Output The number of units of work performed per hour.

• Wrk Cat The work category code for use by the System 
Summary Report

• Mod A M indicates that this detail item has had a 
modifier applied.

• Ovrd This column indicates whether the detail has had a 
price override.  An M indicates that the Material 
Unit Cost has been overridden.  An L indicates that 
the Labor and/or Equipment has been 
overridden.  A B indicates that Both Material and 
Labor/Equipment have been overridden.

• Weight Equivalent unit weight of this item.

• Manhours, etc. The next several columns (up to 5) display the unit 
or extended costs for each direct cost type.

• Direct Cost This column displays the total direct cost for this 
detail.

• Mat’l Update This column displays the date on which the material
cost for this detail was last changed.

Customizing the Grid Panel Display

The Customize Grid... option on the tools panel provides a way to easily turn the
display of selected columns on or off in the Grid Panel to suit your needs.  Each
possible column has an associated check box which determines whether the
column will visible or not.  Note that the information is still  retained and will be
displayed on the edit form dialog box.

You may also choose whether to display costs and manhours as unit
costs/manhours or extended cost/manhours.  Another option allows you to choose
if the description should wrap to an additional line if the width of the column is
less than the length of the description.
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4.3  Notes/Reference Panel

Background

This third panel brings any of several different features within easy reach.
Displaying this panel at full width may conceal indicators and costs in the Outline
Panel, depending on your screen resolution.  Therefore, the boundary with the
Outline Panel can be dragged in either direction at any time.  Notes wrap adjusts
to this so that text remains visible.  (Alternatively, the Notes/Reference Panel may
be toggled off and on at any time to allow for complete display of the Outline
Panel.)  In addition to Notes, this panel can also show Cost Summary, Owner
Markups or Adjust Pricing at various title levels.

Description

The data shown in the Notes/Reference Panel always pertain to the item currently
highlighted in the grid.  The design of the panel recognizes, however, that such
data may have been applied by the user either on the highlighted item or at a title
some levels above it.  For example, owner costs applicable to a detail item are
placed either on the immediate parent (lowest level title) or on the ancestor which
is at the default owner level (as designated for a particular estimate).  When
Owner Markups display is selected, the panel will show the owner markups
applied to the highlighted item, wherever they are physically placed.

The Display Type pulldown list at the upper left is used to choose between Cost
Summary, Owner Costs, Adjust Pricing, and Notes.

At upper right is the Level pulldown list.  Initially, this field always displays the
level of information most directly applicable to the item highlighted in the grid (as
discussed above).  The user may, however, activate the pulldown to display other
levels.  For example, if owner markups have been applied at the immediate parent
of the highlighted detail item, those owner markups are shown.  However, by
activating the level pulldown the user may change the display to show the owner
markups at owner level.

Only the levels appropriate to the display type will appear in the Level pulldown.
This could be as few as two levels, for owner costs, or as many as nine, for notes
on a detail item in an estimate: Detail Level (the default); six levels of titles;
Project level; and Contingency Notes.

The Notes/Reference Panel is the location of data entry for all Notes, Adjust
Pricing, and Owner Costs.  The Cost Summary display is a passive display of the
Cost to Contractor through Project Cost.  Although it is updated each time the
Estimate is recalculated, it contains no directly editable fields.

The Adjust Pricing display includes passive display of the contractors appropriate
to the highlighted item, each with its total percentage markup; as well as the sales
tax and overtime percentage.
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Note: For more information on Adjust Pricing, see Section 6.8.  For more
information on Owner Costs, see Section 7.5.

Notes

Figure 4.5 Notes/Reference Panel - Notes

When the Notes selection is made, the notes displayed will be the notes for the
item currently highlighted in the Grid Panel.  This can be changed by clicking on
the arrow for the level box just to the right of the Notes box.  You can select to
see the notes for the parent title of the item highlighted in the Grid Panel, as well
as its parent’s parent, and so forth.  Notes may be entered by typing directly into
the Notes field, or by using the Paste command to paste the contents of the
Windows Clipboard into the Notes field.

Cost Summary

Figure 4.6 Notes/Reference Panel - Cost Summary
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When the Cost Summary selection is made, a summary of the costs for the title
highlighted in the Grid Panel is displayed.  The first number is Direct Cost total
for the highlighted title.  Added to that is each Indirect Cost, showing a
percentage, as well as an amount for each Indirect Cost type.  A subtotal is then
displayed showing the Cost to Owner.  Following that is each Owner Cost type,
showing a percentage, as well as an amount for each Owner Cost.  The Owner
Costs are then added to the Cost to Owner to show the Total Project Cost.  When
a Level Selection change is made, the totals will display the totals appropriate for
the newly selected title.  As with the Notes Panel, the titles available for selection
include the currently highlighted title in the Grid Panel as well as its parent, its
parent’s parent, etc.

The Cost Summary Panel is for display only, and cannot be edited.

Adjust Pricing

Figure 4.7 Notes/Reference Panel - Adjust Pricing

When the Adjust Pricing selection is made, you can make adjustments on the
Direct Costs at various levels within the project.  Information on Shipping as a
direct cost column is entered in this panel also.  See Sections 6.8 and 6.9 for
detailed instructions on the Adjust Pricing and Shipping features.

Also available for viewing in this panel at the selected title level is a passive
display of Sales Tax, the Overtime percentage being applied on this title, and the
Prime and Subcontractor markup percentages that apply on this title.
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Owner Costs

Figure 4.8 Notes/Reference Panel - Owner Costs

When the Owner Costs selection is made, you can view, add or edit the Owner
Costs at either the default Owner Cost level or at the lowest title level within the
project.  See Section 7.5 for detailed instructions on defining and applying Owner
Costs within the project.

A field to allow the user to indicate which numbered contingency note(s) applies
to the current contingency cost is also available on this panel.  See Section 7.6 for
instructions on working with Contingency Notes.
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4.4  Modifying the Display

Background

Any of the three panels may be resized, hidden or be the exclusive panel on
display.  Both the Toolbar and the Status Bar may also be hidden.

Resizing the Panels

The panels are divided by borders.  To resize a panel, you click on the border until
the cursor becomes a double line with arrows.  When the cursor has become a
double line with arrows, hold the mouse button down and drag the border in the
direction you want to move it.  When the border is in the desired location, release
the mouse button.

Hiding the Panels

There are three buttons in the Toolbar for use in hiding and redisplaying the three
panels.

  Show/Hide Outline Panel - Clicking on this button will either show or hide
the Outline Panel.  When you open a project, all three panels will be displayed.
Clicking on this button the first time will hide the Outline Panel.  Clicking on this
button the second time will redisplay the Outline Panel.

Alternatively, you can use the View Menu and select Outline Panel to hide and
redisplay the Outline Panel.

  Show/Hide Grid Panel - Clicking on this button will either show or hide the
Grid Panel.  When you open a project, all three panels will be displayed.  Clicking
on this button the first time will hide the Grid Panel.  Clicking on this button the
second time will redisplay the Grid Panel.

Alternatively, you can use the View Menu and select Grid Panel to hide and
redisplay the Grid Panel.

  Show/Hide Notes Panel - Clicking on this button will either show or hide
the Notes/Reference Panel.  When you open a project, all three panels will be
displayed.  Clicking on this button the first time will hide the Notes/Reference
Panel.  Clicking on this button the second time will redisplay the Notes/Reference
Panel.

Alternatively, you can use the View Menu and select Notes/Reference Panel to
hide and redisplay the Notes/Reference Panel.

Making one Panel Exclusive

Using the same techniques as described above, you can make one of the three
panels the only visible panel.

Hiding the Toolbar
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You can free more window space and therefore see more of your estimate by
hiding the Toolbar.  To hide the Toolbar, choose Toolbar from the View menu.
To redisplay it, repeat the menu selection.

Hiding the Status Bar

You can free more window space and therefore see more of your estimate by
hiding the Status Bar.  To hide the Status Bar, choose Status Bar from the View
menu. To redisplay it, repeat the menu selection.
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4.5   Item Form

Background

The Item Form is a window that displays all fields for either a title or a detail

record.  The Item Form is accessed by clicking on the Item Form button:    and
will display the item highlighted in the Grid Panel.  Alternatively, you can choose
Item Form from the View menu.

The Item Form can be moved anywhere on your desktop.  To move the Item
From, click on the Window Title Bar and hold your mouse button as you drag the
Item Form to its new location.  When the Item Form is where you want it, release
the mouse button.

The Item Form uses the tabbed notebook metaphor to permit entry and
modification of title and detail item data.  In the Project, the three tabs are Cost,
Options, and Schedule.  The top part of each form contains the same information,
no matter which tab is being accessed.  For a title, the fields common to each tab
are Title ID, Description, Quantity, Unit of Measure and Database ID.  For a
detail, the fields common to each tab are Sequence ID, Database ID, Description,
Quantity, Unit of Measure, and Crew code.  For more information about the fields
in the Item Form, see Sections 6.1 and 6.2.

Navigation

Next and Previous buttons on the Item Form move you from one item to the next
in a list of details or titles.  Alternatively, you can simply click on a different
record to display the item form for that record.

You do not need to close the Item Form to move from one level to another or
even from one record type to another.  You can click on the Go To Parent button

  while in the Item Form for a Detail and the Item Form will then display the

Parent of the Detail you were on.  You can also click on the Go To Child  
button while in the Item Form for a Title and the Item Form will then display the
first child of that Title.

Variations

The fields displayed on the Item Form vary, depending on which record type is
being displayed.  See Section 6.1 for more information about the Title Item Form
and Section 6.2 for more information on the Detail Edit Form.
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4.6   Summary Information

Background

The Summary Information for the project is accessed by clicking on the Summary

Info button:  .  Alternatively, you can choose File | Summary Info.  The
Summary Information is made up of a tabbed dialog box with 5 tabs:

Each of these contains project wide information.  You can access the Summary
Info for an existing estimate at any time.  When the Summary Info button is
clicked, you are in the whichever tab was accessed most recently.  To access any
other tab, clicking on that tab name will bring that tab information to the front and
allow viewing and entry of data.

Following are the five tabs of the Summary Information Dialog Box.

General Tab

This tab contains general descriptive information about the estimate, including the
project title and description, the estimator’s name, preparation date, as well as
other general information.  See Section 5.3 for more information.

Calculation Tab

The Calculation Tab contains information concerning how and when the estimate
is repriced, the databases to be used when repricing, measurement and currency
information.  See Section 5.4 for more information.

Column Setup Tab

This tab is used to define the cost columns shown within your project and on
printed reports.  These columns represent the cost categories of Project Direct
Costs, Indirect Costs, and Owner Costs.  See Section 5.5 for more information.

WBS Definition Tab

This tab is used to define the Work Breakdown Structure for the estimate.  This is
where you define the project level names, as well as indicating the level for
default Owner Cost information. See Section 5.6 for more information.

Notes Tab

This tab is used to input Project Level notes.  See Section 5.7 for more
information.
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Chapter  5

Starting a New Project

Inherited Characteristics

The first task in starting a new project estimate in MCACES is to create the
Project Database.

When you create a new Project Database, it inherits the column and breakdown
structure of the Project Database that is used in the Template.

Chapter Overview

This chapter explains how to create a new project based on the characteristics of
an existing project.  The chapter then provides instructions on how you can alter
the inherited characteristics as needed.

In This Chapter

The following sections are included in this chapter:

5.1  Creating the Project Database
5.2  About Project Structure
5.3  General Information (General Tab)
5.4  Selecting the Estimate Type (Calculation Tab)
5.5  Naming the Project Columns (Column Setup Tab)
5.6  Setting the Breakdown Structure (WBS Definition Tab)
5.7  Project Level Notes (Notes Tab)
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5.1  Creating the Project Database

Background

When you create a Project Database, it inherits the column and breakdown
characteristics of the Template that is selected in the Begin a New Project screen.
When creating a new Project, you can copy from 0 to 6 levels of titles from your
Template.  Any project database may be used as a Template.  The software is
shipped with supplied templates for Military, Civil Works and HTRW type
estimates, but these may be easily changed.

Adding a Project Database

There are two methods for creating a new Project Database.  One method is to
make a complete copy of an existing estimate.  Copying a Database will copy all
titles as well as all costs.  This method is outlined in Section 16.2.

The method outlined in this chapter should be used when you want to copy titles
without costs.  The use of either method will inherit the column and work
breakdown structure of the original project database.

Procedure

Follow these steps to create a new Project Database.  It is not necessary to close
any open databases.

1. Click on the New icon:   .

Alternatively, you can choose File | New.

Result:  The Create Project As window is opened with the File Name field
highlighted.
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Figure 5.1 Create Project As Window

2. Type the new Project ID in the File Name field.  The project ID is a six-
character code that uniquely identifies this database to the system.  It may
include letters, numbers, hyphens, and underscores, but no other symbols or
spaces.  All six characters must be filled in.

Note:  If you want to change the location of where the project is created, find
the correct drive and directory by first clicking on the down arrow to the right
of the currently selected drive in the Drives: field.  When you see the desired
drive, click on it.  The directories for this drive are now listed in the
Directories field in the center of the window.  Use the scroll bars if necessary
to find the correct directory.  When the correct directory has been selected,
you can then type in the new Project ID as outlined in Step 2.

Result:  The Begin a New Project window is opened.
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Figure 5.2 Begin a New Project Window

3. This is the window where you determine which Template to use as the basis
for this new Project.  If templates have already been selected, they will
appear to the right on the words Military, Civil Works, HTRW and Other.  To
select a new template, click on the Locate Selected Template.. button.

Result:  The Locate Selected Template window is opened.

4. If your desired template is in the default directory, you can scroll through the
lists of projects and double click on the desired project, or highlight the
desired project and click on the OK.

Note:  If you want to use a template located on a different drive or path, find
the correct drive and directory by first clicking on the down arrow to the right
of the currently selected drive in the Drives: field.

Result:  The Begin a New Project window is redisplayed.
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5. You may type in the number of title levels to copy from this template.
Alternatively, click on either the up or down arrow to the right of the Levels
to Copy field to raise or lower the number of levels to copy.  The default is 2.
If you want to copy all 6 title levels, click on the up arrow until the number 6

appears in the Levels to Copy field: 

6. When the template has been selected and the Levels to Copy field has been
completed, click on the OK button.

Result:  The hourglass appears while the new project is being created.  This
will take a moment.  When the process is complete, the new project is
opened.
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5.2  About Project Structure

What Controls Project Structure

MCACES uses three major controls to determine project structure:

• Estimate Type
• Project columns
• Project breakdown structure

Estimate Type

The Estimate Type controls whether labor and equipment pricing depend on the
Crews Database, and whether to reprice crew-dependent labor and equipment
items automatically, using current Labor and Equipment Rates Databases, each
time reports are run.

See Section 5.4 for details.

Project Columns

Project columns define the cost column breakdown of the project.  Cost columns
are designated for Project Direct Costs, such as material, labor, equipment, and so
on, and also for Indirect and Owner Costs.

Example 1 - CIVEXM Project

The sample CIVEXM Project Database provided with MCACES is a sample Civil
Works estimate.  This project uses the following columns:

Direct Costs: Labor, Equipment, Material, Other.

Indirect Costs:  Field Office Overhead, Home Office, Profit, Bond.

Owner Costs: Contingency, Escalation.

Example 2 - MILEXM Project

The MILEXM Project Database, also included with the software, is an example of
a military estimate.  It has the following column breakdown:

Direct Costs:  Manhours, Labor, Equipment, Material, Other

Indirect Costs:  Overhead, Home Office, Profit, Bond.

Owner Costs:  Escalation, Contingency, SIOH (Government Supervision,
Inspection, and Overhead).
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Project Breakdown Structure

The project breakdown structure defines the hierarchical structure of the project,
which is used to total and report the costs in the project columns.

This hierarchical structure organizes cost items under various levels of categories
called titles.  MCACES lets you use up to six levels of titles in a project.

How many levels you use depends on the complexity of the project.  A simple
project with very few tasks might be summarized under a single Level 1 title.
More complex projects might use all six levels.

Example 1:  CIVEXM Project

The CIVEXM Project Database is organized by the Civil Works Breakdown
Structure and uses six levels:

• Level 1 - Contract
• Level 2 - Feature
• Level 3 - Sub-Feature
• Level 4 - Element
• Level 5 - Level_5
• Level 6 - Level_6

Example 2:  MILEXM Project

The MILEXM Project uses six title levels, as follows:

• Level 1 - Scope
• Level 2 - Facility
• Level 3 - System
• Level 4 - Subsystem
• Level 5 - Assembly Category
• Level 6 - Assembly

Defining Project Structure

When you create a Project Database, as defined in Section 5.1, the new project
inherits the project structure and format of the Project Database that was
previously displayed in the database window.

If you want to use this inherited structure, you won’t have to make changes in the
Column Setup or WBS Definition Tabs.

If you need to change any part of the inherited structure, you must perform one or
more of the following tasks.

• Select the Estimate Type, as explained in Section 5.4.
• Name the project columns, as explained in Section 5.5.
• Set the project breakdown structure, as described in Section 5.6
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5.3  General Information (General Tab)

Figure 5.3 Summary Info - General Tab

Accessing the General Tab

The Summary dialog box includes data governing the entire project, including the
types of costs to be estimated and how those costs will be calculated.  When the
Summary Info icon is clicked, you are in the General tab, which is the first tab.
To access any other tab, clicking on that tab name will bring that tab information
to the front and allow viewing and entry of data.

The General Tab is accessed by clicking on the Summary Info icon:  , and
then clicking on the General Tab if it is not already displayed.  Alternatively, you
can choose File | Summary Info.

Result:  The General Tab of the Summary Info Dialog Box is opened.

Field Descriptions

This table describes the fields on the General Tab.
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Field Description

MCACES ID A six-character code that identifies the project.  May
include letters, numbers, hyphens, and underscores
(_), but no other symbols or spaces.  For display only
in this window.  This ID is set in the Create Project
As dialog box which is available when File New is
selected, or by the database ID chosen during a File
Copy process.

File Path The drive letter on your computer and directory path
where this database is located.

Project Title Descriptive name of the database.  Up to 32
characters are allowed.  The name is displayed in the
window title bar when this project database is open.

Description These four lines are available for entering additional
text describing this estimate, such as the location and
description.

Designed By The architect's or engineer's name or the name of
their firm.  For information purposes only.

Estimated By The estimator’s name or firm.  For information only.

Prepared By The estimator's name or firm or consulting firm and
location.  For information only.

Preparation Date The date on which the estimate was prepared.  This
field is for information only and is not used in any
computations.

Escal. Index Date Date of publication for Escalation Indexes used in
the project.  This field is for information only and is
not used in calculations.

Eff. Pricing Date Date for which the pricing in this estimate is
effective.  This field is for information only and is
not used in any computations.

Editing the General Tab

To add or edit the data in any field, click on the field.  If you begin typing
immediately, whatever you type will replace the data currently in that field.  To
insert data in a field, click twice where you want to add data and then begin
typing.  You can use the tab key to go from field to field, or you can click on each
field to edit that field.  When you are finished with the General Tab, you can click
on the Calculation Tab (or any of the other Summary Info Tabs) to continue
working with the Project Summary Info or you can click OK to leave the
Summary Info Dialog box.
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You can go back and edit the information on the Summary Info Dialog Box at any
time. The Summary Information for the project is accessed by clicking on the

Summary Info icon:  .  Alternatively, you can click on File and then click on
Summary Info.
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5.4  Selecting the Estimate Type (Calculation Tab)

Figure 5.4 Summary Info - Calculation Tab

Accessing the Calculation Tab

The Calculation Tab is accessed by clicking on the Summary Info icon:  , and
then clicking on the Calculation Tab if it is not already displayed.  Alternatively,
you can choose File | Summary Info.

Result:  The Calculation Tab is opened.

Field Descriptions

This table describes the fields on the Calculation Tab.

Field Description

Estimate Type See below.

Est. Construction Time The Estimated Construction Time in work days to
complete the project.  Used to compute contractor
Bond premiums if the project is estimated at more
than a year’s duration.  (A year is 260 workdays.)
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Sales Tax The Sales Tax percentage entered in this field is
added to all material costs in the project prior to
computing cost to prime.

Database References This displays the drive, path and database ID of the
supporting databases that were last used to reprice
this estimate.  See Section 8.3, Repricing a Project
Database, for information on selecting new
supporting databases and repricing your estimate.

Measurement Indicates the measurement system (U.S., . Metric or
Original)  to be used in the estimate.  “Original”
means no measurement system has been designated.
If you change the measurement system to U.S. or
Metric and confirm and exit the Summary Info
dialog, the software will convert all units of measure
which are in the other system to the desired system.
Quantity and unit costs will be adjusted accordingly.

Currency Description The name of the currency used in the database.  To
change the currency, you must change this and also
change either the Units for Store/Display field or the
Units per U.S. Dollar field.

Currency Units The units used to store monetary values in the
database and to display them on the screen.  Choices
are:

Ones
Tens
Hundreds
Thousands
Ten Thousands

For example, if you want costs represented in
hundreds of Yen, select “Hundreds”

Currency Units/US $ The ratio of the value of one unit of the chosen
currency to one U.S. Dollar.  If you were working
with Japanese yen and one dollar was worth 135 yen,
you would enter 135 in this field, regardless of
whether or not you had selected “Hundreds” in
Currency Units..  If you were working with Kuwaiti
dinars and one dinar was worth 3.40 U.S. dollars,
you would enter 0.29 (that is, 1/3.40) in this field.
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Estimate Type and Repricing

You select the Estimate Type when you want to choose from different options for
pricing and repricing the project.

These options determine whether cost items in the Project Database make use of
the Crews Database, and how and when cost items copied from supporting
databases are repriced from those databases.

When cost items are copied into a project from a supporting database, their stored
unit costs are copied with them.  If these costs are later changed in the supporting
database, they will differ from the costs in the project.  Repricing the project
ensures that costs copied from a supporting database are up to date.

• MCACES can reprice labor and equipment costs in the project from selected
Labor and Equipment Rates Databases.  Depending on the Estimate Type
chosen, repricing of labor and equipment costs can be done manually
whenever you choose, or it can be done automatically during takeoff, or
whenever the estimate is recalculated or reports are run.  See Section 8.3 for
instructions on manually repricing labor and equipment.

• Repricing of material costs can be done manually at any time from a selected
Unit Price Database.  See Section 8.3 for instructions.

Making a Selection

To select an Estimate Type, click on the down arrow to the right of the Estimate
Type field.  Select one of the following values in the field.  The values are
explained in the paragraphs that follow.

U - Unit Costs; No Crews
K - Crews with Reprice Key
A - Crews with Auto Reprice
C - CACES Mode (with Auto)

U - Unit Costs; No Crews

Select this value when you are not using crews to compute labor and equipment
costs within cost items in the estimate.

This Estimate Type has the following effects:

• When copying cost items into the project from the Unit Price or Assemblies
Database, the program uses the currently computed unit labor and equipment
costs for the items.

• Crew IDs and crew output values stored with these cost items are also copied
into the project, but they are not used to compute costs.

Note:  These values are stored in the project so that they can be used for
computing costs if you decide to change the Estimate Type.  See Types K and
A below.



5-14 MCACES for Windows

• Labor and equipment unit costs currently stored in the Project Database are
used when you recalculate the project or run reports.  You can adjust these
labor and equipment costs independently in the Project Database.

Note:  You can manually update these costs using the rates currently
referenced in the Labor and Equipment Rates Databases by choosing Update
All Pricing on the Tools menu.

K - Crews With Reprice Key

Use this selection when you are working with crews but do not want the estimate
automatically repriced from the supporting databases.

This selection has the following effects:

• When copying cost items into the project from the Unit Price, Assemblies, or
Models Database, the program uses the currently computed unit labor and
equipment costs for the items.

• Crew IDs and crew output values stored with these cost items are also copied
into the project, and are linked to the labor and equipment unit costs of the
items.

This makes it possible to adjust the unit labor and equipment costs of the item
by adjusting the crew output, or vice versa.  See Section 6.5 for information.

• Labor and equipment unit costs currently stored in the Project Database are
used when you recalculate the project or run reports.  Because these costs are
linked, adjusting one of them will automatically adjust the other, and the crew
output.

• Whenever you apply overtime to a title, the results of the overtime will not be
reflected in the numbers until you choose Reprice Labor and Equipment.

Note:  As with Type U, you can manually update these costs with the costs
currently stored in the Labor and Equipment Rates Databases by choosing the
Reprice Labor and Equipment option.  See Section 8.3.

A - Crews With Auto Reprice

Choose this selection when you are working with crews and you do want the
estimate automatically repriced from the Labor and Equipment Rates Databases.

Estimate Type A has these effects:

• When copying cost items into the project from the Unit Price, Assemblies, or
Models Database, the program recomputes each labor and equipment cost
based on the currently selected Labor and Equipment Rates Databases.  (For
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cost items containing crew IDs, the current Crews Database is also used to
recompute these costs.)

• Whenever you recalculate the estimate or run reports, the program
automatically reprices each labor and equipment unit cost based on the
currently selected Labor and Equipment Rates Databases.  For cost items
containing crew IDs, the currently selected Crews Database is referenced for
the crew compositions during the repricing.

• Whenever you apply overtime to a title, the results of the overtime will be
reflected in the numbers as soon as you recalculate the estimate or run reports.

C - CACES Mode (With Auto)

This selection has been intended to provide compatibility with the U.S. Army
Corps of Engineers CACES standard.  At present, this selection gives the same
capabilities as Type A.

After Making a Selection

After making your selection, do one of the following:

• Click on the Reset References button to select different supporting databases.
Refer to the Section 8.3 for details.

• Click on the Column Setup tab to move on to the Selection of Project Cost
Columns.

• Click OK to close this screen without making any further changes.

Changing the Estimate Type

You can change the Estimate Type at any time while working on the project.

Caution:  If you have been working on a project with the Estimate Type set to U
and have edited unit costs for items containing crew references, these costs could
be altered by changing to a different Estimate Type.

Estimated Construction Time

The Estimated Construction Time in workdays to complete the project.  Used to
compute contractor Bond premiums if the project is estimated at more than 12
months duration.  (A year is 260 workdays.)  When the contractor Bond is
calculated using a percentage, rather than using the Bond tables, this field will not
be used for any calculations.

Sales Tax

The Sales Tax percentage entered in this field is added to all material costs in the
project.  The Sales Tax percentage may also be viewed in the Adjust Pricing
Panel.
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Database References

This section of the Calculation Tab displays the drive, path and database ID of the
supporting databases that were last used to reprice this estimate.  The Reset
References button brings up a screen in which you can select different supporting
databases and reprice either the Labor and Equipment or the Material prices for
this estimate.  See Section 8.3 Repricing a Project Database for information on
selecting new supporting databases and repricing your estimate.

Measurement

Indicates the system of measurement to be used in Quantity fields in the estimate.
Valid choices are:

Original Units - System default; the units as entered in the project.  Can
be a mixture of U.S. and Metric.

U.S. Units - United States/English Units of Measure

Metric Units - Units of Measure are Metric.

Note: Estimates may be changed from Original to U.S. or Metric, but once they
are changed from Original, they can never be changed back to Original.
Changing the Measurement field of a database involves a database conversion.  It
is recommended that you make a backup copy of your database before it
undergoes any database conversion.

Also Note: A report may be printed in Metric without actually converting the
database to metric.  See Section 15.2 for information about Report Setup.

Currency Description

The name of the currency used in the database.  To change the currency, you must
change this, and also change either the Units for Store/Display field or the Units
per U.S. Dollar field.
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Currency Units

The units used to store monetary values in the database and to display them on the
screen.  Choices are:

Ones

Tens

Hundreds

Thousands

Ten Thousands

Currency Units/US $

The ratio of the value of one unit of the chosen currency to one U.S. Dollar.
Examples: If you were working with Japanese yen and one dollar was worth 135
yen, you would enter 135 in this field.  (You may prefer to display the YEN in
units of Hundreds, rather than Ones.  If so, then you would enter 1.35 in this
field.)  If you were working with Kuwaiti dinars and one dinar was worth 3.40
U.S. dollars, you would enter 0.29 (that is, 1/3.40) in this field.

Note: Changing the Currency fields of a database involves a database conversion.
It is recommended that you make a backup copy of your database before
undergoing any database conversion.
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5.5  Naming the Project Columns (Column Setup Tab)

Figure 5.5 Summary Info - Column Setup Tab

Accessing the Column Setup Tab

The Column Setup Tab is accessed by clicking on the Summary Info icon:  ,
and then clicking on the Column Setup Tab if it is not already displayed.
Alternatively, you can choose File | Summary Info.

Result:  The Column Setup Tab is opened.

Purpose

The fields on this tab determine the format and contents of cost columns shown
on project screens and printed reports.

You can define as many as five columns each for Project Direct Costs, Indirect
Costs, and Owner Costs.
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Column Titles

Each of the Cost Columns in this tab have a Field Type and a Column Title.  The
Field Types are described below.  The Column Title is the title that appears both
on screen and in report headings.  When System Defined Field Types are chosen,
a Column Title is assigned automatically.  In addition to defining user-named
columns, you can rename the predefined Field Types.  Renaming a predefined
column does not affect its calculation.  For example, you might choose to rename
the Equipment column as "Plant."  There are a maximum of 8 characters available
for each Column Title.  The longer titles for Indirect and Owner Costs that appear
in the tail of some Project Summary Reports are entered in the Format Columns
Tab of the Report Setup Dialog Box.  See Section 15.2 for more information on
the longer titles.

Column Types

MCACES provides certain predefined column types for Direct, Indirect, and
Owner Costs.  These predefined types have specific computational characteristics,
which are described in the paragraphs that follow.

The program also allows you to define user-named columns.

Caution

MCACES allows you substantial freedom in choosing the location of cost
columns on screens and reports.  However, once you have added cost data to a
project, changing the order of the cost columns will not relocate your data to the
appropriate column, and may therefore result in invalid output.

You can safely add columns to the right of existing columns, whether the existing
columns already contain data or not.  Also, you can prevent columns from being
printed on reports simply by entering 0 for that column in the Report Width field
on the Format Columns tab of the Report Setup dialog box.

Project Direct Cost Types

Following are the predefined Direct Cost column types and how they are
computed by the program.

Manhours

The program totals the number of labor hours required for each cost item and at
each title level and places that number in the Manhours column.  If crews are
used, the unit Manhours value for an item equals the total number of labor hours
in the crew divided by the crew output figure.

This column type is unique in that it is a measurement of hours rather than costs.
Manhours are not used in project cost calculations, but they are measured and
reported as an aid in project scheduling.

Labor
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The program places the total calculated labor cost associated with an item or title
in this column.

For cost items copied from a supporting database, these labor costs are repriced
from the current Labor Rates Database whenever you choose the Reprice Labor
and Equipment function from the Update All Pricing choice on the Tools menu.
See Section 8.3.

If the Estimate Type is A (Crews with Auto Reprice) or C (CACES Mode), the
labor costs are repriced automatically whenever you copy cost items into your
project, recalculate the estimate or generate reports.

Labor costs may be affected by applying overtime at the lowest title level in the
project.  See Section 6.7 for making overtime adjustments.

Equipment

The program places the total calculated equipment cost associated with an item or
title in this column.

For cost items copied from a supporting database, the equipment costs are
repriced from the current Equipment Rates Database under the same
circumstances as noted above for Labor costs.

Equipment costs may be affected by applying overtime at the lowest title level in
the project.  See Section 6.7 for making overtime adjustments.

Material

The program places the total material cost associated with an item or title in this
column.  The total accumulated in this column is used to compute sales tax, based
on the sales tax percentage entered on the Calculation Tab.  Note that any sales
tax applied to the material costs will be included in any totals labeled as Direct
Costs.

For cost items copied from a supporting database, the material costs are repriced
from the current Unit Price Database whenever you choose the Reprice Material
function from the Update All Pricing choice on the Tools menu.  See Section 8.3.

Shipping

If you define Shipping as a column, shipping costs are computed for every item
that has a value recorded in the Equivalent Shipping Weight field on the cost item
entry screen.  (The Equivalent Shipping Weight is computed by the program.
This is the weight the program uses to calculate the shipping cost of the item.  If
the item weighs less than 56 LBS/CF, then you enter values in both the Unit
Weight and Unit Volume fields, and the program computes the Equivalent
Shipping Weight for cost purposes.  Otherwise, the Equivalent Shipping Weight
is set equal to the Unit Weight that you enter.)
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The program multiplies the item's equivalent shipping weight by the shipping rate
you enter in the Adjust Pricing Panel and places the result in the Shipping column
for the item.  The sum of all shipping costs under any title is computed and placed
in this column on the title entry screen.  See Section 6.9 for details.

Unit Cost

This column type can be used within a project cost item to store work quoted by a
subcontractor to the currently assigned contractor.  The difference between the
Unit Cost cost type and a User Defined cost is that there is a Unit Cost column in
the Unit Price Book also, so that unit costs may be stored in the Unit Price Book
and copied into the project using the Lookup procedure.  See Section 6.3 for more
information on copying detail cost items from the Unit Price Book into the
Project.  This quote may include labor, equipment, material, sales tax, and other
costs, as well as the subcontractor's markups.  By entering the quote as a lump
sum, you can insure that:

Sales tax will not be applied to material a second time, since the program applies
sales tax only to costs in the Material column.

If you use the Unit Cost column in this way (including all markups in one lump
sum), you will need to ensure that you have not applied a subcontractor to this
item, so that the item does not accrue duplicate subcontractor markups.

User Named

This Field Type allows you to name the cost column.  It does not accrue sales tax
and may not be stored in the Unit Price Book.

Unused

Up to five columns are allowed.  If you use fewer than five, the remaining
columns will default to Unused.

Project Indirect Cost Types

Indirect Costs may include contractors' overhead, profit, and bond costs, as well
as other costs that are distributed over all or part of a project.

See Chapter 7 for information on how to define contractor records and their
markups.  For each of the predefined types, you can enter a percentage, an amount
for the costs or use the program to compute a value.  Different computation
options are also provided, specific to the column type.

The predefined types are as follows.

Overhead
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This column represents contractors' overhead costs.  This column may be
calculated as a percentage of Direct Costs only, or as a running percentage based
on the sum of Direct Cost and other Indirect Cost columns that you place to the
left of this column.  A contractor’s overhead can also be computed as a separate
percentage on contractor’s own work versus work performed by subcontractors,
or it can be figured directly as the sum of specific cost items that you enter under
each contractor's record.  See Sections 7.3 and 7.4.

Profit

This column type represents contractors' profit.  As with overhead, the cost can be
calculated as a direct or running percentage, or it can be computed separately for
subcontractors.  Another option is to compute profit according to profit-weighted
guidelines as used in U.S. Government contract procurement practices.  See
Sections 7.3 and 7.4.

Bond

The Bond column shows contractors' bond costs.  This figure can be computed as
a direct or running percentage.  You can also choose to compute the bond costs
based on data tables that store values for each bond class.  These tables are
maintained by the System Administrator.  Editing the Bond Tables is an advanced
MCACES Gold option that is not available in the current version of MCACES for
Windows.   Refer to Sections 7.3 and 7.4 for more information about Indirect
markups.

Project Owner Cost Types

Project Owner Costs are computed after contract costs (Direct plus Indirect Costs)
and are used to estimate costs outside of typical construction contracts.  Owner
Costs can be assigned at the lowest title level and also at the default Owner Cost
Level, which you specify on the WBS Definition Tab of the Project’s Summary
Info dialog box.  (See Section 5.6).

You can use the predefined Owner column types described below, and you can
also select user-named columns.  For user-named columns, you can enter an
amount or compute the costs based on an entered percentage.  Refer to Section 7.5
for details.  Examples of user-named cost columns you might define include:

• Owner Furnished Property
• General and Administrative Costs
• SIOH (Government Supervision, Inspection, and Overhead)

The two predefined types are Escalation and Contingency.
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Escalation

Defining an Escalation column enables you to use MCACES to compute an
escalation value based on starting and ending escalation indexes, which you enter
on the Owner Cost Panel.  See Section 7.5 for details.  You can also enter the
value for this column as a percentage or an amount.

Contingency

This column can be computed as an amount or a percentage.  The only
computational difference between Contingency and user-named columns is that
the value of the Contingency column is transferred to the Contingency column in
the MCACES Gold 2nd View capability.  Values entered in the Contingency
column are annotated using a separate Project-wide Contingency Notes function.
See Section 7.6 for more information about Contingency Notes.

Completing the Tab

Complete each Field Type on the tab by clicking on the pulldown menu and
selecting the desired Field Type.

Complete each Column Title by either accepting the default or clicking on the
field and typing in the desired Column Title.

When you have finished filling in the tab, click on the WBS Definition Tab Label
to go on to the next tab, or click on OK to save this and close the Summary Info
Dialog Box.

Note:  You can also exit at any time without saving your changes by clicking the
Cancel button.

Field Descriptions

Field Description

Direct Cost Columns

Field Type The kind of Direct Cost listed in the column.  Values
are:
Manhours
Labor
Equipment
Material
Shipping
Subcontractor
User Named
Unused Column
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Column Title Title to appear on the column.  Except for user-
named columns, the title is derived from the Col.
Type field.  You can, however, change the name of a
predefined column without changing its calculation
procedures.

Up to 8 characters are allowed.

Indirect Cost Columns

Field Type The kind of indirect cost item listed in the column.
Codes are:

Overhead
Profit
Bond
User Named
Unused Column

Column Title Same as for Direct columns, above.

Owner Cost Columns

Col Type The kind of owner cost item listed in the column.
Codes are:
Escalation
Contingency
User Named
Unused Column

Column Title Same as for Direct columns, above.
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5.6  Setting the Breakdown Structure (WBS Definition Tab)

Figure 5.6 Summary Info - WBS Definition Tab

Accessing the WBS Definition Tab

The WBS Definition Tab is accessed by clicking on the Summary Info icon:  ,
and then clicking on the WBS Definition Tab if it is not already displayed.
Alternatively, you can choose File | Summary Info.

Result:  The WBS Definition Tab is opened.

Background

The Work Breakdown Structure (WBS) Definition Tab defines the overall
hierarchy of a Project.  This includes the number of title levels used and the
number of characters used to identify each title level in a title's Database ID.  (See
below).

You must set the breakdown structure before you start adding titles or detail cost
items.  Once the database contains titles, you cannot modify the breakdown
structure, except to add more title levels.  (You can, however, change the Level
Names, at any time.)

About WBS IDs
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Each title in a project is assigned a Database ID, which identifies its place in the
database hierarchy.  This ID is always displayed when the title is displayed.
Example:  A Level 3 title might have a database ID of 12.044.06.  In this case, 12
is the Level 1 ID (two characters in length), 044 is the Level 2 ID (three
characters in length), and 06 (two characters) identifies the specific title at Level
3.  In this example, the periods are trailing separators for each title level.

You use the WBS Definition Tab to define the Length and Trailing Separators for
the database IDs used at each title level in the Project.

Each title in a project is assigned a unique ID called the WBS ID.  This ID
specifies the title's place in the overall project hierarchy.  This ID is displayed in
the Grid Panel when the title is displayed.

Example:  A Level 3 title might have a WBS ID of 12.04.06.  In this case, 12
identifies the Level 1 title under which this title is found, 04 identifies the Level 2
title, and 06 identifies the actual title at Level 3.  In this example, the periods are
defined as trailing separators for each level.

Note on Alternate Costs

The decision to use alternate costs may affect the number of title levels or the
length of project IDs you need to define.  If you are working with alternate costs
in an estimate, the usual method is to define each alternate situation as a separate
Level 1 title.

See Section 6.12 for more information on working with alternate costs.

Completing the Tab

Complete each field on the tab by clicking in the field and typing the desired
information.  Refer to the Field Descriptions below for more details.

When you have finished filling in the tab, click on the Notes Tab Label to go on
to the next tab, or click on OK to save this and close the Summary Info Dialog
Box.

Note:  You can also exit at any time without saving your changes by clicking the
Cancel button.

Field Descriptions

Following are the fields on the WBS Definition Tab.

Field Description

Project Title Level
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Level Name Name used to describe all the titles at this level of the
project.  Up to 8 characters are allowed.  This name
is used in Project Summary Report headings.

Examples:  Scope, Bid Item, Feature, Floor#.

No of Chars Number of characters used to identify this level in a
Title ID.  Valid range is 2-6 characters.  The total for
all the levels used cannot exceed 16, excluding
separators.

Trail Sep Trailing Separator.  A character or symbol used to
separate this level's identifier in the Title ID from the
identifier of the next subordinate level.

Enter a space to use a space as the separator.  Enter N
to designate no separator.

Owner Cost Level This field identifies which project level (0-6) is the
default level for applying Owner Costs.  Refer to
Section 7.6 for more information on Owner Costs.
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5.7  Project Level Notes (Notes Tab)

Figure 5.7 Summary Info - Notes Tab

Accessing the Notes Tab

The Notes Tab is accessed by clicking on the Summary Info icon:  , and then
clicking on the Notes Tab if it is not already displayed.  Alternatively, you can
choose File | Summary Info.

Result:  The Notes Tab is opened.

Adding or Editing Project Notes

Project Level Notes may be accessed from either the Notes Tab on the Summary
Info Dialog Box or by choosing Project Level in the Level pulldown list in the
Notes/Reference Panel in the project.  These notes are printed on a page following
the title page of reports.

Click on the Notes field to begin typing Project Level Notes.  Up to 20,000
characters may be entered in this field.
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Copying from the Windows Clipboard

You may want to create and spell check your project notes in a word processor.
Entire documents from a Windows based word processor may be copied to the
Windows clipboard and then pasted into the Notes field using the following
procedure:

1. Leaving MCACES open, start your Windows based word processor.

2. In your word processing package, select the entire document.  For
example, in Words for Windows, you would use the Select All
command under the Edit menu.  Alternatively, you can click on the top
of the selection and drag your mouse over the text to be copied.

3. Click on Copy to copy this selection to the Windows clipboard.

4. Use Alt Tab to go back to MCACES.

5. If not already open, open the Summary Info Panel and then click on
the Notes Tab.

6. Go to the location in the notes where you want the new text.

7. Hold down the Control key and press V.

Result:  The selected text will be pasted into your Project Notes field.
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Chapter  6

Working With Project Direct Costs

Chapter Overview

This chapter explains how to build a project by adding titles and detail cost items.
The chapter also discusses how to edit and delete titles and items after they've
been entered.

To help you build estimates efficiently, MCACES provides varied and powerful
options for inputting and computing Direct Cost data.  These features are also
explained in this chapter.

In This Chapter

The following sections are included in this chapter:

6.1 Adding Titles
6.2 Adding Cost Items
6.3 Using Lookup and Find
6.4 Editing and Deleting
6.5 Working with Crews
6.6 Working with Crews as Assemblies
6.7 Adjusting for Overtime
6.8 Using Adjust Pricing
6.9 Working with Shipping Costs
6.10 Working With Assemblies
6.11 Using Modifiers in the Project
6.12 Working with Alternate Costs
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6.1  Adding Titles

When to Use

As discussed in Chapter 5, you can begin a new estimate by copying any number
of levels of existing titles.  If you copy 0 levels of titles, you will begin building a
project by adding titles, starting with a Level 1 title.  You can also add titles at
any time during the process of developing the estimate.  This section covers the
steps used to add titles, and then discusses the fields in each title form.

Definitions

In discussing database structure in MCACES, the terms "title" and "title element"
have specific meanings.

• A title is a category in a database.  This term is also applied to the database
record representing that category.  Up to six levels of titles can be defined in a
project database hierarchy.

• A title element (or element) is defined as a title at any level plus all of the
subtitles and detail items beneath it.  If a database hierarchy is envisioned as a
tree structure, then a title element can be said to represent one branch of that
tree.

Note:  The structure of MCACES is such that any title may have either a
subtitle or detail cost items beneath it, but it may not have both a subtitle and
detail cost items beneath it.

Adding the First Title

To create your first level 1 title, highlight the project description in the Outline
Panel and click on the Add Record icon    in the toolbar.  Alternatively, you
can click on Edit and then Add New Record.

Result:  The title Item Form (Figure 6.1) is displayed:



Working With Project Direct Costs 6-3

Figure 6.1:  Title Item Form, Project Database

The title Item Form has three tabs:  Cost, Options, and Schedule.  The top part of
each form contains the same fields on all three tabs:  Title ID, Description,
Quantity, Unit of Measure and Database ID.  See below for descriptions of each
field on the form.

Adding Additional Titles at the Same Level

To continue adding Level 1 titles, when you have completed entering data for the
first title, click on Next.

Result:  The title you added will be saved and a new title entry form will be
opened, with a Title ID incremented by five.
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Adding Subtitles While in the Add Mode

When you have completed entering data for any title, if you want to add a title as
a subtitle to this title, before closing the form, click on the Go To Child icon  .

Result:  The title you added will be saved and you will be presented with the
following dialog box:

Figure 6.2:  "Which Type of Item to Add?" Dialog Box

To continue adding titles, click on the Subtitle button.

Result:  A new title entry form will be opened at the level below the current level.
The new title will have the default Title ID of 5.

Adding Titles at Any Time

At any time, you can add titles to any level of your estimate.  The only exception
is that if a title already has detail cost items beneath it, you cannot add a subtitle to
this title.

Position the highlight on the parent title in the Outline Panel.  Click on the Add
Record icon:    If there are no existing children to this title, you will be asked
“Which type of item do you wish to add to the empty Grid Panel?”  (If there are
existing subtitles, you will not be asked this question because you can only add a
subtitle to a title that already has a subtitle.)  To continue adding titles, click on
the Subtitle button.

Default Data

If you are adding to an existing list of titles, the Item Form will contain data
copied from the title that was highlighted in the Grid Panel when you clicked on
the Add Record icon.  This default data, which is displayed as green until the field
has been entered by the cursor, is provided to save you keystrokes, since some
field information will often be the same from one title to the next.
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The Title ID for the first title defaults to 5.  Additional titles at the same level will
default to the highest title ID plus 5.  To override the default Title ID enter a
number in the ID field to specify the new title's place in the hierarchy (see below).
Then edit the rest of the data as needed to define the new title.

To replace the description, click once on the description field and begin typing.
To insert or change only a portion of the description, click twice on the place
where you want to insert.  A fast double click will allow you to replace a single
word in the description.

Filling in the Item Form

Click or use the Tab key to move from field to field on the form.  Click on the
other tabs of the form to bring them forward.

Canceling and Erasing Data

You can exit at any time without saving the data by pressing the Esc key.

Exception:  Certain fields on the title Item Form automatically update other
records.  The Quantity field on an assembly title is an example.  If you change one
of these fields, the data is saved automatically.

Until the record has been saved, there are two ways you can undo data entered by
mistake.

• To undo data without closing the Item Form, click the toolbar Undo icon  
or choose the Undo Record Changes command on the Edit menu.

• To undo data and close the Item Form, press the Esc key.

Once a record has been saved, you can erase it by selecting the record and
choosing the Delete Current Record command from the Edit menu.

After Filling in the Item Form

When you have finished filling in the title Item Form, you can do any of the
following:

• Click on the Next button to save the title and begin adding another title at this
level.

• Click on the Go To Child icon  to save the title and begin adding a subtitle.

• Click on Close to close the Item Form.  Click on another record to save this
record.
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Common Fields on the Title Item Form

The following fields are common to all three tabs on the title Item Form:

Field Description

WBS ID The first part displays the Work Breakdown Structure
(WBS) of the parent title.  This part is for display only.  The
second part is the ID of the title at this level.  This field is
accessible when initially adding the record, and is no longer
accessible after the record has been saved.

The number of characters allowed in this field depends on
the Length you assigned to this level on the WBS Definition
Tab in the Summary Information Panel.

Description Name of the title.  The name should describe the element of
the project containing all titles and cost items that fall below
this title. Description can be up to 32 characters in length.

Note:  You can access additional space to describe the title
by clicking on the Notes/Reference Panel and inputting
notes there.  See Section 15.2 for details.

Quantity Quantity associated with this element of the project.  Used
with the unit of measure in the next field.

Entering a quantity value here enables MCACES to
compute a unit cost for this title element.

Also, if you use the Cost Override (explained below), you
must enter a Quantity in order to compute extended costs
based on the unit costs that you enter.

Unit of Measure This unlabeled field contains the unit of measure relevant to
the quantity.  This is the unit applied to unit costs at this title
level.

Examples:

SF - square feet
CY - cubic yards

Refer to Appendix E for a list of valid units of measure.

Database ID The database ID of the crew or assembly copied from the
Crews or the Assemblies Database.
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Costs Tab

In addition to the fields common to all three tabs, the Costs Tab (Figure 6.3)
displays the Unit Costs and the Extended Costs for the Direct Cost Columns that
have been set up for this project.

Figure 6.3:  Title Item Form, Costs Tab

The Cost fields will show all zeroes until you do one of the following:

• Add cost items below the title and recalculate the project using the Recalculate
icon  .  (The project is also recalculated automatically if you run reports.)

• Set the Cost Override field to Yes and then enter unit costs.  By entering a
Quantity value, you can then calculate the extended costs.

 The following fields are displayed on the Costs Tab of the title Item Form:

 Field  Description

 Unit Cost
(Labor, Material,
Equipment, etc.)

 Each of the direct cost types is displayed with the unit cost
per the title’s Unit of Measure, based on the Extended Cost
and the Quantity that has been input for this title.  This field
is for display only, unless a Cost Override has been applied
on this title.

 Extended Cost
(Labor, Material,
Equipment, etc.)

 Each of the direct cost types also display the Extended Cost
for each direct cost type that has been defined for this
estimate.  This is a calculated field for display only, and can
not be edited.
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 Field  Description

 Cost to Prime,
Unit Cost

 This unit cost is the total of the individual Direct Cost Unit
Costs.  This includes sales tax, Overtime, Adjust Pricing
and Subcontractor Markups.  It is calculated by dividing the
Cost to Prime Extended Cost by the Quantity for this title.
This is for display only, and cannot be edited.

 Cost to Prime,
Extended Cost

 This is the total Cost to Prime for this title. This includes
sales tax, Overtime, Adjust Pricing and Subcontractor
Markups. This is a calculated field for display only, and
cannot be edited.

 Project Cost,
 Unit Cost

 This is the unit cost for this title including all Indirect and
Owner Cost markups.  It is calculated by dividing the Total
Project Cost for this title by the Quantity for this title.  This
is for display only, and cannot be edited.

 Project Cost,
Extended Cost

 This is the Total Project Cost for this title.  This total
includes Direct Cost, Indirect Costs and Owner Costs.  This
is a calculated field for display only, and cannot be edited.

 

 Options Tab

 The Options Tab (Figure 6.4) is used to define additional information about the
title.

 

 Figure 6.4:  Title Item Form, Options Tab
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 Field  Description

 Contractor  Two-character ID of a contractor assigned to this title.  This
field has a pulldown menu, from which you may select any
of the contractors which have already been created for this
project.  If the contractor you wish to apply to this title is
not available on the pulldown menu, you must create the
contractor record first.  See Section 7.3 for information on
Defining Contractors.

 If the Contractor Override field below is set to Yes, then
this ID overrides any Contractor IDs set at lower title levels.

 Refer to Chapter 7 for more information on contractors.

 Cat Code  This field can be used to enter Category Codes as used by
the Department of Defense for ENG Form 3086 cost
reporting.

 Contractor
Override

 Click on the checkbox to override any Contractor IDs set at
lower levels with the Contractor ID for this title.  Otherwise,
leave this field empty (default).

 Cost Override  If this field is checked, the user can input unit costs directly
on this title record, and all subtitles and detail cost items
below this record will be ignored.

 Link as Assembly  This field only appears on lowest title level titles.  If this
field has a check, then this title is the parent in a standard
Assembly or a Crew as Assembly.  The quantity fields of all
Labor or Equipment items beneath this title are linked to
this title’s Duration.  The quantity of all other details will be
linked to this title’s Quantity.  The link is created either
when this box is checked or when a detail is added under a
title that has this field checked already.

 HCAS  Clicking this button will bring up an input screen for the
entry of data used to create a report for entry to the HCAS
software.
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 Schedule Tab

 The Schedule Tab (Figure 6.5) applies to lowest level titles only and is used when
using the Crew as Assembly feature or when applying overtime in the project.

 

 Figure 6.5:  Title Item Form, Schedule Tab

 Crew as Assembly Information

 Note: See Section 6.6 for more information about Crews as Assemblies.

 Field  Description

 Production Rate  The amount of work the crew will perform, per the duration
unit of measure of the title.  Example: 500 CY/HR.  This
field is used when using the Crew as Assembly feature.

 Duration  The amount of time the crew will need to perform the
activity defined by the title.  This field is calculated as the
title quantity divided by the Production Rate, but may also
be entered directly, in which case the quantity is held fixed
and the Production Rate field is calculated.  This field is
used when using the Crew as Assembly feature.

 Duration Unit of
Measure

 The unit of measure used for the Duration of this activity.
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 Overtime Computation Information

 Note: See Section 6.7 for more information about adjusting for Overtime.

 Field  Description

 No. of Work Days  Number of workdays per week for the task defined by this
title.  Valid values are 5, 6 or 7.

 Shifts/Day  Number of shifts per day.  Valid values are:

 1 Shift, 8 hours

 2 Shifts, 8 and 7.5 hours

 2 Shifts, both 7.5 hours

 3 Shifts, all 7.5 hours

 Overtime
Differential

 Indicates the overtime differential and which days it is
applied.  Valid values are:

 Pay time-and-1/2, Monday through Saturday, double-
time on Sunday

 Pay time-and-1/2, Monday through Friday, double-time
on Saturday and Sunday

 Pay double-time all days

 Total Hours per
Day

 Total number of hours worked per day.  The program fills in
this value based on the Shifts/Day field, but allows you to
enter a different value as an override.

 Overtime
Percentage

 Computed by the program.  This is the total labor markup
percentage for the overtime situation defined on this title.
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 6.2  Adding Cost Items

 Where to Add Cost Items

 You can begin adding detail cost items beneath a title at any time.  You do not
have to use the complete project hierarchy.

 In other words, you might add cost items beneath Level 2 titles in one part of the
project, while adding them beneath Level 5 titles in another part.  In this way, the
more complicated portions of a project can be broken down to greater depth than
is necessary with less complicated portions.

 Restriction:  The only restriction is that you cannot add cost items beneath a title
for which subtitles already exist.

 Supporting Database Versus User Defined Cost Items

 The method of adding a cost item differs depending on whether you are copying
an item from a supporting database or creating a user-defined item within the cost
estimate.

 You can use any of the following methods to define a cost item in the Project
Database:

 • Copy an item from the Unit Price Database.
 • Copy an item from another Project or an Assemblies Database.
 • Copy an item from the Labor or Equipment Rates Database.
 • Create your own cost item.

 Copying a Unit Price Database Item

 To copy an item from the Unit Price Database, you first use the Lookup feature to
find open the UPB and find the item.  The easiest way to copy items is to use the
Drag and Drop feature, as shown in the following procedure.

 Note:  See Chapter 3 for a detailed, step-by-step example.  See Section 6.3 for
more information on using Lookup and Find Keyword.

 1. In the Outline Panel of your Project Database select the title that you want to
add the detail item under.  (This must be a title with no subtitles.)

 Note:  If there are not already detail items under this title, the Grid Panel will
be empty.

 2. Open the Unit Price Database by clicking on the UPB icon    or by using
the Lookup, Unit Price Book command on the Window menu.

 Note:  If this is the first time you have opened a Unit Price Database from
this project, you will use the Open dialog box to select a Unit Price Database.
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 3. Choose Tile Vertically from the Window menu to place the project and UPB
windows side by side.

 4. Search through the UPB until finding the item you want to copy.  Highlight
that item in the Grid Panel by clicking on the field on the far left.

 5. Click on the Description field of the same item and drag the item to the Grid
Panel in the project window.  (Drag by clicking on description field of the
item and then holding the mouse button down as you move the cursor over to
your project.  Release the mouse button when the cursor is over the project
Grid Panel.)

 Note:  When you are dragging the item from the UPB to the project, the
cursor becomes a circle with a slash through it to let you know that you are
over an area where you can not drop it.  When the cursor becomes a book and

pointer    it means that you are over an area where you can drop it.

 6. Enter the quantity appropriate for your estimate in the Quantity field on the
Grid Panel.

 7. If you choose, you can also adjust the costs or other data for the item by
displaying the detail Item Form.  Choose Item Form from the View Menu or

click the Item Form icon .  (Refer to the Item Form field descriptions
below for more information.)

 Note:

 If you are working with crews (the Estimate Type is K, A, or C) the labor
and equipment costs are tied together.  Adjusting one cost automatically
changes the other.  For example, if you increase the labor cost by 10%, the
equipment cost is automatically increased by 10% as well.

 Therefore, you cannot independently adjust labor or equipment costs of
crew-dependent items in the Project Database.  If you need to adjust labor
or equipment costs independently for these items, you can do so in the
Labor and Equipment Rates Databases.  You can, however, adjust the
crew's hourly output figure in the project.  You may also change the Crew
ID to N/A and then independently change the Labor and Equipment costs.
Refer to Section 6.5 for more information.

 Copy a Project or Assemblies Database Item

 You can also copy an individual cost item from another project or an Assemblies
Database.  The methods and options are exactly the same as copying from the
Unit Price Database, as discussed above.



6-14 MCACES for Windows

 Copying a Labor or Equipment Item

 You can also copy detail cost items directly from the Labor or Equipment Rates
Databases.  These items are listed as individual items in the project, with labor or
equipment costs independent of the crew compositions stored in the Crews
Database.

 Note:  Typically, you would use a method of adding items similar to this if you
are working with crews as assemblies, which is discussed in Section 6.6.

 To add a Labor or Equipment Rates Database item to the Project Database, use

the same instructions as above for the Unit Price Database.  Click on    to open

the Labor Rates Database or on    to open the Equipment Rates Database.
Alternatively, you can use the Lookup command on the Window menu to open
either database.

 Notes:

• If you copy an Equipment Rates Database item, MCACES may ask you if you
also want to copy linked items or attachments.  These are additional, related
items that you can choose to copy at the same time.  Refer to Section 13.3 for
more information.

• If you later reprice the estimate, the item's labor or equipment cost will be
changed back to the cost recorded in the source database.  See Section 5.3 for
information on repricing.

 Applying Different Rates

 When you copy an item from the Labor Rates Database, MCACES  automatically
applies the standard laborer rate for the item.  Similarly, when you copy an item
from the Equipment Rates Database, MCACES automatically applies the rate for
average working conditions for the equipment.

 • For labor items, you can choose to substitute an apprentice or foreman rate.
These rates are computed as adjustments to the laborer rate, as described under
"About Foremen and Apprentice Rates" in Section 9.4.

 • For equipment items, you can choose to substitute a standby rate or a rate for
severe conditions (if one is available).  These rates are stored separately for
items in the Equipment Rates Database.  (See Section 13.3.)

 To apply a different rate for a labor item or equipment item:

 1. First copy the item from the Labor Rates Database or Equipment Rates
Database, as described above.

 2. Open the detail Item Form and click on the Schedule Tab.

 3. Click on the pulldown list for the L/E Type field.
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 4. Click on the appropriate L/E Type to choose the rate you want

 • For labor items, choose Apprentice or Foreman

 • For equipment items, select Severe Equipment or Unused/Standby
Equipment.

 5. Click on Close to leave this form, or Tab to another field to save this entry.

 6. Click on the Recalculate icon  to see the effects of the changed L/E Type.

 Result:  The item's new rate is applied and displayed in the labor or
equipment cost column in the Costs Tab.

 Creating Your Own Cost Item

 To create your own cost item, do the following:

 1. In the Outline Panel of your Project Database select the title that you want to
add the detail item under.  (This must be a title with no subtitles.).

 2. Click on the Add Record icon  or select Add New Record from the Edit
menu.

 Note:  If there are not already detail items under this title, the Grid Panel will
be empty.  MCACES asks which type of item you want to add, title or detail?
Select Detail and continue.

 Result:  The detail Item Form is displayed.

 3. Fill in the form to define the cost item.  See the Field Descriptions below.

 4. Choose Close to exit the form and save the new item.

 Note:  If, while defining an item, you enter a database ID that matches the ID
of an item in a source database, that item will be copied in and the item will
no longer be independent of a source database.  If this happens, simply
change the entry in the Database ID field and continue.

 Default Data

 If you are adding to an existing list of cost items, then the new item appears on the
Grid Panel and Item Form with data copied from the cost item that was
highlighted when you began adding the new item.  As with titles, this default data
is provided to save you keystrokes for fields that require the same entries from
one item to the next.
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 Detail Item Form

 The detail Item Form (Figure 6.6) contains three tabs:  Costs, Options, and
Schedule.

 

 

 Figure 6.6:  Detail Item Form, Project Database
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 Common Fields on the Detail Item Form

 The following fields are common to all three tabs on the detail Item Form:

 Field  Description

 Sequence ID  The Sequence code has three possible uses.  The first use is
to determine the order in which items are displayed and
printed.

 The second use is to sequence detail cost items so that when
the project is brought up in the Scheduling Interface, the
items will be already sequenced to produce the desired
duration for the lowest title level.

 The third use is to store the Item Selection Parameter
Worksheet reference code, when using Item Selection
Parameter Worksheets in MCACES GOLD version 5.30 to
select detail items.

 Up to four characters are allowed.

 Database ID  This ID is copied from either the Unit Price, Labor Rates, or
Equipment Rates Database.  For user created items, you can
enter an identifier here.

 Description  Description of the item.  This is read from the source
database for copied items.  Entered here for user-created
items. Description can be up to 64 characters in length.

 Quantity  Quantity of the item to be used in the estimate.  Used in
conjunction with the Unit of Measure field.

 Unit of Measure  Unit used to describe the quantity.

 Examples:

SF - square feet
CY - cubic yards.

 Refer to Appendix E for a list of valid units of measure.

 Crew:  ID of the crew, in the Crews Database, that is referenced by
this item.
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 Costs Tab

 The Costs tab (Figure 6.7) is used to define basic cost information for the item.

 

 Figure 6.7:  Detail Item Form, Cost Tab

 Field  Description

 Unit Cost  Unit costs are initially copied with the item from the Unit
Price or other database, or entered by the user for user-
defined items.  The unit costs may be modified at any time.

 Extended  Extended costs are the unit costs multiplied times the value
of the Quantity field.

 Override -
Labor/Equipment

 If X, a user has modified the labor or equipment unit costs
or the crew output, or has applied an override to the crew
referenced by the item.

 Override -
Material

 If X, a user has modified the material unit cost.

 Override - Blank  If Blank, the Unit Cost is from the supporting database.

 Note:  If the item is User Defined, with a Source Code of
USR, then the Override field will always be blank.
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 Options Tab

 The Options tab (Figure 6.8) is used to define additional and optional information
for the item.

 

 Figure 6.8:  Detail Item Form, Options Tab

 

 Field  Description

 Contractor  Two-character ID of a contractor assigned to this detail
item.  This field has a pulldown menu, from which you may
select any of the contractors which have already been
created for this project.  If the contractor you wish to apply
to this title is not available on the pulldown menu, you must
create the contractor record first.  See Section 7.3 for
information on Defining Contractors.

 Leave this field blank to assign the item to a contractor
assigned at a title level.

 Note:  The program will not allow you to make an entry in
this field if you specified Contractor Override for a title
level, under which the current item is grouped.

 Refer to Chapter 7 for more information on contractors.
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 Work Cat  You can use this field to enter a building system code for
each cost item in the project.  You can then produce system
summary reports showing  project costs sorted according to
the building systems hierarchy.  See Section 15.10 for more
information.

 Note:  In some cases (for example, in cost items copied in
with assemblies from the supplied Assemblies Database)
this field may already be filled in with a system code by the
program.

 Source  A 3-character item source ID filled in by the program.  All
items that you define are tagged USR.  Other codes come
from the Department of Defense Unit Price Database, for
example:

 MIL - Building construction item.
CIV - Civil works item.
HTW - Hazardous waste construction item.

 Modifiers  If checked, this item has had a modifier applied.  See
Section 6.11 for information about using Modifiers in the
project.

 Backup  If checked, Material Backup exists in the project for the
current UPB ID.  Choose the accompanying button to view
this information.

 Note:  Material Backup data in the project may be edited
using MCACES GOLD version 5.30.

 

 Shipping Weight  Weight of materials associated with the item, per the unit of
measure in the following field.  Used to calculate shipping
costs.

 Shipping Volume  Volume per unit of measure.  Used to compute the
Equivalent Shipping Weight for low-density items.
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 Equiv. Shipping
Wt.

 Computed by the program.  This is the weight the program
uses to calculate the shipping cost of the item. If the item
weighs less than 56 lbs./cubic foot, the program computes
the equivalent shipping weight for cost purposes by
multiplying the unit volume times the standard density of 56
lbs./cf. Otherwise, the program sets the Equivalent Shipping
Weight field equal to the actual unit weight entered above.
This field is computed in kilograms regardless of the unit of
measure used to enter the unit weight and unit volume.

 Note:  In the Project Database, only the equivalent shipping
weight is saved.  The next time you view or edit the item,
the Unit Weight field will show the same value as the
Equivalent Shipping Weight field and the Unit Volume field
will be blank.  If you want to store all the field values, you
can define and store the item in the Unit Price Database and
then copy it into the project.

 
 Note: The shipping information is used only if you have selected Shipping as a
Direct Cost column and you have defined a Shipping rate(s) using the Adjust
Pricing Panel.  See Section 6.9 for information on Working with Shipping Costs.

 Schedule Tab

 The Schedule tab (Figure 6.9) is used to define additional and optional
information for the item.

 

 Figure 6.9:  Detail Item Form, Schedule Tab
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 Field  Description

 Output/HR  The crew's estimated hourly output per the unit of measure
associated with the cost item.  This field is used when
referencing a crew for the cost item.  The output value is
copied from the Unit Price Database, but you can adjust the
value here.

 Duration  The Duration equals the Quantity divided by the
Output/HR.  This field is calculated by the software.

 L/E Type  This field identifies the source database for the item and
type of rate used.   Codes are:

 C - Crew.  The item references a crew in the Crews
Database for labor and equipment cost information.

 E - Equipment (Average).  The item is copied directly
from the Equipment Rates Database and the unit rate for
average conditions is applied.

 S - Severe Equipment.  The item is copied directly from
the Equipment Rates Database and the unit rate for
severe conditions is used.

 U - Unused/Standby.  The item is copied directly from
the Equipment Rates Database and the standby unit rate
is used.

 L - Laborer.  The item is copied directly from the Labor
Rates Database and uses the laborer unit rate.

 A - Apprentice.  The item is copied directly from the
Labor Rates Database and the apprentice rate is used.

 F - Foreman.  The item is copied directly from the Labor
Rates Database and the foreman rate is used.

 Note:  Foreman and apprentice rates are computed as
adjustments to the laborer rate.  These adjustments are
defined in the Summary Information dialog for the Crews
database from which this project is being repriced.  See
Section 9.4.

 Material Price
Updated

 Date when this item's material unit cost was last modified.
For new items, the date created.  This field is updated by the
software and is not directly editable.
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 After Defining the Cost Item

 When you have finished defining the cost item, you can:

 • Add Notes to your description by typing notes in the Notes/Reference Panel.

 • Click on Next to save the item and begin adding another cost item beneath the
same title.

 • Click on Close to close the detail Item Form and save the item.

 Note:  You can also exit without saving the data by clicking on Edit | Undo
Record Changes or by pressing the Esc key.
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 6.3  Using Lookup and Find

 Description

 The Lookup feature allows you to open a supporting database in a separate
window from the project.  You can arrange the windows side-by-side (or in any
other configuration you find useful).  You can then search the supporting database
by navigating through it or by using the Find Keyword feature.  When you have
found an item or title element that you want to copy back to the project, you can
do so using either Drag and Drop or the Windows Cut and Paste commands.

 Use in Other Databases

 You can also use the Lookup and Find Keyword feature starting from databases
other than the Project Database.  For example, when working in the Unit Price
Database, you can look up into the Crews Database.

 Retrieving Cost Data to the Project Database

 You can use Lookup and Find Keyword to copy cost data at the detail or title
level.

 Detail-level

 At the detail level screens, you can look up and copy individual cost items from
the Unit Price, Assemblies, Labor Rates, or Equipment Rates Databases, or from
another Project Database.

 Title Level

 At the title level, you can look up and retrieve:

 • A crew composition from the Crews Database.
 • An assembly from the Assemblies Database.
 • A title element from another Project Database.

 For More Information

 Refer to the following Sections for more information on using Lookup:

 • Chapter 3 for a detailed example of copying an item from the UPB
 • Section 6.2 for instructions on copying detail items into the Project.
 • Section 6.6 for instructions on copying a crew as an assembly
 • Section 6.10 for information on copying an assembly.

 Using Find

 Once you have opened a supporting database, you can use the Find Keyword
feature to search for titles or detail items (or both).

 Note:  You can also use this feature to search in a Project Database.
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 Displaying the Dialog Box

 To access Find, select Find from the Edit menu.

 Result:  The Find dialog box is displayed (Figure 6.10).

 

 Figure 6.10:  Find Dialog Box

 Defining the Search

 You can use the following fields and options to define the search criteria.

 Field/Option  Description

 Matching ID  You can enter a partial ID to restrict the search to only those
items or titles that contain that partial ID. You can choose to
search for titles, detail items, or both.

 Find What  Enter a word or character string to search for.

 
 Executing the Search

 1. Click the Find button to execute the search.

 Result:  The grid displays the search results, including the following:

 Field  Description

 T/D  Indicates if the item on this row is a title or detail item.

 ID  Database ID of the item found.

 Seq  Sequence ID for detail items.

 Description  Description of the item.

 
 2. To locate an item, highlight that row in the grid and click the Go to button.
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 6.4  Editing and Deleting

 Description

 After adding titles and cost items to a project, you will often need to go back and
make changes.  MCACES allows you to easily modify titles or cost items in the
Project Database and to delete them.

 Note:  You can also use the procedures listed here to edit and delete items in the
other databases.

 Editing a Title or Detail Item

 Follow these steps to edit a title or detail cost item.

 1. Select the title or item so that it is highlighted in the Grid Panel.

 2. Choose Item Form from the View Menu or click the Item Form icon .

 Result:  The Item Form is displayed.

 3. Click or use the Tab key to move from field to field.  Change the fields as
needed.

 4. When you are finished editing, click the Close button to exit the Item Form
and save the changed data.

 Note:  You can exit at any time without saving the changes by pressing the
Esc key.

 Effect of Deleting

 When you delete a title or cost item, it is flagged for deletion but remains in the
database.  Deleted titles and items are shown on the Grid Panel in light gray.

 The deleted title or item remains stored in the database, but is not included in any
calculations.  To permanently remove titles or cost items from a database once
they've been deleted, use the Pack Data command on the File Menu.

 Deleting Titles or Items

 To delete a title or detail item, select it in the Grid Panel and press Ctrl+D or
choose Delete Current Record from the Edit menu.

 Note:  Deleting a title deletes all subtitles and cost items beneath the title.
MCACES prompts you to confirm this action.
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 To Cancel Deletion

 Since deleted titles and cost items are not permanently removed from the database
until the database is packed, you can cancel the deletion.

 Simply select the deleted title or item in the Grid Panel and press Ctrl+D or
choose UnDelete Current Record from the Edit menu.
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 6.5  Working With Crews

 About Crews

 A crew is a grouping of cost items representing all the labor and equipment costs
required to accomplish a specific kind of work.

 Crews are stored in the Crews Database as titles at the lowest title level.  The
individual labor and equipment cost items within each crew are copied from the
Labor and Equipment Rates Databases and stored as detail items below the crew
title.  These items are referred to as the crew members.

 Using Crews in a Project

 MCACES lets you use crews in a project in two ways:

 • A crew can be referenced by a cost item to derive the labor and equipment
costs of the item.  You can then adjust the crew's hourly output figure to suit
your estimate.  This adjustment will automatically modify the labor and
equipment costs of the item.

 This method is described in this section.

 • You can copy (or build) a crew as a title in the Project Database at the lowest
title level.  The labor and equipment items in the crew (that is, the crew
members) then become individual cost items in the project.  This option is
referred to as treating crews as assemblies.

 This method is discussed in Section 6.6.

 Referencing a Crew Within a Cost Item

 If you copy a Unit Price Database item that references a crew, the crew reference
and crew hourly output for the item are automatically copied as well.  You then
have the option of changing the item to reference a different crew, or of adjusting
the hourly output.

 If you are creating your own cost item, you also have the option of referencing a
crew within the item.

 Note:  If the Estimate Type is set to U (Unit Costs; No Crews) you can still assign
a crew to a cost item, but the crew reference will be ignored in cost calculations.
The reference is recorded in case you later decide to change the Estimate Type.
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 Procedure

 Follow these steps to add or change a crew reference within a cost item:

 Note: Refer to Section 6.2 for descriptions of the fields used to associate a crew
with a cost item.

 1. Display the detail Item Form and choose the Schedule tab.

 2 Enter a Quantity and Output / HR if they are not already entered.

 3. Select Crew in the L/E Type field (if it is not already listed).

 4. Enter the Crews Database ID of the crew you want to use in the item and
press Enter.

 Note:  If you do not know the ID, you can use the Lookup feature to open the
Crews Database and find the Crew ID.

 5. Select the Costs tab.

 Result:  The Labor, Equipment, and Manhours cost fields (if defined for this
project) now show values based on the crew reference and hourly output.

 Adjusting Crew Output

 Regardless of whether the cost item is copied from the Unit Price Database or
user-created, you can adjust the hourly output figure to fit your estimate.

 Enter the output in the Output / HR field on the Schedule tab or in the Output
field on the Grid Panel.  Adjusting this figure will change the labor and equipment
costs for the item.  It will also change the figure in the Manhours figure if this
column type is used.

 Example

 An MCACES Project Database contains cost item MIL 03110 1613, copied from
the Unit Price Database.  This item references Crew ACARJ, with an hourly
output figure set at approximately 42 square feet.  The resulting unit costs shown
on the primary entry screen are $1.74 for labor and $0.05 for equipment.  A unit
Manhours figure of 0.10 is also shown.

 If you double the crew's hourly output to 84 square feet, this reduces the unit costs
by half, since the crew is needed only half as much time to accomplish the same
work.  The unit costs are now shown as $0.87 for labor and $0.03 for equipment,
and the Manhours is reduced to .05.

 Note:  This example assumes that the Crew Production Rate value, set in the
Crews Database, is equal to 1.00, which is most often the case.
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 Crew Costs in Tandem

 As previously noted, in a cost item referencing a crew, the labor and equipment
costs are tied together.  Adjusting one cost automatically changes the other.

 Therefore, you cannot independently adjust labor or equipment costs of crew-
dependent items in the Project Database.  If you need to adjust labor or equipment
costs independently for these items, you can do so in the Labor or Equipment
Rates Database.
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 6.6  Working With Crews as Assemblies

 About Crews as Assemblies

 The second way you can use the Crews Database to help build an estimate is to
copy an entire crew at the lowest title level.  The crew then becomes a title in the
Project Database, and the crew members become individual labor and equipment
cost items below that title.

 This method is called using crews as assemblies, since the procedures are much
the same as those for using assemblies in the project.  (See Section 6.10 for
information.)

 Redefining Crews in the Project

 Once the crew is copied into the project, you can add or delete crew members.
This allows you to define exactly the crew composition you need for any part of
an estimate.

 • You can add crew members by creating them yourself or by copying them
from the Labor or Equipment Rates Database.  See Section 6.2 for instructions.

 • You can remove crew members through the Delete function (Ctrl+F4), which
is explained in Section 6.4.

 Copying a Crew as an Assembly

 Follow these instructions to add a crew as an assembly to your project.

 Note: Refer to Section 6.1 for descriptions of the fields used in this procedure.

1. In the Outline Panel of your Project Database highlight the title that you
want to add the crew title under.

2. Open the Crews Database by clicking on the Crew icon    or by using
the Lookup, Crew command on the Tools menu.

 Note:  If this is the first time you have opened a Crews Database from this
project, you will use the Open dialog box to select a Crew Database.

3. Choose Tile Vertically from the Window menu to place the project and
Crews Database windows side by side.

4. Search through the Crews Database until finding the crew you want to
copy.  Highlight the crew's title in the Outline Panel.

5. Click on the crew title and drag it to the Grid Panel in the project window
and release the mouse button.
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 Note:  When you are dragging the item from the Crews Database to the
project, the cursor becomes a circle with a slash through it to let you know
that you are over an area where you can not drop it.  When the cursor
becomes a crew icon, it means that you are over an area where you can
drop it.

 Result:  The crew title is added at the lowest title level and its members are
added as detail items.

6. Highlight the crew title on the Grid Panel.  Choose Item Form from the

View Menu or click the Item Form icon .  Select the Schedule tab.

7. Enter a Quantity, Unit of Measure and Production Rate figure for the
crew.

 Result:  The program computes and displays a value in the Duration field.

8. Select the Costs tab.

 Result:  The cost fields now show the calculated costs for all for all items
(crew members) below the title.

9. If you wish, you can make other changes to the crew title data.  Otherwise,
click on the Close button to exit the item form.

 Example

 The following example illustrates the use of a crew as an assembly:

 1. An excavation activity within a project needs to be defined.  For the
purposes of estimating this task, you copy Crew CODEF from the Crews
Database.

 2. On the Schedule tab of the title Item Form, you enter a quantity of 100,000
cubic yards and a Production Rate figure of 250 CY/HR.

 3. MCACES computes a task duration of 400 crew hours by dividing the
quantity by the Production Rate.

 Note:  The duration figure is used in cost computations, as explained
below.

 Member Quantity

 When a cost item is defined as a member of a crew in the Crews Database, it is
given a member quantity.  This quantity expresses the number of this type of
member in the crew.  Alternately, it can be viewed as the amount of the member's
unit cost that is charged to the crew.

 Example:  Crew CODEF contains two full-time laborers.  They are grouped
together as a single cost item in the crew with a member quantity of 2.  The crew
also contains a foreman who spends one quarter of his time supervising this crew.
His member quantity is defined as .25.
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 When a crew member is copied as a cost item into the project, the member
quantity becomes part of the cost calculation for the item, as explained below.

 How Costs Are Calculated

 When you work with a crew as an assembly, the labor or equipment cost of each
item is calculated as follows:

 1. The member quantity copied from the Crews Database is multiplied by the
duration figure defined at the title level.  The result is the number of hours
this crew member is used for the task.  This value is placed in the Quantity
field on the cost item entry screen.

 2. This quantity value is then multiplied by the unit (per hour) labor or
equipment rate defined for the item to produce the item's labor or equipment
cost for the task.

 Example:  To extend the above example, using the foreman:

 Member Quantity = .25; and Duration = 400 hrs.

 Cost Item Quantity = .25 X 400 = 100 hrs.

 Item Labor Cost = 100 hrs. X 6.70 (hourly rate) = $670.

 Adjusting Linked Values

 As illustrated above, when you work with a crew as an assembly, the costs of
individual items are linked to the duration figure established at the title level.

 You can adjust the costs of these items by adjusting the values within this link.

 • You can change the duration by changing either the quantity or the Production
Rate stored at the title level.

 • You can also change the member quantity figure copied from the Crews
Database.  For example, your situation might dictate that you change the
foreman's quantity from .25 to .5 hours per crew hour.

 To change the member quantity, you simply highlight the crew member on the
Grid Panel and enter a new value in the Quantity field.

 Result:  MCACES computes new costs for the item and adjusts the costs at the
crew title level accordingly.
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 6.7  Adjusting for Overtime

 Description

 MCACES lets you compute overtime as a percentage and assign it to a title in the
project.  This overtime percentage is then applied to the labor and equipment costs
for all items grouped below the title.

 Depends on the Estimate Type

 The use of the Overtime Adjustment feature depends on which Estimate Type you
have selected on the Calculations tab of the Summary Information dialog box.

 • For Estimate Types A and C, the overtime adjustments are computed and
applied whenever you recalculate the project or generate reports.

 • For Estimate Type K, the overtime adjustments are calculated and applied only
when you reprice labor and equipment.

 • For Estimate Type U, the Overtime Adjustment feature is not used.

 Where to Adjust

 You define overtime adjustments at the lowest title level in the project.  This is
defined as any title that has detail items but no subtitles below it.

 Procedure

 You adjust for overtime using the Schedule tab of the title Item Form.  You can
include overtime information when you first add the title, or you can access the
Item Form later to add overtime data for the title.

 Follow these instructions:

 1. Display the Item Form and select the Schedule tab.

 2. Enter data in the fields as required to define the overtime percentage.  Refer
to the Field Descriptions in Section 6.1 for details.

 3. When you are finished entering the data and the program has computed a
value for the Overtime Percentage field, click on the Close button.

 Result:  The program applies the overtime markup to all labor costs below
this title.  The equipment costs (for equipment whose costs come from the
Equipment Rates Database) will be affected by the following formula: the
Facilities Capital Cost of Money field is multiplied by  40 / ( total hours per
day * number of work days).
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 6.8  Using Adjust Pricing

 Purpose

 The Adjust Pricing feature lets you change the Direct Costs within all or part of a
project by one or more percentage factors that you specify.

 When to Use

 Use this function when you want to adjust the costs in an estimate.  For example,
you might want to make regional adjustments based on published industry tables
for different geographic locations.

 Use for Shipping Costs

 This function is also used to define shipping costs for a project.  If Shipping is
defined as a Direct Cost column, then you enter a shipping rate rather than an
adjustment percentage in the Shipping column on the Adjust Pricing Screen.  See
Section 6.9 for details.

 Where to Set Adjustments

 The most common practice is to define adjustment factors for the entire project.

 However, MCACES also allows you to define adjustment factors at the Owner
Cost Level and lowest title level.  Adjustments set at lower levels will override
those set at higher levels for the same item or title.

 After Setting Adjustments

 Once you have set cost adjustment factors, you must recalculate the project (by
clicking the Recalculate icon ) or run reports before the adjustments will be
reflected on Project Database windows.
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 Adjust Pricing Panel

 You enter adjustment percentages on the Adjust Pricing Panel.  To access this
panel, click on the Notes/Reference Panel and select Adjust Pricing in the
pulldown list box.  Figure 6.11 shows the panel slightly resized to show all cost
columns.

 

 Figure 6.11  Adjust Pricing Panel

 Parts of the Panel

 The dropdown list box on the right of the panel is used to select the title level at
which the price adjustments will be applied.

 The rest of the panel contains the following columns:

 • The ID Column can be used to enter a partial Unit Price Database ID of up to
five characters.  This partial ID identifies the cost items that the Adjust Pricing
adjustments apply to.

 • The Description column can be used to enter a short description of the item
category.

 • The remaining columns are labeled with the Direct Costs defined for the
project.

 Entering the Adjustments

 To enter adjustments, click in the appropriate row and column on the grid.

 Enter the percentage of adjustment as a decimal multiplier.

 Examples:

 • To adjust material up 5%, enter .05 in the Material column.

 • To adjust labor down 3%, enter -.03 in the Labor column.
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 Adjusting for All Items

 If you want to apply a single set of adjustment factors for all items in the project
(or under the current title), fill in only one row on the screen.  Leave the ID
column blank and enter the appropriate value in each Direct Cost column.

 Adjusting by CSI Division

 Cost items in the supporting databases supplied with MCACES use the CSI
Divisions as the first two characters of their database IDs (UPB IDs).  This makes
it easy to adjust items by category, using the CSI Divisions.

 Enter the CSI Divisions that you want to adjust in the ID column, one per row.
On each row, enter the adjustment values in the appropriate Direct Cost columns.

 Note:  You can also create a default row to define adjustment factors for any
items not covered by your other entries.  This would include any user-created
items whose database ID does not fall within a CSI Division.  The default row
must be the top row on the screen and must have a blank ID column.

 Making Finer Adjustments

 Sometimes, you may want to make finer distinctions than the CSI Divisions
allow.  You can define rows on the screen to break down the CSI Divisions to
lower title levels, or to the level of an individual cost item.

 To add rows to the panel, enter a value in the ID field and press the Tab key.

 Note:  Be sure to add rows directly beneath the higher level title to which they
apply.  See the Caution below.
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 Caution on Adding Rows

 When performing price adjustments or adding shipping costs, MCACES searches
the leftmost column of the Adjust Pricing Panel for an ID that matches the current
item in the Project Database.  The program begins this search from the bottom of
the screen.  As soon as it finds a match for an item, it uses that row and does not
work on that item further.

 Therefore, when you add rows on the Adjust Pricing Panel, be sure to place the
rows in descending numerical sequence beneath the CSI Division to which they
apply.

 Correct: 03 Incorrect: 03
  031 03110
   03110 031

 If the rows were set up as in the incorrect example above, the program, searching
from the bottom up, would first encounter row 031.  This would be read as a
match for cost item 03110 1111, so the program would apply that row's
adjustment factor.  It would not use the next row, which contains the factor
actually intended for the specific cost item.
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 6.9  Working With Shipping Costs

 Description

 If you are estimating for construction overseas or at a remote location, you may
want to include shipping costs in the estimate.

 MCACES lets you compute equivalent shipping weights for materials at the cost
item level in the Project or Unit Price Database.  In the Project Database, the
program automatically calculates shipping costs at the detail and title levels, based
on the shipping rates you enter.

 Task List

 Working with shipping costs involves three tasks:

 1. You define Shipping as a Direct Cost column on the Columns Setup tab of
the Project Information dialog box.  This column is then used to display the
shipping costs on screens and list them in reports.

 2. For each cost item that includes material to be shipped, you enter shipping
weight data.

 3. You set the shipping rates to be applied.

 Task 1 is explained in Section 5.4.  Tasks 2 and 3 are discussed in the following
paragraphs.

 Task 2:  Defining Shipping Weights

 When a cost item is copied from the Unit Price Database into the project, its
shipping weight data is automatically copied as well.

 For a cost item that you create in the Project Database, you can enter weight and
volume information and the program will compute the equivalent shipping
weight, which is used to determine the shipping cost.

 To compute the equivalent shipping weight, you use the Options tab on the detail
Item Form.  The relevant fields are as follows:

• Unit Weight

• Unit Volume

• Equivalent Shipping Weight

See Section 6.2 for descriptions of these fields.
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Task 3:  Setting Shipping Rates

Normally, you define one or more shipping rates for the entire project and assign
them at the Project Level.

However, MCACES also allows you to define shipping rates at the Owner Cost
Level or at the lowest title level in the project.  Rates set at a lower level override
those set at a higher level for the same item or title.

You enter shipping rates as a cost per metric ton.  MCACES computes each item's
weight in metric tons using the Equivalent Shipping Weight value discussed
above.

Adjust Pricing Panel

You set shipping rates in the Shipping column on the Adjust Pricing Panel.  To
access this panel, click on the Notes/Reference Panel and select Adjust Pricing in
the pulldown list box.  Figure 6.12 shows the panel slightly resized to illustrate
five Direct Cost columns.

Note:  This Panel is also used to apply cost adjustments to the other Direct Cost
columns defined for the project.  Refer to Section 6.8.

Figure 6.12:  Adjust Pricing Panel with Shipping Cost

Applying a Single Rate

If you want to apply a single shipping rate to all items below the current title,
enter that rate in the Shipping column and leave the rest of the panel blank.

You can use this method at the Project Level to set a single rate for the entire
project.

Setting Multiple Rates

As with price adjustments, you can also set multiple shipping rates.  You can
enter rates by CSI Division or you can make finer adjustments.  The methods and
rules you use to enter the shipping rates are the same as for price adjustments.
Refer to Section 6.8 for more information.
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Example of Use

You might define a row for CSI Division 05, Metals, and then enter a rate of $120
in the Shipping column on that row.  This would affect all cost items below the
current title that have a database ID beginning with 05 and have a value recorded
in the Equivalent Shipping Weight field.

For each of these items, the program would multiply the equivalent shipping
weight by the rate of $120 to compute the unit shipping cost for the item.  The
unit shipping cost would then be multiplied by the item quantity to yield the total
shipping cost for the item.  Both of these cost values would be displayed in the
Shipping cost column for the item.
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6.10  Working With Assemblies

About Assemblies

An assembly is a collection of cost items that represents all the costs required to
create a larger piece of a project.

In the Assemblies Database, assemblies are stored as titles at the lowest title level,
with the associated cost items stored below the title.  The quantities and costs of
these items are based on one unit of the assembly; for example, one square foot of
partition.

Assemblies in the Project

When you copy an assembly into the Project Database, you add the assembly as a
title at the lowest title level.  The cost items in the assembly are automatically
copied in as detail items below the assembly title.

At the title level, you then enter the quantity appropriate to your project, such as
10,000 square feet.  The program multiplies this quantity value by the quantity of
each of the detail items in the assembly to generate each item's quantity and total
costs.  These costs are then added to yield the total costs of the assembly.

Copying an Assembly into the Project

Follow these instructions to copy an assembly into your project.

1. In the Outline Panel of your Project Database find the title that you want to
add the assembly title under.

2. Open the Assemblies Database by clicking on the Assemblies icon    or
by using the Lookup, Assemblies command on the Window menu.

Note:  If this is the first time you have opened an Assemblies Database from
this project, you will use the Open dialog box to select the Database.

3. Choose Tile Vertically from the Window menu to place the project and
Assemblies Database windows side by side.

4. Search through the Assemblies Database until finding the assembly you want
to copy.  Highlight the assembly title in the Outline Panel.
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5. Click on the assembly title and drag it to the Outline Panel in the project
window.  Move the cursor over a lowest level title (this will become the
parent to the assembly title you are adding), and release the mouse button.

Note:  When you are dragging the item from the Assemblies to the project,
the cursor becomes a circle with a slash through it to let you know that you
are over an area where you can not drop it.  When the cursor becomes a pages
icon, it means that you are over a title where you can drop it.

Result:  The assembly title is added at the lowest title level and its detail
items are added below it.

6. Highlight the assembly title on the Grid Panel.  Choose Item Form from the

View Menu or click the Item Form icon .  Select the Options tab.

7. Enter the appropriate quantity value for your project in the Quantity field.

If you want to change the assembly's name to one specific to your project,
enter a new name in the Description field.

Click on the Link as Assembly option.

Select Close to save.

Result:  The cost fields of detail items below the assembly are recalculated
based on the entered quantity.

Adjusting Linked Values

As explained above, the costs of individual items in the assembly are linked to the
entry in the Quantity field on the title entry screen.

You can adjust the quantities and thereby the costs of these items by adjusting the
linked values.

• You can change the quantity figure for the title at any time and this will
automatically adjust the quantities of the detail items.

• You can also change the detail item quantity figure copied from the
Assemblies Database.

Example:  A partition assembly might be defined to include 2 square feet of
drywall (both sides) for every square foot of partition.  The item quantity for
the drywall item would be defined as 2.  If your estimate called for single-side
construction instead, you would change the detail item quantity to 1.

To change the detail item quantity, you simply highlight the item on the Grid
Panel and enter a new value in the Quantity field.

Result:  MCACES computes new costs for the item and adjusts the costs at the
assembly title level accordingly.
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6.11  Using Modifiers in the Project

Definition

A modifier is an adjustment record that can be applied to a detail cost item.
Modifiers allow you to change the labor, material, and/or shipping costs of items
by adding or deducting optional quality or scope.

Example:  The Unit Price Database supplied with MCACES contains a series of
cost items for drywall construction.  A range of modifiers is available for these
items.  These modifiers represent options such as waterproof drywall, fire-
resistant drywall, and so on.

Options in the Project

If you have cost items in your project that were originally copied from the Unit
Price Database (items with UPB IDs), you can look up and copy modifiers for
those items from the library of modifiers stored with the UPB.  You can then
make changes to the modifiers you've copied, if needed.

You can also create and apply modifiers that are specific to items in the project.

Item Modifier Dialog Box

You use the Item Modifier dialog box (Figure 6.13) to apply modifiers to cost
items in the Project Database.  To access this dialog box, display the detail Item
Form, select the Options tab, then choose the Modifiers button.

• The top row of the dialog box shows the cost item's UPB ID and Description.
It also shows the base labor and material unit costs and the unit weight in
kilograms.

• Subsequent rows show any modifiers currently applied to the item, and the
associated cost and/or weight adjustments.  Adjustments may be applied as
either an amount or a percentage.

• The bottom row shows the unit costs and weight resulting from the
modifications.  These are the values that are actually used in the estimate.
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Figure 6.13:  Item Modifier Dialog Box

Using Multiple Modifiers

You can apply more than one modifier to an item in the project, to make multiple
cost adjustments.

When you enter multiple modifiers, MCACES computes the modifications in the
following order:

1. Percentage adjustments are first totaled together and then applied to the base
unit values.

2. Amount adjustments are then totaled and applied.

Adding a Modifier to an Item

Follow these steps to add a modifier to a cost item in the Project Database.

1. Display the detail Item form, select the Options tab, then click on the
Modifiers button.

Result:  The Item Modifier dialog box is displayed.  Any modifiers already
applied to the item are listed.
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2. To add a modifier from the UPB, choose Add from UPB to display the
Modifier Choices dialog box. (Figure 6.14).  Go to Step 3.

Figure 6.14: Modifier Choices Dialog Box

To add a user defined modifier, go to Step 4.

3. Click to highlight the UPB modifier you want to use, then choose OK.

Result:  The modifier is placed on the Item Modifier dialog box.  MCACES
computes the applicable adjustments and places the results on the bottom row
of the screen.

Note:  Once you've copied a modifier from the library, you can change the
modifier in the project without affecting its original in the library.  See
"Editing Modifiers in the Project," below.

4. To create your own modifier, click on the Add Custom button.

Result:  MCACES adds a blank row to the grid.

5. Enter a description of the modifier and the adjustment value or values in the
appropriate columns on the blank row.

6. Click on Close to exit.

Result:  The Item Form is redisplayed.  The modifications for the item costs
are now reflected in the appropriate fields on the Costs tab.
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Editing Modifiers in the Project

After you have applied one ore more modifiers to an item, you can change the
modifiers as needed.  You can enter new adjustment values for labor, material,
and weight, and you can also change the adjustment methods from percentage to
amount or amount to percentage.

Changes made to modifiers in the Project Database do not affect the original
modifiers stored in the UPB Library.

1. Display the Item Modifiers dialog box.

2. Enter the changes to the modifier(s) as needed.

Result:  MCACES recomputes the item's costs and displays the results at the
bottom of the screen.

3. After making the changes, press Close to exit.

Deleting Modifiers in the Project

When working on the Item Modifier dialog box, you can delete an existing
modifier.  First position the cursor on the row for the modifier to be deleted, then
click on the Delete button.

Result:  GOLD prompts you to confirm the deletion.

Choose Yes to confirm or No to cancel.
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6.12  Working With Alternate Costs

Purpose

In some projects, you may want to estimate and compare the costs for different
alternatives.  By using the methods described in this section, you can separate and
view alternate costs on screens and reports.

Defining the Project Structure

To build alternate costs into an estimate, define a separate Level 1 title for each
alternate situation.  This allows you to separate the alternate costs at a high level
and to see cost comparisons by displaying only Level 1 titles in the Outline Panel.

Examples:

• In some estimates, you might have a Base Bid represented by one or more
Level 1 titles, plus several alternates.  Each alternate would be created as a
separate Level 1 title, with IDs higher than the Base Bid titles.  The alternates
can be additive or deductive; that is, adding costs to or deducting costs from
the Base Bid.

• In estimating a building project, you might have alternate possibilities of using
brick or stone.  You could define a Level 1 title called Brick Construction and
a second called Stone Construction.  You would then place all the costs
relevant to the brick option under the first title and those for stone under the
second.

Procedure

Use the following procedure to define and view alternate costs in an estimate:

1. Create separate Level 1 titles for each alternate, with the alternates using the
highest title ID numbers.

2. Add the subtitles and/or detail cost items for each alternate.

Note: You can, if you choose, define the first Level 1 title element (title plus
subtitles and detail) and then use the Copy command on the Edit menu to
copy it one or more times.  You can then edit the elements for each alternate,
changing only the data that differs in each case.

3. Display the Report Setup dialog box and choose the Calculation tab.  Enter a
Level 1 title ID in the First Alternate ID field.  This is the first Level 1 title
ID that will be treated as an alternate.  Any Level 1 title with this ID or
higher will not be included in the project total on Level 1 project summary
reports.
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4. After defining the alternate elements, position the highlight on the Project
title in the Outline Panel and click the Recalculate icon .

Result:  The project is recalculated.  The total costs for each element are
shown on the Outline Panel.

5. To produce a report of the alternate costs, do the following:

• On the Report Setup dialog box, Select Reports tab, choose project
summary reports at Level 1.

• Run the selected reports.

Note: See Chapter 15 for complete instructions on generating reports.
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CHAPTER  7

WORKING WITH INDIRECT AND OWNER COSTS

Chapter Overview

Chapter 7 explains how to add Project Indirect and Owner Costs to an estimate.

MCACES offers great flexibility in how these costs can be applied to a project.
The software automatically calculates the costs according to any of a number of
methods that you choose.

This chapter contains the following sections:

7.1 Working With Indirect Costs
7.2 Contractor Tiering
7.3 Defining Contractors
7.4 Applying Contractors to Costs
7.5 Working With Owner Costs
7.6 Working With Contingency Notes
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7.1  Working With Indirect Costs

About Indirect Costs

Indirect Costs are costs that you choose to distribute over an entire project or
some portion of a project.  They can include contractors' overhead, profit, and
bond as well as other distributed costs.

MCACES places these costs in the Indirect Cost Columns that you define on the
Column Setup tab of the Summary Information dialog box.

Contractors' Costs

Contractors' overhead, profit, and bond costs are figured individually for each
contractor involved in the project.

Three tasks are involved in working with contractors in your project:

1. You set up the Indirect Cost columns, as discussed in Section 5.5.

2. You define each contractor as a title in the Contractor database.  If there are
subcontractors involved, you define the contractor titles in a hierarchy, which
represents the tiering of the subcontractors (who works for whom).  As you
define each contractor, you also select the method that the program will use to
figure the associated Indirect Costs.

See Sections 7.2 through 7.3.

3. You assign contractors to titles or individual cost items in the project to
prorate their costs over the relevant project elements.  This is explained in
Section 7.4.
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7.2  Contractor Tiering

Prime and Subcontractors

In MCACES, a prime contractor is defined as one who does not work for another
contractor.  A subcontractor is one who does work for another contractor.

MCACES allows you to have more than one prime contractor defined in the
project.  MCACES also permits you to define multiple levels of subcontractors, as
in the following example:

Example:

Level 1 - Contractors (Holding title)
Level 2 - BC - Building Construction (Prime Contractor)

Level 3 - EL Electrical (Subcontractor)
Level 4 - ES Electrical Specialties (Subcontractor)

In this example, Contractor ES works for Contractor EL, who in turn works for
Contractor BC.  BC is a prime contractor, because he does not work for any other
contractor.  BC is also considered the parent contractor to his subcontractor EL.
Similarly, EL is considered the parent contractor to his sub, ES.

Compounded Cost Markups

When MCACES recalculates the project or runs reports, a subcontractor's cost
markups are rolled in to the costs applied to the parent contractor.

In the above example, the costs for work performed by ES will be applied to EL
with ES's markups included.  Similarly, the costs for the same work will be
applied to BC with both ES's and EL's markups included.

In other words, MCACES compounds the markups of tiered contractors, as is
common construction practice.

How Tiering Is Defined

In MCACES, the relationship of tiered contractors (who works for whom) is
defined by the way you enter the contractor records.

• Prime contractors are always entered as titles at Level 2 beneath a special
Contractors "holding title" at Level 1.

• Subcontractors are always entered as subtitles beneath the title of their parent
contractor.

Note:  You can define up to four levels of tiered contractors.  This assumes that
there are six title levels defined for the project on the WBS Definition tab of the
Summary Information dialog box.  In general, the number of contractor levels
allowed for a project equals the number of defined title levels minus two.

Refer to the next section for instructions on defining contractors.
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Viewing Tiered Relationships

Because subcontractors are entered as subtitles to their parent contractors, you can
view the tiered relationships of contractors by opening the Contractor Database
and expanding the Prime Contractor in the Outline Panel.  Figure 7.1 shows an
example.

The tiered relationship is also shown on Contractor Summary Reports.

Figure 7.1:  Tiered Contractors in the Contractor Database
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7.3  Defining Contractors

Opening the Contractor Database

You define contractors in the Contractor Database.  This database is automatically
created when you first create the project.  You open the Contractor Database by

clicking on the Contractor icon on the toolbar .

The Contractor Database is similar to the Project Database.  It includes an Outline
Panel, a Grid Panel and a Notes Panel.  Contractors are added in the same way
that titles are added to a project.  See Section 6.1 for instructions on adding titles.

If there are no contractors defined for this project, there will be a Level 1 title with
an ID of 0, and a description of Contractors.  You create your first contractor as a
subtitle to this title.

Accessing the Contractor Item Form

You add and edit contractor records on the Contractor Item form.  How you
access this form depends on where you are adding the contractor and whether
contractors are already defined at that level.

• To add a prime contractor (at Level 2), highlight the Contractor holding record
on the Outline Panel and select Add New Record from the Edit menu.

After the first contractor is defined, you can define additional contractors at the
same level by simply highlighting the title of an existing contractor and
selecting Add New Record again.

• To add a subcontractor, highlight the default Overhead Items subtitle that is
always created below each contractor title and choose Add New Record.
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Contractor Markups Tab

The first tab on the Item Form is Contractor Markups (Figure 7.2).  You use this
tab to name the contractor and to select the method of computing the contractor's
cost markups for each of the Indirect Cost columns defined for the project.

Figure 7.2:  Contractor Markups Tab, Contractor Item Form

Field Descriptions

This table describes the fields on the upper part of the primary Contractor
Markups tab.

Field Description

Contractor Two-character code you assign to identify this contractor.
You enter this code in the Contractor ID field on project
titles and cost items to assign the associated costs to this
contractor.

Refer to "Suggested Contractor IDs" below for a list of
recommended codes.
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Field Description

WBS Portion of the contractor title's database ID defined at the
current level.  (The full database ID consists of this entry
plus the IDs of any higher-level titles-representing parent
contractors-under which this contractor is placed.)

Note:  You might typically make the same entry in this and
the preceding field.  Since the WBS ID is used to sort
contractors on Panels and reports, this will result in the
contractors being sorted by their contractor IDs.

Quantity and Unit
of Measure

The quantity and unit of measure for the work assigned to
this contractor.

This field allows the program to calculate a unit cost for all
work done by this contractor independent of the unit costs at
any particular level.

Description Name of the contractor as defined in the estimate.  You can
add additional description or notes through the Notes
feature.

Own Work Total cost of all work performed by this contractor in the
project.  This is the cost to the contractor and does not
include his markups.

Subbed Work Total cost of all work performed by subcontractors of this
contractor.  This is the cost to this contractor; it includes any
subcontractors' markups.
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Suggested Contractor IDs

Following is a list of recommended contractor IDs for common types of
contractors:

AA - Prime Contractor
AB - Alternate Prime
AC - Acoustic Treatment
CA - Carpeting
CO - CO2 Fire Protection System
CS - Special Coating
CW - Cabinet and Casework
EL - Electrical
ES - Special Electrical Systems
EV - Elevators
FP - Fire Protection
FS - Food Service Equipment
FU - Furnishings
GL - Glass and Glazing
GW - Gypsum Wallboard
HA - Halon Fire Protection System
HC - Hoist and Cranes
HV - HVAC
IN - Insulation
LP - Lath, Plaster, Stucco
MA - Masonry
MB - Prefab Metal Buildings
MC - Controls
ME - Mechanical
MI - Instrumentation

MR - Membrane Roofing
PA - Partitions
PC - Precast Concrete
PL - Plumbing
PR - Preform Roofing, Siding
PS - Painting and Sealants
RF - Resilient Flooring
SC - Ceiling Suspension Systems
SD - Special Doors
SF - Special Flooring
SM - Sheetmetal
SR - Shingles, Roofing Tiles
SS - Structural Steel
ST - Soil Treatment
SW - Sitework
TB - Test and Balance
TE - Terrazzo
TF - Pile, Foundations
TI - Tileproof, Waterproof
WC - Wall Covering
WD - Windows
WF - Wood Flooring
WP - Dampproof, Waterproof
WW - Entrances, Windowwalls
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Cost Fields

Cost fields occupy the grid portion of the tab.  They are repeated for each of the
Indirect Cost columns defined for the project.

Field Description
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Method The method of applying Indirect Costs.  Which of the
following methods is available depends on the cost column
type.

• Percent of Running - Calculate the cost based on the
percentage you enter in the Pct column times the
running total.  (The running total is the total of the
contractor's Direct Costs plus the values of any columns
appearing above the present column in the grid.)  This
option is available for all column types.

• Direct Percent - Calculate the cost using the percentage
you enter in the Pct column times the contractor's Direct
Costs only.  This option is available for all column
types.

• Amount - Add the amount that you enter in the Amount
column.  This option is available to all column types.

• Separate Percent - Used with the Overhead and Profit
column types only.  Calculate the cost using using two
separate percentages that you enter.

 The first percentage is entered in the Pct column on this
row and is applied to the contractor's costs for work
performed by this contractor.  The second percentage is
entered on a separate row for "Subbed Work" that
becomes available for entry on the lower part of the grid.
This second percentage is applied to the contractor's
costs for work performed by this contractor's
subcontractors.

• Compute - Used for the Overhead column type only.
Compute the cost based on detail overhead items that
you enter.  See "Working with Overhead Items," below.

• Weighted Guidelines - Used for the Profit column type
only.  Compute the profit using Profit Weighted
Guidelines.  See "Profit Weighted Guidelines Tab,"
below.

• Class A, A1, or B Table - Used for the Bond column
type only.  Compute a bond amount using a predefined
Bond Table and a bond class.  See "Computing Bond
Costs," below.
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Field Description

Pct % Depending on the Method selected, this field is either a
percentage that you enter or is computed by the program.

Amount Depending on the Method selected, this field is either an
amount that you enter or is computed by the program.

In either case, it represents the Indirect Cost applicable to
this contractor for the column type specified.

Total Markup The total markup percentage and amount are calculated by
the program and placed on the last row of the grid.

Working With Overhead Items

When you choose Compute as the Method for Overhead columns, MCACES will
compute the Overhead amount by totaling the costs contained in overhead cost
items, which you enter for the contractor.  Like other cost items in the project,
these items may include crews, labor, and equipment.

You enter these detail cost items in the Contractor Database, under a special
subtitle called Overhead Items, which is automatically created when you add a
contractor record.  This subtitle is always the first title beneath any contractor on
the Outline Panel.

To enter Overhead Items for a contractor, do the following:

1. Highlight the Overhead Items title for the contractor on the Outline Panel.
Then select Add New Record from the Edit menu.

Result:  The detail item form is displayed.

2. Define one or more detail items as needed.  You can use the same methods as
for defining cost items in the main part of the project.  (This includes looking
up into a supporting database, if appropriate.)  Refer to Sections 6.2 and 6.3
for instructions.

Result:  MCACES will total these cost items, place the amount in the
Overhead column, and distribute the amount with the other contractor costs.
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Computing Bond Costs

Bond Class

In the Method field for Bond costs, you can select Class A, A1, or B Table.  This
causes MCACES to compute a bond cost for the contractor using a predefined
Bond Table and one of the following bond classes: B, A, or A-1.

Bond Data

MCACES stores bond computation data for each bond class.  This data can be
modified by your System Administrator, using MCACES GOLD.  (Modifying Bond
and Profit Tables is an advanced option and is not supported by the current
version of MCACES.)

Computation Method

MCACES uses the bond computation data in the Bond Table to calculate the
contractor's bond costs as a running percentage.  This running percentage is based
on the total Direct Costs of work performed by the contractor plus all costs in
preceding Indirect Cost columns (that is, columns listed in rows above Bond on
the Contractor Markups tab).

Example 1

This example shows how MCACES computes bond costs for projects of one year
or less duration.

1. A contractor performs work in the project in the amount of $450,000
(including overhead and profit).  Bond Class A is assigned to the contractor
on this screen.

2. MCACES refers to the Bond Table.  It finds a percentage of 1.500% defined
for Class A for the range of 0 to $100,000; and a percentage of 1.000% for
the range of $100,000 to $500,000.

3. The program multiplies 1.500% times the first $100,000 of the contractor's
amount, and 1.000% times the remaining $350,000.  The resulting amounts
of $1500 and $3500 are added together to yield a computed Bond total of
$5000.

4. Finally, the $5000 is converted to a percentage of the contractor's total work
amount ($450,000).  This percentage, approximately 1.11%, is applied to all
the contractor's work in the project as the markup percentage for Bond.
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Projects Longer Than One Year

For projects longer than a year, an additional calculation is performed, using an
Additional per Month Over 12 value stored in the Bond Table.

You enter a project's duration in the Estimated Construction Time field on the
Calculation Tab of the Summary Information dialog box.  This figure, entered as a
number of workdays (not calendar days), is converted by MCACES to a number
of months.  MCACES then uses this number of months to compute Bond costs for
the project, as illustrated in the following example.  If no value is entered in the
Estimated Construction Time field, the Bond cost is computed based on a default
12-month duration, as shown in Example 1..

Example 2

In this example, assume that 1.000% is entered in the Additional per month over
12 field.

1. A project duration is defined as 350 working days in the Estimated
Construction Time field.  MCACES converts this figure to 16 months.

2. Using the Bond Table data, MCACES computes the contractor's Bond
premium for the first 12 months as $6200.

3. For each month over 12, MCACES then adds 1% of $6200 to the 12-month
premium.  As there are 16 months, this amounts to 4 * $62 = $248.  The total
Bond premium for this contractor is therefore $248 + $6200 = $6448.

4. As in the previous example, the Bond premium is converted to a percentage
and then used to mark up all Direct Costs assigned to this contractor in the
project.
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Profit Weighted Guidelines Tab

The second tab on the Contractor Item Form is Profit Weighted Guidelines
(Figure 7.3).  You use this tab when you've selected Weighted Guidelines as the
cost Method for the Profit column.

Figure 7.4:  Profit Weighted Guidelines Tab, Contractor Item Form

About the Profit Weighted Guidelines Table

As part of its support for U.S. Department of Defense estimating procedures,
MCACES provides the Profit Weighted Guidelines table as a method of
estimating contractor profit.

To use the table, you enter a decimal value for each factor listed in the grid.
MCACES multiplies these values by the weights assigned to each factor to yield a
profit percentage for that factor.  These individual profit percentages are totaled at
the bottom of the screen, and the sum is the profit percentage applied for the
contractor.

Note:  The weights listed for each factor can be adjusted by your System
Administrator through the Edit Bond and Profit Tables option in MCACES GOLD.
This is an advanced function and is not supported by the current release of
MCACES.

The following guidelines for each weighting factor are copied from the Engineer
Federal Acquisition Regulation Supplement (EFARS).
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Risk

Degree of risk.  Where the work involves no risk or the degree of risk is very
small, the weighting should be .03; as the degree of risk increases, the weighting
should be increased up to a maximum of .12.

Lump sum items will have, generally, a higher weighted value than unit price
items for which quantities are provided.  Other things to consider:  the portion of
the work to be done by subcontractors, nature of work, where work is to be
performed, reasonableness of negotiated costs, amount of labor included in costs,
whether the negotiation is before or after performance of work, etc.

Difficulty

Relative difficulty of work.  If the work is most difficult and complex, the
weighting should be .12 and should be proportionately reduced to .03 on the
simplest of jobs.  This factor is tied in to some extent with the degree of risk.
Some things to consider:  the nature of the work, by whom it is to be done, where,
what is the time schedule, etc.

Size

Size of job.  All work not in excess of $100,000 shall be weighted at .12.  Work
estimated at between $100,000 and $5,000,000 shall be proportionately weighted
from .12 to .05.  Work from $5,000,000 to $10,000,000 shall be weighted at .04,
and work in excess of $10,000,000 at .03.

Period

Periods of performance.  Jobs in excess of 24 months are to be weighted at .12.
Jobs of lesser duration are to be proportionately weighted to a minimum of .03 for
jobs not to exceed 30 days.

Investment

Contractor's investment.  To be weighted from .03 to .12 on the basis of below
average, average, and above average.  Things to consider:  amount of
subcontracting, mobilization payment item, Government-furnished property,
method of making progress payments, etc.

Assistance

Assistance by Government.  To be weighted from .12 to .03 on the basis of
average to above average.  Things to consider:  use of Government-owned
property, equipment and facilities; expediting assistance, etc.

Subcon

Subcontracting.  To be weighted inversely proportional to the amount of
subcontracting.  Where 80% or more of the work is to be subcontracted, the
weighting is to be .03 and such weighting proportionately increased to .12 where
all work is performed by the contractor's own forces.
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7.4  Applying Contractors to Costs

Introduction

Once contractor records have been defined in the project, the contractors must be
applied to titles and/or individual cost items in order for the contractors' cost
markups to be included in the project costs.

Effects of Applying Contractors

Applying a contractor to a title or cost item has the following results:

• The contractor's cost markups (Indirect Costs) are added to the base Direct
Costs associated with the title or item.  If the Indirect Cost is defined as a
percentage, this percentage is multiplied by the base costs and the resulting
amount added in.  If the Indirect Cost is defined as an amount, a prorated
(distributed) portion of this total amount is added to the base costs for the item.

• The cost item becomes part of the contractor's costs as his own work and will
be included in the Direct Costs listed for this contractor on the Contractor
Direct Summary Report.

Note:  The roll-in of cost markups actually takes place when you recalculate the
estimate or run reports.  Thereafter, Direct Costs shown in MCACES and on
project reports will include the markups for the assigned contractor plus those of
any parent contractors up to, but not including, the prime contractor.  In other
words, the costs shown are the costs to prime.  This does not apply to costs shown
on detail item forms or in the Unit Cost row of the Detail Report, which are base
costs with no markups.

Applying to Cost Items

You can apply contractors to cost items whenever you add or edit.  Simply select
the contractor in the Contractor field on the Options tab of the Item Form for the
detail item.

Result:  The item's Direct Costs will be assigned to this contractor, with the
resulting effects as described above.

Applying to Titles

You can apply contractors to project titles in either of two ways:

• As a default contractor.
• As an override contractor.
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Default Contractors

To apply a contractor as a default, select the contractor on the Options tab of the
Item Form for the title and do not select the Contractor Override option.

Result:  All Direct Costs entered below this title will be assigned to this default
contractor, except for costs that are assigned to a different contractor at a lower
level.

Example:  In the following example, Contractor EL is applied at the Level 4 title
and Contractor ES is applied at the Level 5 Title C.  In this case, all the costs
under Titles A and B would be assigned to Contractor EL, while those under Title
C would be assigned to ES.

Level 4 Title - Contractor EL
Level 5 Title A - No contractor
Level 5 Title B - No contractor
Level 5 Title C - Contractor ES

Override Contractors

To apply a contractor as an override, select the contractor on the Options tab of
the title Item Form and select the Contractor Override option.

Result:  MCACES will ignore all other contractors applied below this title,
including those applied to individual cost items.  In the example above, if you
selected Contractor Override on the Level 4 Title, then the costs for all three Level
5 titles would be applied to EL.

Note:  You can restore the contractors entered at lower levels simply by removing
the selection from the Contractor Override option.
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7.5  Working With Owner Costs

About Owner Costs

Owner Costs may include escalation, contingency, supervisory costs, and so on.
Like Indirect Costs, they are distributed over all or part of a project.

Owner Cost columns are computed after contract costs (Direct plus Indirect
Costs) and are used to estimate costs outside typical construction contracts.

Where to Enter

On the WBS Definition tab of the Summary Information dialog box, you select a
title level to be used for Owner Costs in the project.  This level becomes the
default Owner Cost Level.

MCACES allows you to enter Owner Cost information at the default level you
defined, and also at the lowest title level (that is, any title that has or will have
detail cost items directly beneath it, in any part of the project).  Owner Costs
entered at the lowest title level override those entered at the default Owner Cost
Level.
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Owner Cost Panel

You apply Owner Costs at either the default or lowest title level by using the
Owner Cost Panel, which is illustrated in Figure 7.4.  You access this panel by
selecting Owner Costs from the pulldown list in the Notes/Reference Panel.

Figure 7:4  Owner Cost Panel

Owner Cost Grid

Within the Owner Costs Panel, the costs listed on the left side of the grid are
determined by the Owner Cost columns, which you define on the Summary
Information dialog box, Column Setup tab.
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Calculating Owner Costs

When entering Owner Costs, you first enter the method of calculation and then the
percent or amount, as determined by the method.

Depending on which cost you are calculating, MCACES lets you choose from
among the following methods of calculation:

• Percent - Apply the percentage entered to the running total up to this Owner
Cost.  The running total is figured here as the sum of all Direct and Indirect
Costs, plus the Owner Costs for any categories above this category on the grid.
(For the top cost category, choosing Percent is the same as choosing Direct.)

 After selecting this method, you then enter the Percent

• Direct - Apply the percentage entered to total contract costs only (that is, total
Direct plus Indirect Costs).  Exclude other Owner Costs from the computation.

 After selecting this method, you then enter the Percent.

• Amount - Add the specified amount.  After selecting this method, you enter the
Amount.

• Compute - Compute costs based on an escalation factor.  Used for the
predefined Escalation column type only.  Choosing this option causes
Escalation fields to display as described below.

• Owner Levl - Set at Owner Level.  Automatically entered by MCACES if
Owner Costs are set at a higher title level.

Escalation Fields

You use these fields to compute an escalation factor based on escalation table data
that you enter.  Escalation tables are available from a number of industry and
government sources, such as:

• R.S. Means Company
• Engineering News Record
• F.W. Dodge
• U.S. Government Office of Management and Budget

)

Field Description

Escalation Start Start Date and Index used to begin calculating Escalation
costs.

Escalation End End Date and Index at which to end calculation of
Escalation.
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The End Index is divided by the Start Index to compute an escalation factor
representing the relative cost change between the two indexes.  This factor (minus
one) is then applied as a running percentage to yield the Escalation cost.  The
escalation Percent and Amount are then shown in the grid.

Contingency Notes Number Field.

Use this field to enter the numbers of one or more contingency notes that apply to
the costs shown on this Owner Cost Screen.  Refer to the next section for details.
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7.6  Working With Contingency Notes

About Contingency Notes

Contingency Notes can be used to explain the rationale for a particular cost or
percentage as applied to the owner cost entries for an item. You can then choose
to print the Contingency Notes for a project on the Owner Cost Summary Report.

For example, you might apply a high contingency cost percentage to an
excavation activity if there is a high likelihood of encountering large boulders or
of striking water.  You can then use the Contingency Notes feature to explain the
reasoning for the high percentage.

Note: Contingency Notes can be attached to Owner Costs represented in any cost
column type.

Contingency Notes Window

Contingency Notes are entered in the Notes / Reference Panel  using the menu on
the right side of the Notes panel.  An example is shown in Figure 7.5.

A single window is defined for the entire Project Database. You enter all of a
project’s contingency notes in this window, and assign each one a number.
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Figure 7:5  Contingency Notes Window
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Defining Contingency Notes

Use this procedure to enter contingency notes for a project:

1. Select Notes in the left side menu of the Notes / Reference Panel.

2. Select Contingency Notes in the right side menu of the Notes / Reference
Panel.

3. Type one or more contingency notes in the window.  Begin each note with a
numeral.  If notes already exist in the window, use the down arrow or Page
Down key to reach the end of the list, before adding more notes.

4. Move to another panel to save the Contingency Notes entry.

Attaching Notes to Costs

Once a contingency note is defined, you can reference it to owner costs for any
title at the Owner Level or lowest title level.  If appropriate, you can reference the
same note on more than one title.  Follow these steps:

1. With the appropriate cost item selected, choose Owner Costs in the left side
menu of the Notes / Reference Panel.

2. Enter the number of the note you want to reference on the Contingency Note
Nos. box.  You can enter up to four numbers to any given title to reference
multiple notes.  Type a comma after each number.

3. Move to another panel to save entry.

Printing Contingency Notes

The Contingency Notes numbers applied in a project can be printed on the Owner
Cost Summary Report.

A footnote-type format is used.  The numbers of notes are printed to the right of
the Total Cost column for the title to which the notes apply.  The text of the notes
are printed on a separate page after the Project Notes and before the Detail and/or
Summary Reports.

To print contingency notes, check the Print Contingency Notes box on the Select
Reports tab of the Report Setup Dialog Box.
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Chapter  8

Working With Existing Projects

Introduction

This chapter contains information on working with existing estimates, including
those created using earlier versions of MCACES.  It also describes working with
project templates and how to reprice a project from the supporting databases.

In This Chapter

The following sections are included in this chapter:

8.1 Opening a Project Database
8.2 Working With Project Templates
8.3 Repricing a Project Database
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8.1  Selecting a Project Database

To open an existing Project Database, do the following:

1. Click on the File Open button on the tool bar   , or select Open from the File
menu.

Result:  The Open dialog box is displayed.  (Figure 8.1)

2. If the project you want is not displayed in the file list, change the drive and
directory to locate the project .

3. When the Project Database you want is displayed, click on it in the window and
click OK.

Result:  The project is opened.

Figure 8.1  The Open Database Dialog Box

Hint: If the database you want to open is one of the last four projects or
databases you have accessed, then it is displayed at the bottom of the File
menu and can be opened directly simply by clicking on it.
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8.2  Working With Project Templates

Description

A project template is a database containing the column and breakdown
characteristics for a project.  You can use one of the templates supplied with
MCACES or create your own templates.  Project templates give you an easy way
to begin a project with the structure characteristics predefined the way you need
them.

Using a Template

You do not add items directly to a template.  Instead, when you add a new project,
MCACES diaplays the Begin a New Project dialog box (Figure 8.2) and asks you
which template you want to use.  You can select one of the standard templates, or
use the Locate Selected Template button to search for a template in a different
drive or directory.  You can also select the number of title levels to copy from the
template.  After making your selections, click the OK button.

Result:  MCACES creates the new project according your specifications and
displays it.

Figure 8.2:  Begin a New Project Dialog Box
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Creating a Template

You can create a new template and store it on disk to use as the basis for projects.
To create a new template, follow these steps:

1. Add the project.  Use a name that will identify the project as a template, such as
XXXTMP.

2. On the Summary Information dialog box, fill in the Column Setup tab to define
the project columns.

3. Complete the WBS Breakdown Definition tab to define the project levels.
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8.3 Repricing a Project Database

About Repricing

When cost items are copied into a project from a supporting database, their stored
unit costs are copied with them.  If these costs are later changed in the supporting
database, they will differ from the costs in the project.  Repricing the project
ensures that costs copied from a supporting database are up to date.

• MCACES can reprice labor and equipment costs in the project from the
currently selected Labor and Equipment Rates Databases.  Depending on the
Estimate Type chosen, repricing of labor and equipment costs can be done
manually whenever you choose, or it can be done automatically whenever the
estimate is recalculated or reports are run.

• Repricing of material costs can be done manually at any time from the Unit
Price Database.

Repricing an Entire Project

To update all project costs, do the following

1. Select Update All Pricing from the Tools Menu

Result:  The Update All Pricing dialog box is displayed (Figure 8.3).

2. Select Reprice Labor and Equipment, Reprice Materials, or both.

3. Ensure that the supporting databases you want to use for repricing are correctly
displayed.

Note:  If you need to select a new database, press the select button  and look
up the new database ID.

4. Click on the Reprice Now button.
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Figure 8.3  Update All Pricing Dialog Box

Repricing a Single Cost Item

To reprice a single cost item in the project, do the following:

1. Select the item in the Grid Panel.

2. Choose Reprice Labor / Equipment or Reprice Item Material from the Tools
Menu.

Result:  The item is repriced using the supporting databases referenced on the
Summary Information dialog box, Calculation tab.
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Chapter  9

Working With Supporting Databases

Introduction

The Supporting Databases serve as storage areas for the different types of cost
data that can make up a project.  The supporting databases include:

• the Unit Price Book (UPB) Database
• the Crews Database
• the Labor Rates Database
• the Equipment Costs Database
• and the Assemblies Database.

The structure of these databases is similar, and the same techniques are used when
working with them.  The procedures in this chapter will show you how to access,
add, change, delete, and print data in the supporting databases.  Instructions for
adding new databases of your own and working with multiple databases are also
provided.

In This Chapter

The following sections are included in this chapter:

9.1 Navigating in a Database
9.2 Adding Titles to a Database
9.3 Adding Detail Items
9.4 Editing and Deleting Items
9.5 Working With Multiple Databases
9.6 Printing From the Supporting Databases
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9.1  Navigating in a Database

Opening the Database

To open a Supporting Database either click on the File Open button on the tool

bar   , or select the Open choice from the File menu.  In the Open Database
dialog box (figure 9.1), click on the List Files of Type pulldown and select the
desired type of database.  You can also change the drive and directory of where to
locate the database.  When the database you want is displayed in the file list, click
on it in the window and click OK, or simply double click to open.

Figure 9.1  The Open Database Dialog Box

Hint: If the database you want to open is one of the last four projects or
databases you have accessed, then it is displayed at the bottom of the file
menu and can be opened directly simply by clicking on it.
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3-Panel Display

All of the Supporting Databases have a 3-Panel display similar to the display for
the Project (Figure 9.2).

Figure 9.2  3-Panel Display for the Labor Rates Database

The upper left panel is the Outline Panel, displaying the database structure.  A title
with a Plus symbol  has further titles underneath it which can be displayed by

clicking on the symbol.  The Page Leaf symbol  indicates that there are detail
items beneath the title which are displayed when the Grid Panel is open.  To the

right of the title description is a column for the Notes indicator  , designating
when a title has notes attached.

The upper right panel is the Notes/Reference Panel.  Here you can edit or add
notes on detail or title items.

The lower panel is the Grid Panel displaying either titles or detail items,
depending on what is highlighted in the Outline Panel.  Use the horizontal scroll

bar to view the columns off the right side of the screen.  The Freeze button 
locks the column to the left of the cursor so that it does not scroll off the left side

of the screen.  The Previous/Next buttons  move the Grid Panel view up or
down to the next title in the Outline Panel.
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9.2  Adding Titles to a Database

Title Levels

The title levels are used to organize the detail items into logical categories,
making them easier for the user to find.  When adding new cost items to the
database, they should be added under an existing title which contains similar
items, or you may need to add a new title for a new category of cost items.

For example, the Labor Rates Database titles group the labor cost items for
building workers under the title B and the labor items for hazardous, toxic, and
radioactive waste workers under the title H.  You would add a new building
worker under the existing title B, but if you had a new category for office workers
such as engineers, computer programmers, or clerks, you might want to add a new
title called O for Office Workers.

How to Add Titles

Titles are added in the Grid Panel.  If you adding to an existing list of titles,
position the cursor on the parent title in the Outline Panel so that the list of titles

you are adding to is displayed in the Grid Panel.  Press the Add Item icon  or
select Add a New Record from the Edit menu.  A new line for the new title is
added in the Grid Panel.  Edit the Title ID and Description as desired.

If no titles or detail cost items currently exist under a parent, then the Grid Panel

will be empty.  When you select Add New Record  , the message “Which type
of items do you wish to add” is displayed.  Select the Subtitle button and the new
title is added in the grid.

You may also add notes to describe the use of the title category.  After notes are

added, the notes indicator  is displayed in the Outline Panel and a “Yes” is
displayed in the notes column of the Grid Panel.
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9.3  Adding Detail Items

Detail Level

The detail level contains the specific cost items for each type of Supporting
Database.  In the Unit Price Book (UPB) Database, the detail items are unit cost
items generally containing a unit material cost and a unit labor and unit equipment
installation cost.  In the Labor Rates Database the detail items are the labor costs
for each different type of laborer.

Detail items are displayed in the Grid Panel when the Outline Panel Selection

Indicator  is next to a title that contains detail, indicated by the Leaf symbol .

How to Add Detail Items

Detail items may only be added under a title which already contains detail items,
or under a title that contains no items.  To add a new detail item, highlight the

parent title in the Outline Panel and press the Add New Record icon  or select
Add New Record from the Edit Menu.

If you are adding to an existing list of detail items, the Detail Item Form will be
displayed.  If no items currently exist in the Grid Panel the message “Which type
of items do you wish to add” is displayed.  Select the Detail button and the Detail
Item Form is opened.

Enter the required data in the fields (see the Supporting Database chapters for
field descriptions) and press the Close button when finished.

Adding from Other Databases

When adding detail items, you can also search a subordinate Supporting Database
for cost information and then copy it back using the Drag and Drop or Copy and
Paste techniques.

At This Database You Can Copy Information From

Assemblies Project

Unit Price Book

Crews

Labor Rates

Equipment Rates

Unit Price Crews

Crews Labor Rates

Equipment Rates
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Drag and Drop

This is a very useful technique for adding cost data from a subordinating source
database into another destination database (see above table).  For instance, you
can drag cost items from the UPB (source) and drop them into a Project
(destination) or you can drag labor items from Labor Rates database (source) and
drop them into a crew in the Crews Database (destination).  The drag and drop
process automatically makes a copy of the item or group of items being dragged
from the source.

To use drag and drop, open both the source and destination database.  From the
Window Menu select Tile Vertically to see the databases side by side, or Tile
Horizontally to see the databases one above the other.  Click on the item or group
of items you want to copy in the source database.  Then, holding down the mouse
button, position the cursor in the grid or over the title where you want to add the
items.  When you release the mouse button the items are “dropped” and added to
the destination database.

Copy and Paste

You can also add cost items using the copy and paste technique.  With both
databases open, click on the item or group of items you want to copy, and press

the copy button  .  Now click in the grid of the destination database or click on
the title in the Outline Panel where you want to add the cost item.  Finally press

the paste button  and the cost item(s) will be added to the destination database.
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9.4 Editing and Deleting

Editing Cost Items

Cost item information can be viewed and edited when the cost item is displayed in
the Grid Panel.  Some fields can be edited directly on the grid by clicking in the
field and entering the new data.  Use the scroll bar to view any cost columns off
the right side of the screen.

To view each cost item individually, click on the Item Form button  or select
Item Form from the View Menu.  Change the data in the fields as desired and
press the Close button when finished.

Refer to the Supporting Database chapters for complete field descriptions.

Deleting Cost Items

To delete a cost item, click on it in the Grid Panel and select Delete Current
Record from the Edit Menu.  Alternatively you may use the Ctrl+D fast key
combination.  The item appears grayed out in the grid.  It is not actually removed
permanently from the database until the database is packed.

If you want to recall an item (before the database is packed), then click on it and
select Undelete Current Item from the Edit Menu or use the Ctrl+D keyboard
combination.

Editing Titles

There is not a great deal of information on the database title levels that might need
editing besides the title description.  Click on the Description field in the grid, and
type in the new information.

Deleting Titles

Deleting a title is very similar to deleting a cost item.  To delete a title, click on it
in the Grid Panel and select Delete Current Record from the Edit Menu (or use the
Ctrl+D fast key combination).  The message “Mark for deletion this item and all
subordinate items.  Are you sure?” is displayed.  Answer Yes and the title appears
grayed out in the grid.  Answering No cancels the operation.

If you click on the deleted title in the Outline Panel to view the subordinate level
in the Grid Panel, you see that all titles and cost items under the deleted title are
also grayed out and marked for deletion.  They are not actually removed
permanently from the database until the database is packed.

If you want to recall the title and all subordinate data, then click on the title in the
Grid Panel and select Undelete Current Item from the Edit Menu or use the
Ctrl+D keyboard combination.



9-8 MCACES for Windows

Editing Database Summary Information

The Database Summary Information screen is used when adding a new database
or to edit overall database information such as the database description or unit of
currency.  The screen is automatically displayed whenever adding a new database.
To access the screen for an existing database, click on the Summary Information

button  or choose Summary Info... from the File Menu.

Enter the new data in the fields (see the Supporting Database chapters for field
descriptions).  Press the OK button to save the changes and exit the dialog box, or
press Cancel to cancel the operation or to return to the original entries without
saving changes.
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9.5 Working With Multiple Databases

Purpose

MCACES allows you to work with multiple versions of all of the Supporting
Databases.  This gives you great flexibility for selecting different supporting
databases to aid in building different project types, and also flexibility in
repricing.

For instance, you might create a separate UPB just for Civil Works type projects
that would not contain all the building construction line items found in the
standard UPB.  This database would take up less space on your hard drive and you
would be able to look for cost items faster.

Or you could create multiple Labor Rates Databases containing the different labor
costs in each of the areas where you build projects.

Creating Multiple Databases

MCACES provides two ways of creating multiple copies of Supporting
Databases.

• You can use the New button  on the toolbar or select New... from the File
Menu to create a new, empty databases.  This method is helpful if want to start
a database from scratch.

• You can use Copy command from the File Menu to make a duplicate of a
database with a new ID.  This method is helpful when you just want to edit the
costs within the database, maintaining most of the original titles and cost
items.

Repricing a Database

A particularly useful application of multiple databases is for repricing your project
with the labor, equipment, and material costs in a different database.

To update all project costs, select the Update All Pricing option from the Tools
Menu (figure 9.3).  Click in the boxes next to Reprice Labor and Equipment and
Reprice Material as desired.  Make sure that the databases you want used for the
repricing are displayed in the each of the database windows.  If you need to select

a new database, press the select button  and lookup the new database ID.



9-10 MCACES for Windows

Figure 9.3 The Update All Pricing Screen

Once you have all the databases selected, you may use the Save References button
to retain them.  When you are ready to start the reprice process, click on the
Reprice Now button.  The Cancel button cancels the operation.

If you just want to reprice the costs on an individual cost item displayed in  the
Grid Panel, then select the Reprice Item Labor / Equipment or Reprice Item
Material options from the Tools Menu.  The repricing uses the database references
displayed on the Calculation Tab of the Project Summary Information Screen.
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9.6 Printing the Supporting Databases

Purpose

Even though MCACES provides easy access to cost database information on
screen, there are times when you may want to print all or part of a Supporting
Database.  This procedure can be used to print all or part of the following
databases:

• Unit Price
• Crews
• Labor Rates
• Equipment Rates

Note: Supporting databases used with MCACES can be extremely large and can
take a long time to print.  You might want to select just the portion of the database
you need.

The MCACES Database Listings function is a selection on the File Menu.  This
command displays a tabbed dialog box which provides access to various options
for selecting ranges, filters, and formats.  Clicking on each tab will bring the
information on that tab to the front for view and input.

Refer to Section 15.7 for complete instructions.
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Chapter  10

The Unit Price Database

Introduction

The Unit Price Database (also referred to as the UPB for Unit Price Book) is a
storage place for individual cost items.  Each detail item can include costs for
material, labor, equipment, and unit cost, as well as shipping weight and shipping
volume figures.

Often, the items in this database contain crew IDs from the Crews Database.  This
allows you to reprice the Unit Price Database labor and equipment costs based on
crew compositions and current prices in the Labor and Equipment Rates
Databases.

In turn, information stored in the Unit Price Database can serve as input into the
Assemblies Database, or directly into the Project Database.

Supplied Database

The Unit Price Database supplied with MCACES  is based on Tri-Services data.
This database is based on the Unit Price Book and is therefore abbreviated UPB.
The UPB organizes cost items under a hierarchy of titles that corresponds to the
Construction Specifications Institute (CSI) classification system.  The structure of
the UPB is examined in detail in Section 10.1.

In This Chapter

This chapter describes the structure of the supplied Unit Price Database and gives
instructions for editing, deleting, and adding to the database.  Instructions for
adjusting the material prices of items and for using the database ID screen are also
provided.

The following sections are included in Chapter 10:

10.1  Structure of the Database
10.2  UPB Titles
10.3  UPB Detail Items
10.4   Summary Information
10.5   Modifiers



10-2 MCACES for Windows

10.1  Structure of the Database

Opening the Database

As with all other databases, to open a Unit Price Database either click on the File

Open button on the tool bar   or select Open from the File menu.  In the Open
dialog box, click on the List Files of Type pulldown and select Unit Prices.  You
can also change the drive and directory of where to locate the database.  Click on
the desired database in the window, and click OK.

Hint: If the database you desire to open is one of the last four projects or
databases you accessed, then it is displayed at the bottom of the File menu
and can be opened directly by choosing it.

3-Panel Display

The 3-Panel display, shown in Figure 10.1, is similar to the displays for the
Project and other Supporting Databases.

Figure 10.1 The Unit Price Database

The upper left panel is the Outline Panel, displaying the database structure.  A title
with a Plus symbol  has further titles underneath it which can be displayed by

clicking on the symbol.  The Page Leaf symbol  indicates that there are detail
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labor items beneath the title which are displayed when the Grid Panel is open.  To

the right of the title description is a column for the Notes indicator  ,
designating when a title has notes attached.

The upper right panel is the Notes/Reference Panel.  Here you can edit or add
notes on detail or title items.

The lower panel is the Grid Panel displaying either titles or detail items,
depending on what is highlighted in the Outline Panel.  Use the horizontal scroll

bar to view the columns off the right side of the screen.  The Freeze button 
locks the column to the left of the cursor so that it does not scroll off the left side

of the screen.  The Next and Previous buttons  move the Grid Panel view
up or down to the next title in the Outline Panel.

Title Levels

The titles at Level 1 title are the same as the 16 Construction Specifications
Institute (CSI) Divisions.

Levels 2 - 6 of the database represent further breakdowns by category of unit cost
items.  Some portions of the database use all six title levels, others do not.

Note:  See Section 10.2 for descriptions of the fields stored for each UPB title.

Detail Level

The detail level contains individual cost items.  Detail items are displayed in the
Grid Panel when the Outline Panel Selection Indicator is next to a title that
contains detail, indicated by the Leaf symbol.

Use the scroll bar to view the cost columns off the right side of the screen.  You
may edit the cost columns by clicking in the field and typing a new entry.  To

view more details on each cost item, click on the Item Form button   or select
Item Form from the View Menu.

Note:  Refer to Section 10.3 for descriptions of the fields stored for each detail
item.
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10.2  UPB Titles

Adding and Changing Titles

You can use the Grid Panel to change the title description or to add a new title.
To add a new title, position the cursor on the parent title in the Outline Grid, and

press the Add Item button  or select Add a New Record from the Edit menu.

Field Descriptions

The following information is stored for UPB titles.

Field Description

UPB ID Unit Price Book ID.  Database ID of the title.

Level Database level of the title.  Filled in by the program.

Name Name of the title.  The descriptive name can be expanded by using
the Notes feature.



Unit Price Database 10-5

10.3  UPB Detail Items

How to Add or Edit Detail Items

To add a new detail item, highlight the parent title in the Outline Panel and press

the Add New Record button  or select Add New Record from the Edit menu.
If no items exist in the Grid Panel the message “Which type of items do you wish
to add” is displayed.  Select the Detail button and the Detail Item Form is opened.
Enter the required data in the fields (see the Field Descriptions below) and press
Close to save.

To edit an existing item, highlight the item in the Grid Panel and press the Item

Form icon  or select Item Form from the View menu.

Detail Item Form, General Tab

The Item Form for detail items, General tab, is shown in Figure 10.2

Figure 10.2: Detail Item Form, General Tab, Unit Price Database
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Field Descriptions, General Tab

The following table describes the fields on the General tab for UPB detail items.

Field Description

Unit Price
ID

ID of up to ten characters used to place the item in the database
hierarchy.  When adding an item, choose an ID of up to 10
characters that places the item between its title's ID and the ID of
the next title.

Source 3-character source ID specifying the type of the item.  Codes
include the following:

MIL - Building construction item.

CIV - Civil works item.

HTW - Hazardous waste construction item.

RAD - Radioactive waste item

TUN - Tunneling item.

When you add an item, the program automatically fills in the
first part as USR for user-defined.

Units Unit of Measure applied to the item.

Refer to Appendix E for valid units of measure.

Description Description of the cost item. Description can be up to 64
characters in length. The description can be expanded through
use of the Notes feature.

Crew ID of a crew in the Crews Database that the item references for
labor and equipment costs

Output/Hr The crew's estimated output per unit of measure associated with
the cost item.

Contractor Contractor ID applied to this item.  This ID is supplied as a
default, which you can change if needed when you copy the item
into a project.



Unit Price Database 10-7

Field Description

Unit Cost
Fields

These fields contain the unit costs for the item in each of the
following cost categories.

Manhrs Number of manhours required to perform the specified work.

If crews are used, MCACES calculates this figure by dividing
the number of worker hours in the crew by the crew output.
(The crew output equals the Hourly Output figure times the
Crew Productivity value entered in the Crews Database.)
Adjusting the hourly output will therefore change this value.

Note: This value is shown on project backup reports as an aid in
scheduling.  It is also shown in the Project Database Manhours
cost column, if one is defined

Labor Unit labor cost associated with the item.

If crews are used, this cost equals the crew's total hourly labor
cost divided by the crew output.  (The crew output equals the
Hourly Output figure times the Crew Productivity value entered
in the Crews Database.)

Equipment Unit equipment cost associated with the item.

If crews are used, this cost equals the crew hourly equipment
cost divided by the hourly output.  (The crew output equals the
Hourly Output figure times the Crew Productivity value entered
in the Crews Database.)

Material Unit material cost associated with the item.

UnitCost Unit Cost for work quoted by a subcontractor to the currently
assigned contractor.

Total Total unit cost of the item. The sum of the Labor, Equipment,
Material, and UnitCost unit costs.
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Field Description

Shipping
Fields

These fields are used to compute a shipping weight for the item.  If
the item weighs less than 56 LBS/CF, then you enter unit values in
both the Weight and Volume fields, and MCACES computes the
Equivalent Shipping Weight for cost purposes based on the values
of the Weight and Volume fields.  Otherwise, the Equiv. Weight is
set equal to the unit weight.

Weight Weight per unit of measure for the cost item.

Volume Volume per unit of measure.  Used to compute the Equivalent
Shipping Weight for low-density items.

Equiv.
Shipping
Wt.

Computed by the program.  This is the weight the program uses to
calculate the shipping cost of the item.

If the item weighs less than 56 lbs./cubic foot, the program
computes the equivalent shipping weight for cost purposes by
multiplying the unit volume times the standard density of 56 lbs./cf.

Otherwise, the program sets the Equivalent Shipping Weight field
equal to the actual unit weight entered above.

This field is computed in kilograms regardless of the unit of
measure used to enter the unit weight and unit volume.

Note:  In the Project Database, only the equivalent shipping weight
is saved.  The next time you view or edit the item, the Unit Weight
field will show the same value as the Equivalent Shipping Weight
field and the Unit Volume field will be blank.  If you want to store
all the field values, you can define and store the item in the Unit
Price Database and then copy it into the project.
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Detail Item Form, Material Backup Tab

The Material Backup tab for UPB detail items is used to store vendor price quotes
for material for an item and to select a material price based on the quotes.

Figure 10.3: Detail Item Form, Material Backup Tab, Unit Price Database

Field Descriptions

The Unit Price ID, Source, Units, and Description fields are the same as on the
General tab.  The following table describes the remaining fields on the Material
Backup tab.

Field Description

Default Mat'l Material unit cost assigned to the item when the database was
first compiled.  Not changed until the database is recompiled by
its developer.

Material
Updated

Date when the material price for this cost item was last updated.
The program fills in the present computer system date when you
are adding a new item.

Vendor
Fields

The grid fields can be used to store up to five vendor quotes for
the item.

Vendor ID Database ID associated with the vendor.

Vendor
Name

Name of the vendor firm.

Material Material unit price quoted by the vendor.

Date Date of the quote.

Selected Use the dropdown list to select the Lowest, Highest, Average, or
Override price for the item based on the vendor quotes.
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10.4  Summary Information

Summary Information Dialog Box

The Summary Information dialog box for the Unit Price Database shows summary
and currency information, and a reference to the Labor, Equipment, and Crews
Databases last used to reprice this UPB.  The General tab of the dialog box is
shown in Figure 10.4.

Figure 10.4:  Summary Information Dialog Box, Unit Price Database, General Tab

To display the dialog box, choose the Summary Information button from the tool
bar.
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Field Descriptions, General Tab

This table describes the fields and options on the General tab.

Field Description

Database ID Six-character ID used to identify the Unit Price Database

File Path DOS drive and directory where the project files are stored.

Name Name of the UPB.  Up to 32 characters.

Issue Date Date when the UPB was issued.

Measurement The units of measure to be used for storage of the data and
display on the screen.  Options are:  Original (the units as
entered), Metric, and U.S.

Currency
Fields

The following fields are used to compute currency conversions
for the database.  This allows you to transfer a project from one
currency to another

Description Name of the currency

Units Select the Units for storing monetary values and displaying them
on the screen.

Units/US $ Ratio of the currency to one U.S. dollar.  That is, the actual
exchange rate of one U.S. dollar to the selected currency

Database References Tab

The Database References tab shows the names, IDs, and file paths for the Labor
Rates, Equipment Rates, and Crews Databases last used to reprice this Unit Price
Database.  To reprice the UPB from these or other databases, choose the Reprice
button.
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10.5  Modifiers

About Modifiers

Modifiers provide for the option to change the labor, material, and/or shipping
cost of Unit Price Database items by adding or deducting optional quality or
scope.  A library of more than 1000 modifiers is provided with the Unit Price
Database supplied with MCACES.

Working in the Unit Price Database, you can add new modifiers to this library or
change the characteristics of current modifiers.  You can also delete modifiers
from the library.

Modifier IDs

Each modifier in the library is assigned a modifier ID, which is equivalent to a
Unit Price Database ID for that modifier.

The first five characters of the modifier ID are the same as the first five characters
of the UPB IDs of all items to which the modifier can be applied.

Example:  The modifier represented by modifier ID 03110 29901 can only be
assigned to items with a UPB ID that begin with 03110.

Note:  There is no restriction against a modifier ID being the same as the UPB ID
of an item.

Modifier Ranges

Each modifier in the library is also assigned a range of valid UPB IDs.  This range
indicates all the UPB items to which the modifier can be applied.

Example:  Modifier ID 03110 29901 might be assigned to the range of UPB items
with UPB IDs 03110 2500 to 03110 2574.  (Note that the modifier ID in this case
is outside the range of the UPB IDs.)

How to Access Modifier Features

You work with modifiers by pressing the paintbrush button on the title line of the
Grid Panel.  When this button is depressed, the Outline Panel will display a

paintbrush icon  next to each title under which modifiers exist (figure 10.5).
The Grid panel will display each modifier within the range of the item highlighted
in the Outline Panel.  In this configuration, using the Item Form and Add Record
toolbar buttons will enable you to add new modifiers or change existing
modifiers.  You can use the Delete selection on the Edit Menu to delete the
modifier currently highlighted in the Grid Panel.
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The Outline Panel and Grid Panel after the paintbrush button has been pushed is
shown in Figure 10.5.

Figure 10.5:  Outline Panel and Grid Panel displayed in Modifier Mode

Field Descriptions, Modifier Grid Panel

This table describes the fields on the Modifier Grid Panel.

Field Description

Src Three-character Source ID which identifies the item as follows:

MIL - Building construction item.
CIV - Civil works item.
HTW - Hazardous waste construction item.

Modifier ID Database ID assigned to the modifier.  Has the same first five
characters as the first five characters of the UPB IDs of all items
to which the modifier can be applied.

From UPB ID of the first cost item in the database to which this
modifier can be applied.
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Field Description

To UPB ID of the last cost item in the database to which this
modifier can be applied.

Description Modifier description, used to identify the nature and scope of the
modifier.

Labor Percent of adjustment made to a cost item’s labor and equipment
price when this modifier is applied to the item.

Material Percent or amount of adjustment made to a cost item’s material
price when this modifier is applied to the item.

Editing a Modifier

To make changes to the modifier highlighted in the Grid Panel, click on the Item

Form button  on the Toolbar.  This will initiate the Item Form dialog box for
modifiers (see figure 10.6).  Make changes as required, then close the dialog box
to save your changes.  The fields on the General and Material Backup Tabs are
described below.

Figure 10.6:  Item Form General Tab displayed in Modifier Mode
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Field Descriptions, Item Form (Modifier) - General Tab

This table describes the fields on the General Tab of the Item Form for modifiers.

Field Description

Modifier ID Database ID assigned to the modifier.  Has the same first five
characters as the first five characters of the UPB IDs of all items
to which the modifier can be applied.

Source Three-character Source ID which identifies the item as follows:

MIL - Building construction item.
CIV - Civil works item.
HTW - Hazardous waste construction item.

Description Modifier description, used to identify the nature and scope of the
modifier.

Apply
Material and
Shipping
Adjustments
As:

Indicates the method used to apply this modifier's material and/or
shipping adjustments.  Choices are:

Percent - The adjustment percentage is multiplied by the item's
base unit cost or value.

Amount - The adjustment amount is added to the base unit cost
or value.

Note: Labor and Equipment costs may be adjusted by a
percentage only.

Range
Affected by
Modifier:

Indicates the range of UPB IDs to which this modifier can be
applied.

From ID: UPB ID of the first cost item in the database to which
this modifier can be applied.

To ID: UPB ID of the last cost item in the database to which this
modifier can be applied.

Adjustment
Values

Labor: percent of adjustment made to a cost item’s labor and
equipment price when this modifier is applied to the item.

Material: percent or amount of adjustment made to a cost item’s
material price when this modifier is applied to the item.

Weight: percent or amount of adjustment made to a cost item’s
weight when this modifier is applied to the item.

Volume: percent or amount of adjustment made to a cost item’s
volume when this modifier is applied to the item.
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Item Form (Modifier) - Material Backup Tab

Material backup records can be edited for modifiers in the Unit Price Database in
MCACES Gold 5.30.  To view a backup record in MCACES for Windows, select
the material backup tab.

Adding a Modifier

To add a modifier, highlight the lowest level title record in the Outline Panel, then

click on the Add button  on the Toolbar.  This will initiate the Add dialog box
for modifiers.  Fill in the fields as needed to define the modifier.  The fields are
the same as described above for editing a modifier.

Deleting a Modifier

To delete a modifier, make sure the modifier you wish to delete is highlighted on
the Grid Panel.  On the Edit Menu, select Delete Current Record.  The highlighted
modifier will be greyed out and will be removed from the database when you have
used the Pack a Database command.
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Chapter  11

The Crews Database

Introduction

The Crews Database is used to group labor and equipment costs into crews.  Each
cost item in the Crews Database corresponds to a detail cost item in either the
Labor Rates or Equipment Rates Database.  The Crews Database should be
viewed as a library of crew compositions, which are used to access the pricing
data stored in the Labor Rates and Equipment Rates Databases.

Crew compositions can be referenced to generate labor and equipment cost data
for the Project, Assemblies, and Unit Price Databases.

Supplied Database

The Crews Database supplied with MCACES contains several hundred crews
developed by the Tri-Services.

Using Multiple Databases

During repricing, the software uses the crew compositions found in the selected
Crews Database to locate the labor and equipment costs in the selected Labor and
Equipment Rate Databases.  Since the labor and equipment costs are actually
stored in their respective databases, it is not necessary, nor is it recommended, to
keep multiple Crews Databases priced for different areas of the country.  If
needed, the Crews Database can be repriced using site specific Labor and
Equipment Databases.

In This Chapter

The following sections are included in this chapter:

11.1 Structure of the Database
11.2 Crew Titles
11.3 Crew Detail Items
11.4 Summary Information
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11.1  Structure of the Database

Opening the Database

As with all other databases, to open a Crews Rates Database either click on the

File Open button on the Tool bar   or select the Open choice from the File
menu.  If you have a Project or Assemblies database already open, then the Open

Crews button  is also available.  Any of these three actions accesses the Open
Database dialog box.

In the Open Database dialog box, click on the List Files of Type pulldown and
select Crews (this is already selected when using the Open Crews button).  You
can also change the drive and directory of where to locate the database.  Click on
the desired database in the window, and click OK.

Hint: If the database you desire to open is one of the last four projects or
databases you accessed, then it is displayed at the bottom of the file menu
and can be opened directly by choosing it.

3-Panel Display

The 3-Panel display, as in Figure 11.1, is similar to the displays for the Project
and other Supporting Databases.
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Figure 11.1 The Crews Database

The upper left panel is the Outline Panel, displaying the database structure.  A title
with a Plus symbol  has further titles underneath it which can be displayed by

clicking on the symbol.  The Page Leaf symbol  indicates that there are detail
crew items beneath the title which are displayed when the Grid Panel is open.  To

the right of the title description is a column for the Notes indicator  ,
designating when a title has notes attached.

The upper right panel is the Notes/Reference Panel.  Here you can edit or add
notes on detail or title items.

The lower panel is the Grid Panel displaying either titles or detail items,
depending on what is highlighted in the Outline Panel.  Use the horizontal scroll

bar to view the columns off the right side of the screen.  The Freeze button 
locks the column to the left of the cursor so that it does not scroll off the left side

of the screen.  The Previous/Next buttons  move the Grid Panel view up or
down to the next title in the Outline Panel.
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Title Levels

In MCACES, a crew is a grouping of the labor and equipment items required to
accomplish a specified type of work.

In the Crews Database, a crew is defined as a title that groups together a number
of detail labor and/or equipment items.

Detail Level - Crew Members

Each detail cost item beneath the crew title refers to the crew members.  Crew
members can represent either labor or equipment costs.  Detail items are displayed

in the Grid Panel when the Outline Panel Selection Indicator  is next to a title

that contains detail, indicated by the Page Leaf symbol .

In the Grid Panel, each crew member line item has a database ID that connects it
to its source in the Labor or Equipment Rates Database.  A single line item may
contain the labor costs for several workers paid at the same rate, or for only a
portion of a single worker’s rate.  This is determined by the quantity in the Labor
Hours (L hr) or Equipment Hours (E hr) column.  The basic labor rate can also be
adjusted for foremen rates and apprentice rates, and equipment can use the
average, severe, or standby rate from Equipment Rates Database.

See section 11.3 for more information on the crew detail items.  Use the scroll bar
to view the cost columns off the right side of the screen.  You may edit selected
crew cost columns by clicking in the field and typing a new entry.

Example

A crew consisting of three carpenters, and one apprentice, using small tools, and
supervised by a foreman, might be defined as having the following members.

• One laborer member.  Quantity = 3, for the three carpenters, all paid the same
rate.

• One apprentice member.  Quantity = 1.

• One small tools member.  Quantity = 1.  (Small tools are generally estimated as
an hourly allowance on a per average crew basis.)

• One foreman member.  Quantity = 0.25.  This assumes the foreman devotes
only 25% of his time to this crew.

How Crews Reference Other Databases

Each crew in the Crews Database references the Labor Rates Database to price its
labor members.  If the crew uses equipment, it also references the Equipment
Rates Database to price the equipment members.
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How Other Databases Reference Crews

In turn, crews can be referenced by cost items in the Project, Assemblies, and Unit
Price Databases, to obtain labor and equipment pricing for these cost items.

Example

Expanding on the example above, the carpenter crew might be referenced by a
cost item for a plywood roofing task in the Unit Price Database.

• The labor cost of each crew member is computed as the member quantity times
the rate for that member.

3 X 22.87 (laborer rate) = $68.61

1 X 18.30 (apprentice rate) = $18.30

0.25 X 23.37 (foreman rate) = $5.84

• The total hourly labor cost of the crew is then computed as the sum of these
individual costs.

68.61 + 18.30 + 5.84 = $92.75

• Similarly, the hourly equipment cost of the crew is computed as one times the
small tools rate.

1 X 1.45 = $1.45.

• The total hourly crew cost is the sum of the hourly labor cost and the hourly
equipment cost.

92.75 + 1.45 = $94.20

• In the Unit Price Database, the hourly output for this crew performing the
roofing task is estimated at 175 SF per HR.

• This hourly output value is multiplied by the Crew Productivity value of 1.00,
which is stored in the Crews Database.  (Productivity values other than 1.00
can be used if conditions warrant.  See the Field Description in Section 11.4.)

175 X 1.00 =  175 SF per HR.

• The unit labor cost for this roofing item in the UPB is then computed as the
crew's hourly labor cost divided by the calculated hourly output:

$92.75 per HR / 175 SF per HR = $0.53 per SF.

• The unit equipment cost is likewise computed:

$1.45 / 175 = $0.01.
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Crews as Assemblies

Crews can also be copied to the lowest title level in the Project Database.  In this
case, the crew title becomes a lowest-level project title, and its members become
individual cost items beneath that title.

This method of using crews is referred to as "crews as assemblies," and is
explained in Section 6.6.
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11.2  Title Levels

Where to Add Titles

The Crews Database supplied with MCACES is organized into three title levels.
The first two title levels are used to group the data by the type of work performed.

Level 1 divides the database into general types of work, for example Architectural
Crews and Civil Works Crews.  Level 2 provides a further breakdown, which
differs depending on the Level 1 category.  The Civil section breaks down the
crews based primarily on the type of equipment employed by each crew.  The
other sections organize the crews based on the predominant trade employed.

The actual crews are designated as Level 3 titles.  The crew description generally
contains the number of laborers and the type of equipment found in the crew.

How to Add Titles

Titles are added in the Grid Panel.  If you adding to an existing list of titles,
position the cursor on the parent title in the Outline Panel so that the list of titles

you are adding to is displayed in the Grid Panel.  Press the Add Item icon  or
select Add a New Record from the Edit menu.  A new line for the new title is
added in the Grid Panel.  Edit the Title ID and Description as desired.

If no titles or detail cost items currently exist under a parent, then the Grid Panel

will be empty.  When you select Add New Record  , the message “Which type
of items do you wish to add” is displayed.  Select the Subtitle button and the new
title is added in the grid.

You may also add notes to describe the use of the title category.  After notes are

added, the notes indicator  is displayed in the Outline Panel and a “Yes” is
displayed in the notes column of the Grid Panel.

Field Descriptions

Title ID The database ID of the title.  Choose an ID to place the title
logically in the database.

Description Description of the crew category or crew composition.

Notes This column displays “Yes” when notes have been added to the
title.
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11.3  Crew Detail Items

How to Add or Edit Detail Items

You can add labor or equipment members to existing crews, edit the composition
of existing crews, or add whole new crews to the database as your needs dictate.

Caution:  Care must be taken when editing existing crews since the crew
composition in the Crews Database is used to determine the unit labor and
equipment costs of cost items in the Project.  Changing the members of an
existing crew will have an effect on each cost item which references that crew the
next time the project is repriced.

Detail items are added and edited in the Grid Panel.  To edit an existing item,
click on the field you wish to change and type in the new data.

There are three ways to add a new detail item.  The best way is to copy the labor
or equipment item from the Labor Rates or Equipment Rates Database using the
Drag and Drop technique or Copy and Paste technique (see below).

You can also add an item using the Add button or menu selection.  Highlight the

parent title in the Outline Panel and press the Add New Record button  or
select Add New Record from the Edit Menu.  If no items exist in the Grid Panel
the message “Which type of items do you wish to add” is displayed.  Select the
Detail button and a new line is added to the Grid.

Enter the Database ID, Quantity, and Type in the required fields (see the following
section for field descriptions).  Adding in this way requires you to know the
Database ID of the item you wish to add.

Drag and Drop

This is a very useful technique for easily copying labor and equipment items from
their source databases to a crew title in the destination database.

To use drag and drop, open both the source (Labor or Equipment Rates Database)
and destination (Crews) database.  From the Window Menu select Tile Vertically
to see the databases side by side, or Tile Horizontally to see the databases one
above the other.  In the source database, click on the labor item, equipment item,
or group of items you wish to copy.  Then, holding down the mouse button,
position the cursor in the grid or over the crew title where you want to add the
items.  When you release the mouse button the items are “dropped” and added to
the crew.  To complete the process, enter the member hours and member type in
the grid.

For more about drag and drop, see section xx.x.
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Copy and Paste

You can also add cost items using the copy and paste technique.  With both
databases open, click on the item or group of items you want to copy, and press

the copy button  .  Now click in the grid of the Crews database or click on the
crew title in the Outline Panel where you want to add the crew member(s).

Finally press the paste button  and the cost item(s) will be added to the
destination database.

Crew Information in the the Grid Panel

When a level 3 Crew ID is selected in the Outline Panel, the Crew Members along
with other crew information is displayed in the Grid Panel as shown in Figure
12.2

Figure 12.2: Detail Crew Information Shown in the Grid Panel

The top and bottom of the Grid Panel display global crew information, and the
center of the grid lists the crew members and their information.
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Field Descriptions

The following fields are displayed in the Crew Grid Panel.

Top of Grid

Crew ID Display of the ID of the crew.  This is the same as the ID
shown in the Outline Panel.

Description Description of the crew.  This is the same as the description
shown in the Outline Panel.  You can extend the description by
adding Notes at the title level.

Units Unit of measure applied to the cost of the crew.  Usually hours
(HR), though Day, Week, Shift, and Month are also acceptable.

Productivity Productivity figure assigned to the crew.

An entry of 1.00 represents standard U.S. productivity.  If
conditions warrant the crew to only work at 80%, for example,
then .80 should be entered.

When MCACES computes crew-dependent costs for a cost
item, it multiplies the Crew Productivity value times the Hourly
Output figure (as entered for the item in the Unit Price,
Assemblies, or Project Database.)  The resulting output figure
is then divided into the crew's total labor and equipment costs
to yield the unit labor and equipment costs for the item.

The default for this field is set on the Crews Summary
Information Screen.  See Section 11.4.

Middle of Grid

Source The 3-character tag that identifies the original source of the
cost item.  Values include USR for user-created, MIL for
military building development, CIV for Civil works.

Database ID The ID of this item in either the Labor or Equipment Rates
Database.  Up to 10 characters may be used.  If you enter a
member ID with no match in the appropriate database, the
program issues a warning message but allows you to continue.

Description Description of the crew member.  Copied from the Labor or
Equipment Rates Database.

Labor Hours (L hr) Quantity of time, per the unit of measure, charged for this
labor member.  Can also be viewed as the number of this type
of member employed in the crew.

Equip Hours (Eq hr)Quantity of time, per the unit of measure, charged for this
equipment member.  Can also be viewed as the number of
pieces of equipment used in the crew.
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Rate Cost per unit of measure for this member.  Copied by the
program from the appropriate database and adjusted based on
the labor or equipment type selection.

Labor Cost The labor hours multiplied by the adjusted labor rate.

Equipment Cost The equipment hours multiplied by the adjusted equipment
rate.

L/E Type Identifies the type of rate used by this crew member.  Codes
are:

Equipment Average - Uses the unit rate for average
conditions  from the Equipment Rates Database.

Equipment Severe - Uses the unit rate for severe conditions
from the Equipment Rates Database.

Equipment Standby - Uses the unit standby rate from the
Equipment Rates Database.

Laborer - Uses the unit rate in the Labor Rates Database.

Apprentice - Uses a preset percentage of the unit rate in the
Labor Rates Database.  For example, 80%.

Foreman - Adds a preset amount to the unit rate in the Labor
Rates Database.  For example, $.50 per hour.

Note:  The Apprentice and Foreman adjustment  values are set
on the Crews Summary Information (see Section 11.4).

Member Override Filled in by the program.  Indicates whether a user has
changed any information about this crew member since the
Crews Database was created.  Values are Yes and No.

Sequence Code An optional entry of up to 4 characters that determines the
order crew members are displayed in browse mode and in
listings.

Bottom of Grid

Override This box is filled in by the program when any of the following
are true:

• A user has changed the crew title information.
• A user has added or deleted crew members.
• A user has changed information about any of the crew
members (so that the Member Override field on any crew
member entry screen is set to Yes).

Updated Date when crew information was last updated.  When you are
adding a crew, the computer system date is automatically
entered here.
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Crew Totals

Labor Hours Sum of all the labor hours contained in the crew.

Equip Hours Sum of all the equipment hours contained in the crew.

Rate Total cost of the crew, per the unit of measure.

Labor Total cost of labor time per the unit of measure.

Equip Total cost of equipment time per the unit of measure.
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11.4  Summary Information

To edit overall Crew Database information such as the default crew productivity

or unit of currency, click on the Summary Information button  or select
Summary Information from the File Menu with the Crews Database active.
Displayed is the Summary Information screen with the current database ID and
directory path shown (figure 11.3).

Figure 11.3  The Crews Summary Information Screen

Field Descriptions

When the Summary Information dialog box is opened, the current database
description, directory path, and database ID are displayed.  You can edit the
following fields.
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General Tab

Name Descriptive name of the database.

Foreman Additional Amount The amount to be added to each unit labor
rate to compute the foreman rate for that labor item.

Apprentice Percentage The percentage to be multiplied by each unit labor rate
to compute the apprentice rate for that labor item.

Default Productivity Default value for the Productivity field for all crews in
the database.

Currency Description Name of the currency.

Currency Units Units for storing monetary values and displaying them
on screen.  Options are:
Ones
Tens
Hundreds
Thousands
Tens of thousands

Currency Units/US $ Ratio of the currency to one U.S. dollar.

Examples:

If you are working with Japanese yen and the exchange
rate is 135 yen per dollar, enter 135 in the Units per
U.S. dollar field.

If you are working with Kuwaiti dinars and the
exchange rate is 3.40 dollars per dinar, enter 0.29
(1/3.40 = 0.29) in the Units per U.S. Dollar field.

Database References Tab

Labor The name, ID, and path of the Labor Rates Database
used to price the current Crews Database.

Equipment The name, ID, and path of the Equipment Rates
Database used to price the current Crews Database.

Reprice Use this button to access the Update All Pricing dialog
box which allows the selection of repricing of Labor
and Equipment  costs, and the selection of different
supporting databases for repricing.

Press the OK button to save the changes and exit the dialog box, or press Cancel
to return to the original entries without saving changes.
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Chapter  12

The Labor Rates Database

Introduction

The Labor Rates Database stores labor costs, including the costs of taxes,
insurance, fringe benefits, and travel.

A labor cost item from the Labor Rates Database can be copied directly into the
Project or Assemblies databases as a line item using the drag and drop or copy
and paste techniques.  A labor cost item can also be combined with other labor
and equipment cost items to become crew members in the Crews Database.

Supplied Database

The Labor Rates Database supplied with MCACES is based on Tri-Services data.
It contains approximately 150 labor rate items organized by labor type under one
or two title levels, and is priced at a national level.

Using Multiple Databases

A new labor rates database may be created and edited for each project, so that it
contains the labor rates specific for that area.

In This Chapter

The following sections are included in this chapter:

12.1 Structure of the Database
12.2 Labor Rates Titles
12.3 Labor Rate Detail Items
12.4 Summary Information
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12.1  Structure of the Database

Opening the Database

As with all other databases, to open a Labor Rates Database either click on the

File Open button on the Tool bar   or select the Open choice from the File
menu.  If you have a Project, Assemblies, or Crews database already open, then

the Open Labor button  is also available.  Any of these three actions accesses
the Open Database dialog box.

In the Open Database dialog box, click on the List Files of Type pulldown and
select Labor (this is already selected when using the Open Labor button).  You
can also change the drive and directory of where to locate the database.  Click on
the desired database in the window, and click OK.

Hint: If the database you desire to open is one of the last four projects or
databases you accessed, then it is displayed at the bottom of the file menu
and can be opened directly by choosing it.

3-Panel Display

The 3-Panel display, as in Figure 12.1, is similar to the displays for the Project
and other Supporting Databases.
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Figure 12.1 The Labor Rates Database

The upper left panel is the Outline Panel, displaying the database structure.  A
title with a Plus symbol  has further titles underneath it which can be displayed

by clicking on the symbol.  The Page Leaf symbol  indicates that there are
detail labor items beneath the title which are displayed when the Grid Panel is

open.  To the right of the title description is a column for the Notes indicator  ,
designating when a title has notes attached.

The upper right panel is the Notes/Reference Panel.  Here you can edit or add
notes on detail or title items.

The lower panel is the Grid Panel displaying either titles or detail items,
depending on what is highlighted in the Outline Panel.  Use the horizontal scroll

bar to view the columns off the right side of the screen.  The Freeze button 
locks the column to the left of the cursor so that it does not scroll off the left side

of the screen.  The Previous/Next buttons  move the Grid Panel view up or
down to the next title in the Outline Panel.

Title Levels

The title levels are used to organize the different types of labor into categories.
User created labor items are generally added under level one title Z, and are
further categorized by project or division under a level two title, making them
easy to find and review.
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Detail Level

The detail level contains the labor and associated taxes, insurance, fringe benefits,
and travel costs for each trade.  Detail items are displayed in the Grid Panel when

the Outline Panel Selection Indicator  is next to a title that contains detail,

indicated by the Leaf symbol .

Use the scroll bar to view the labor cost columns in the Grid Panel.  You may edit
the basic labor rate columns by double clicking twice in the field and typing a
new entry.

To view each labor item individually, click on the Item Form  or select Item
Form from the View Menu.  The Next button moves the focus to the next labor
item in the Grid Panel.  You may also move the focus to the Previous labor item.
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12.2  Title Levels

Where to Add Titles

You might add titles to a Labor Rates database in order to create a new
classification of workers.  For example, you might want to add a category O for
Office Workers such as Engineers, Computer Programmers, or Clerks.

How to Add Titles

Titles are added in the Grid Panel.  If you adding to an existing list of titles,
position the cursor on the parent title in the Outline Panel so that the list of titles

you are adding to is displayed in the Grid Panel.  Press the Add Item icon  or
select Add a New Record from the Edit menu.  A new line for the new title is
added in the Grid Panel.  Edit the Title ID and Description as desired.

If no titles or detail cost items currently exist under a parent, then the Grid Panel

will be empty.  When you select Add New Record  , the message “Which type
of items do you wish to add” is displayed.  Select the Subtitle button and the new
title is added in the grid.

You may also add notes to describe the use of the title category.  After notes are

added, the notes indicator  is displayed in the Outline Panel and a “Yes” is
displayed in the notes column of the Grid Panel.

Field Descriptions

Labor Title ID The database ID of the title.  Choose an ID to place the title
logically in the database.

Name Description of the labor category.

Notes This column displays “Yes” when notes have been added to the
title.
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12.3  Labor Rate Detail Items

How to Add or Edit Detail Items

You can add or edit labor rate items as your project needs dictate.

For example, you may want to add rates to match local union and open shop pay
scales.  You may need to add project management personnel.  Or you may want to
create a separate labor category for a particular crew or task.

To edit an existing item, highlight the item in the Grid Panel and press the Item

Form button  or select Item Form from the View menu.

To add a new detail item, highlight the parent title in the Outline Panel and press

the Add New Record button  or select Add New Record from the Edit Menu.
If no items exist in the Grid Panel the message “Which type of items do you wish
to add” is displayed.  Select the Detail button and the Detail Item Form is opened.
Enter the required data in the fields (see the following section for field
descriptions) and press Close when finished.

Detail Item Form

The Item Form for detail items is shown in Figure 12.2.
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F
igure 12.2: Detail Item Form, Labor Rates Database

Field Descriptions

The following fields are displayed on the Detail Item Form.

Labor ID An ID of up to 10 characters that uniquely identifies the item in
the database and places it beneath its title.

Source The program assigns USR for user-created items.  Databases
furnished with the program use MIL for military building
construction, CIV for civil works, and other abbreviations.

Description The kind of laborer.  You can expand the description through
use of the Notes feature.

Units of Measure.  Normally hours are used as the unit of measure,
though other time units are allowed.  (See Appendix G for
valid units.)

Default Rate Default rate stored in the database for the item.  This rate is
entered at the time the database is created, and is only changed
when the database is updated by the database developer.  It is
provided as a baseline for comparison purposes.

Updated The program automatically fills in the system date when the
item was last changed in the database.  For a new item, the
system inserts the current date as the date created.
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Basic Rate Basic rate per the unit of measure in the following field.

Overtime Hourly amount or percentage applied to the labor item for
overtime.
Note: An overtime amount or percentage is only entered
here if this labor item will always be used on tasks composed
of a constant ratio of straight time and overtime.  Generally,
this only occurs when an entire project is estimated based on a
specific percentage of overtime and a Labor Rates Database is
dedicated to that project.  More often, overtime is applied at the
level of the project task, as described in Section.

Hint: For this and the next 3 fields, you can enter either the amount or
percentage and the program will compute the other.

Payroll Taxes & Insurance This amount or percentage includes Workmen's
Compensation and Liability Insurance, State and Federal
Unemployment Compensation, and Social Security.

Fringe Benefits This amount or percentage includes costs for health and
welfare, pension, vacation, apprentice training, and other costs
as may be required by union agreements or established trade
practice.

Travel/Subsistence Amount or percentage for travel costs or subsistence as
may be required.

Total Labor Rate Sum of the basic rate plus the preceding 4 cost fields.
Computed by the program.

Note:` This is the standard laborer rate for the item.  To arrive at the foreman and
apprentice rates used in the Crews and other databases, the program
adjusts the laborer rate with values entered on the Crews Summary
Information dialog box (as described in Chapter 11).
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12.4  Summary Information

To edit overall Labor Rates Database information such as the database description

or unit of currency, click on the Summary Information button  or select
Summary Information from the File Menu with the Labor Rates Database active.
Displayed is the Summary Information screen with the current database ID and
directory path shown.

To add a new Labor Rates Database, click on the New button  or select New...
from the File Menu.  After entering the new database ID and clicking OK, the
Summary Information screen is displayed.

You can edit the following fields by entering new information.

Name Descriptive name of the database.

Currency Description Name of the currency.

Currency Units Units for storing monetary values and displaying them
on screen.  Options are:
Ones
Tens
Hundreds
Thousands
Tens of thousands

Currency Units/US $ Ratio of the currency to one U.S. dollar.

Examples:

If you are working with Japanese yen and the exchange
rate is 135 yen per dollar, enter 135 in the Units per
U.S. dollar field.

If you are working with Kuwaiti dinars and the
exchange rate is 3.40 dollars per dinar, enter 0.29
(1/3.40 = 0.29) in the Units per U.S. Dollar field.

Press the OK button to save the changes and exit the dialog box, or press Cancel
to return to the original entries without saving changes.
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Chapter  13

The Equipment Rates Database

Introduction

The Equipment Rates Database stores costs for equipment, including the cost of
ownership (depreciation and Facilities Capital Cost of Money) and operating costs
(fuel, filters, oil and grease, repairs, tire wear and tire repair).

Like a labor cost item, detail equipment items can be copied directly into the
Project or Assemblies databases as line items using the drag and drop or copy and
paste techniques.  An equipment cost item can also be combined with other
equipment and labor cost items to become a crew member in the Crews Database.

Supplied Database

The Equipment Rates Database supplied with MCACES contains rates for over
2400 pieces of equipment.  The supplied database also contains fields and
auxiliary files to support Tri-Service equipment cost calculations as defined in
engineering publication EP-1110-1-8, Construction Equipment Ownership and
Operating Expense Schedule, which is published annually by the Walla Walla
District of the U.S. Army Corps of Engineers.

A printed copy of the EP-1110-1-8 is available through the Superintendent of
Documents or government bookstores.  For information phone (202) 783-3238, or
write the following address:

Superintendent of Documents
P.O. Box 371954
Pittsburgh, PA 15250-7954

Using Multiple Databases

Separate Equipment Rates Databases containing costs for different regions can be
created by copying an initial database and adjusting the Area Factors portion of
the Summary Information dialog box.  Contact the U.S. Army Corps of Engineers
Division, TRACES Group, in Huntsville Alabama for the appropriate regional
factors.

In This Chapter

The following sections are included in this chapter:

13.1 Structure of the Database
13.2 Equipment Rates Titles
13.3 Equipment Rate Detail Items
13.4 Summary Information
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13.1  Structure of the Database

Opening the Database

As with all other databases, to open an Equipment Rates Database either click on

the File Open button on the Tool bar   or select the Open choice from the File
menu.  If you have a Project, Assemblies, or Crews database already open, then

the Open Equipment button  is also available.  Any of these three actions
accesses the Open Database dialog box.

In the Open Database dialog box, click on the List Files of Type pulldown and
select Equipment (this is already selected when using the Open Equipment
button).  You can also change the drive and directory of where to locate the
database.  Click on the desired database in the window, and click OK.

Hint If the database you desire to open is one of the last four projects or
databases you accessed, then it is displayed at the bottom of the file menu
and can be opened directly by choosing it.

3-Panel Display

The 3-Panel display, as in Figure 13.1, is similar to the displays for the Project
and other Supporting Databases.
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Figure 13.1 The Equipment Rates Database

The upper left panel is the Outline Panel, displaying the database structure.  A title
with a Plus symbol  has further titles underneath it which can be displayed by

clicking on the symbol.  The Page Leaf  symbol indicates that there are detail
equipment items beneath the title which are displayed when the Grid Panel is

open.  To the right of the title description is a column for the Notes indicator ,
designating when a title has notes attached.

The upper right panel is the Notes/Reference Panel.  Here you can edit or add
notes on detail or title items.

The lower panel is the Grid Panel displaying either titles or detail items,
depending on what is highlighted in the Outline Panel.  Use the horizontal scroll

bar to view the columns off the right side of the screen.  The Freeze button 
locks the column to the left of the cursor so that it does not scroll off the left side

of the screen.  The Previous/Next buttons  move the Grid Panel view up or
down to the next title in the Outline Panel.

Title Levels

The title levels are used to organize the different types of equipment into
alphabetical categories.  As in the Labor Rates Database, user created equipment
items are generally added under level one title Z, and are further categorized by
project or division under a level two title, making them easy to find and review.
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Detail Level

The detail level items contain the calculated equipment costs.  Detail items are

displayed in the Grid Panel when the Outline Panel Selection Indicator  is next

to a title that contains detail, indicated by the Leaf symbol .

Use the scroll bar to view the equipment cost columns in the Grid Panel.  To view
detailed information about each equipment item, click on that item and then click

on the Item Form  or select Item Form from the View Menu.  Edit values as
needed.  The Next button moves the focus to the next equipment item in the Grid
Panel.  You may also move the focus to the Previous equipment item.
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13.2  Title Levels

Where to Add Titles

You might add titles to an Equipment Rates Database in order to create new
classifications of equipment or to subdivide existing classifications.  For example,
you might want to add a category N for Non-powered Equipment.

If you create a new (empty) Equipment Database, you will need to add titles to
create the breakdown structure.

How to Add Titles

Titles are added in the Grid Panel.  If you adding to an existing list of titles,
position the cursor on the parent title in the Outline Panel so that the list of titles

you are adding to is displayed in the Grid Panel.  Press the Add Item icon  or
select Add a New Record from the Edit menu.  A new line for the new title is
added in the Grid Panel.  Edit the Title ID and Description as desired.

If no titles or detail cost items currently exist under a parent, then the Grid Panel

will be empty.  When you select Add New Record  , the message “Which type
of items do you wish to add” is displayed.  Select the Subtitle button and the new
title is added in the grid.

You may also add notes to describe the use of the title category.  After notes are

added, the notes indicator  is displayed in the Outline Panel and a “Yes” is
displayed in the notes column of the Grid Panel.

Field Descriptions

Equipment Title ID The database ID of the title.  Choose an ID to place the title
logically in the database.

Name Description of the equipment category.

Notes This column displays “Yes” when notes have been added to the
title.
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13.3  Equipment Rate Detail Items

How to Add or Edit Detail Items

You can add or edit equipment rate items as your project needs dictate.

To edit an existing item, highlight the item in the Grid Panel and press the Item

Form button  or select Item Form from the View menu.

To add a new detail item, highlight the parent title in the Outline Panel and press

the Add New Record button  or select Add New Record from the Edit Menu.
If no items exist in the Grid Panel the message “Which type of items do you wish
to add?” is displayed.  Select the Detail button and the Detail Item Form is
opened.  Enter the required data in the fields (see the following section for field
descriptions) and press Close when finished.

How Costs Are Computed

The fields in the Equipment Rates Database store information used to compute
hourly ownership (as opposed to rental) costs for construction equipment.  The
computations are specifically designed to support U.S. Army Corps of Engineers
estimating procedures.

For the purposes of the computations, equipment costs are divided into ownership
and operating costs.

• Ownership costs are subdivided into Depreciation and Facility Capital Cost of
Money (FCCM).

• Operating costs are subdivided into the following:

- Fuel Expense
- Filters, oil, and grease (FOG)
- Equipment Repair
- Tire Wear
- Tire Repair

For each equipment item, MCACES maintains figures for each of these costs for
average operating conditions.  Where appropriate, a second set of figures is also
maintained for severe conditions.  The program totals these component figures to
calculate total hourly rates (both average and severe), which are called the single-
shift rates.  A standby rate is also computed automatically.

Working With Equipment Costs

MCACES uses data tables provided by the Army Corps of Engineers for
computing equipment costs.  These data tables, and instructions for their use, are
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published annually as Engineering Pamphlet (EP)-1110-1-8 by the Walla Walla
District of the Corps of Engineers.

When adding or editing equipment items, you enter information about the
equipment purchase price and operating costs.  MCACES uses this information in
combination with the Corps data tables to compute the component costs, which
are displayed on the Item Form.

Note: When adding new items, you do not have to use the data tables.  If you do
not enter an Equipment ID and Subcategory Code that conform to the EP-
1110 listing, the rate categories such as depreciation become accessible to
the cursor.

Detail Item Form

The Item Form for detail items is shown in Figure 13.2.  It contains 3 tabs for the
display of pertinent data.  The General Tab contains the equipment cost summary
based on data in the Ownership and Operating tabs.  Click on the tab at the top of
the form to move from window to window.

Figure 13.2: Detail Item Form, Equipment Rates Database
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Field Descriptions

The following fields are displayed on the Detail Item Form.  Some of these fields
are also displayed in the Grid Panel however Description and Quantity are the
only fields you can edit.

General Tab

Equipment ID up to 10 characters which uniquely identifies the item in
the database and places it beneath its title.
Note:  If you are using the Corps of Engineers' data
tables, the Database ID must conform to the following
rules:
-Characters 1- 3 must match the item's category as
defined in EP1110-1-8, Appendix D.
-Characters 4 -5 are the manufacturer code.
-Remaining characters represent a unique ID.

Model Model number of the equipment.  For information
purposes only; not used in calculations.

Description Description of the equipment.  Can be extended by
using the Notes (F7) feature.

Subcat The Subcategory is used in combination with the item's
category to reference Appendix D of EP1110-1-8.
When adding an item, refer to Appendix D for the
correct subcategory.  Or you can refer to another
MCACES Item Form for a similar piece of equipment.

Econ. Key The Economic Key is copied from Appendix D for the
item and is displayed in the window for your
information.  MCACES uses the Economic Key to
reference Appendix E of the EP1110-1-8.

Note: The Subcategory and Economic Key fields are only
needed if you use the Corps' computation method.

Source These 3 characters indicate the Source of the item.  The
program assigns USR for user-created items.  Databases
furnished with the program use MIL for military
building construction, CIV for civil works, and other
abbreviations.

Units The unit of time used to calculate the equipment rate.
Usually hours (HR), though other time units are
allowed.  Refer to Appendix E of this manual for valid
units.
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Depreciation (A) Depreciation allowance.  Equal to the price of the
equipment as depreciated per the unit of measure over
the expected life of the equipment.

Facilities Capital Cost of Money (B) The cost of financing the equipment,
including interest and any loan fees, as prorated over
the expected life of the equipment.

Ownership (C=A+B) Sum of the ownership costs.

Operating Exp (D) Sum of the operating from the Operating Tab.

Single Shift Rate (C+D) Sum of ownership and operating costs.  This is the total
unit rate of the equipment item as used in the Project
Database or other database, for either average or severe
conditions.

Standby Rate (1/2A+B) Rate for keeping the equipment on standby for a
project.  Equal to 1/2 of the Depreciation cost plus the
Cost of Capital.

Note: There is no separate standby rate for severe conditions, since the standby
rate is considered to be the same regardless of conditions.

Ownership Tab

Equipment ID same as the ID on the General Tab which uniquely
identifies the item in the database.

Model Same as the Model number on the General Tab.

Description Description of the equipment; same as on the General
Tab.

Default Rate Average-condition single-shift rate as originally
supplied with the database.

Updated The program automatically fills in the system date when
the item was last changed in the database.  For a new
item, the date created.

Purchase Year Year of purchase.  Used to access the Corps data tables
in order to figure the Depreciation cost.

List Price The list price of the equipment,.

Actual Price The actual price including sales tax & delivery.

Shipping Weight Shipping weight of the equipment in hundredweight.

Note:  If you do not know the Actual Price, and you are
using the Corps' computation method, you can calculate
an Actual Price by entering values in the Shipping
Weight and List Price fields.
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Depreciation (A) Depreciation allowance.  Equal to the price of the
equipment as depreciated per the unit of measure over
the expected life of the equipment.

Facilities Capital Cost of Money (B) The cost of financing the equipment,
including interest and any loan fees, as prorated over
the expected life of the equipment.

Total Ownership Rate (C=A+B) Sum of the ownership costs.

Operators 1 and 2 Database IDs of 1 or 2 labor rate items in the Labor
Rates Database which represent operators of this
equipment.

Note:  See "Copying of Linked Items," below.

Attachments 1 and 2 Database IDs of 1 or 2 other items in the Equipment
Rates Database which represent attachments to this
equipment.

Note:  See "Copying of Linked Items," below.

Operating Tab

Equipment ID same as the ID on the General Tab which uniquely
identifies the item in the database.

Model Same as the Model number on the General Tab.

Description Description of the equipment; same as on the General Tab.

Fuel Type Type of fuel used by the main equipment engine and, if applicable,
the carrier.  Choices are:

• None
• Air
• Gas
• Electric
• On-Road Diesel
• Diesel Off-Road

Size Horse power rating of the operating portion of the equipment and,
if applicable, of the carrier portion.  (Equipment items with a fuel
type of "Air" are rated in CFM, all others in HP.)

Note:  In the Corps' computation method, the fuel type and size are
used to calculate the Fuel costs shown on the Item Form.
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Tire Type Types of tires required by the front, drive, and trailing parts of the
equipment (where applicable).  Tire type codes are:

A None
B Bias Off-Highway E4, L4, L5
C All Other Bias Ply
D Radial Off-Highway RL4
E All Other Radial

Tire Cost Present-year cost of tires for the front, drive, and trailing parts of
the equipment, as applicable.  (This is the total, not unit, cost.)

Note:  In the Corps' computation method, the above fields are used
to calculate the Depreciation, Equipment Repair, Tire Wear, and
Tire Repair fields.

FOG Extra Extra amount added to the cost of Fuel, Oil, and Grease.  The FOG
amount shown in the Item Form is based mainly on fuel costs.  The
FOG Extra field can be used to add an extra amount for those types
of equipment (such as chainsaws) that use significantly more oil or
grease than fuel.

Total The Total field shows the total operating cost.

Copying of Linked Items

As discussed above, an equipment rate item can have one or two linked labor rate
items and equipment rate items.

• Linked labor rate items represent operators of the equipment.

• Linked equipment rate items represent attachments to the equipment.  For
example, an item for a bulldozer might have a blade defined as an attachment
item.

When you copy an item from the Equipment Rates to another database, MCACES
prompts you to specify whether any linked laborers or attachments should also be
copied.  If you enter Y to confirm, MCACES will automatically copy the linked
items and place them beneath the same title as the equipment item you are
copying.
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13.4  Summary Information

To edit overall Equipment Rates Database information such as the database
description, unit of currency, area factors, or freight tables, click on the Summary

Information button  or select Summary Information from the File Menu with
the Equipment Rates Database active.  Displayed is a 3 tab Summary Information
dialog box (figure 13.3).

To add a new Equipment Rates Database, click on the New button  or select
New... from the File Menu.  After entering the new database ID and clicking OK,
the Summary Information screen is displayed.

Click on the tabs at the top of the box to move from window to window.  When
you have finished viewing or editing information click OK.  Click Cancel to exit
the dialog box without saving changes.

Fi

Figure 13.3  Summary Information Screen
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Field Descriptions

General Tab

When you open the Summary Information dialog box, the current database
description, database ID, and directory path are displayed.  You may edit any of
the additional fields.

Name Descriptive name of the database.

Issue Date Effective Date of Issue of the Equipment Rates
Database..

Currency Symbol Symbol to be displayed in monetary fields.  Up to three
characters can be used to abbreviate the currency, such
as DM for Deutsche marks or YEN for yen.

Currency Description Name of the currency.

Currency Units Units for storing monetary values and displaying them
on screen.  Options are:
O - Ones
T - Tens
H - Hundreds
M - Thousands
X - Tens of thousands

Currency Units/US $ Ratio of the currency to one U.S. dollar.

Examples:

If you are working with Japanese yen and the exchange
rate is 135 yen per dollar, you will enter 135 in the
Units per U.S. dollar field.

If you are working with Kuwaiti dinars and the
exchange rate is 3.40 dollars per dinar, you would enter
0.29 (1/3.40) in the Units per U.S. Dollar field.

Area Factors Tab

Area Factors are based upon Appendix B, EP 1110-1-8.

State Sales or Import Tax Rate Percentage of tax applied to the purchase
price of the equipment.  Used by MCACES
to figure the Actual Cost.

Working Hours per Year Average yearly operating hours for
equipment.  Used in the calculation of the
Cost of Capital.

Labor Adjustment Factor (LAF) Area adjustment factor for labor.  Used in
the calculation of Repair costs.
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Electricity Cost Per KWH Cost of electricity in the area.  Used in the
fuel cost calculations for electrical
equipment.

Gasoline Cost Per Gallon Cost of gasoline in the area.  Used in the fuel
cost calculations for gasoline-driven
equipment.

Diesel Cost per Gallon (On Road) Area cost per gallon for on-road diesel fuel.

Diesel Cost per Gallon (Off Road) Area cost per gallon for off-road diesel fuel.

Cost-of-Money Rate (Full Rate) Average interest rate on borrowed money in
the area.  Used as the basis for deriving the
discounted Cost-of-Money Rate in the next
field.

Cost-of-Money Rate (Adjusted) Average interest rate on borrowed money in
the area as discounted for calculation.  Used
for calculating the Cost of Capital.  This
value is computed by the program based on
the current Cost of Money entered in the
previous field.

Note: The current cost of capital is discounted to avoid duplication when
applying markups for contractor overhead and profit.

The Database Default column to the right shows the original field values
when the database was released.

Freight Rate Tab

Freight Rates These fields show the average cost of shipping equipment in the
region per unit of measure, for each weight class shown.

UOM Unit of Measure, generally per CWT (costs per hundredweight).

Note: These rates are used in combination with the Shipping Weight field
for calculating the Actual Price of each equipment item.
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Chapter  14

The Assemblies Database

Introduction

The Assemblies Database stores groupings of cost items representing all the costs
required to create a larger piece of a project.  The individual cost items within
each assembly are usually copied from the Unit Price Database.  However, the
items may also be copied from the Labor or Equipment Rates Database, or they
may be user-created.

Using assemblies can greatly reduce the amount of data entry required to build a
project.

Example of Use

An assembly representing 6-inch concrete slab on grade includes all the cost items
required to prepare for, form, pour, and finish the slab.  The assembly unit of
measure is square feet.  The Assemblies Database stores the unit costs (Labor,
Equipment, Material, and Total) and quantities of each item required to construct
one square foot of slab.

When you copy this assembly into the Project Database, you supply the square
feet of slab needed for your estimate.  MCACES then computes the total
quantities and resulting costs of all items required for slab on grade construction.

Supplied Databases

The ASM94A Assemblies Database supplied with MCACES contains
approximately 2500 separate building assemblies drawn from Tri-Services data,
and presented by building systems classification.

The CWSA95 Civil Works Smart Assemblies Database contains 29 civil works
(sitework) oriented assemblies.

Building Systems Classification

The ASM95A Assemblies Database is broken down according to the building
systems hierarchy used by the Tri-Services.  This breakdown scheme closely
follows the UNIFORMAT system which is widely used in private and
government organizations.

The building systems classification organizes construction costs according to
function, such as substructure, roofing, and so on.  This allows the use of data to
estimate costs by function during planning and early design, before the detailed
identification of materials.
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This systems approach contrasts with the CSI classification scheme used in the
Unit Price Database, which organizes cost items by material and labor type.  The
CSI approach more closely resembles the way building construction is actually
purchased and accounted for by a contractor.  In MCACES, the CSI approach
provides detailed backup to the systems estimating method.

In This Chapter

The following sections are included in this chapter:

14.1 Structure of the Database
14.2 Assemblies Titles
14.3 Assemblies Detail Items
14.4 Detailless Assemblies
14.5 Summary Information
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14.1  Structure of the Database

Opening the Database

As with all other databases, to open an Assemblies Database either click on the

File Open button on the Tool bar   or select the Open choice from the File
menu.  If you have a Project database already open, then the Open Assemblies

button  is also available.  Any of these three actions accesses the Open
Database dialog box.

In the Open Database dialog box, click on the List Files of Type pulldown and
select Assemblies (this is already selected when using the Open Assemblies
button).  You can also change the drive and directory of where to locate the
database.  Click on the desired database in the window, and click OK.

Hint: If the database you desire to open is one of the last four projects or
databases you accessed, then it is displayed at the bottom of the file menu
and can be opened directly by choosing it.

3-Panel Display

The 3-Panel display, as in Figure 14.1, is similar to the displays for the Project
and other Supporting Databases.
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Figure 12.1 The Assemblies Database

The upper left panel is the Outline Panel, displaying the database structure.  A title
with a Plus symbol  has further titles underneath it which can be displayed by

clicking on the symbol.  The Page Leaf symbol  indicates that there are detail
labor items beneath the title which are displayed when the Grid Panel is open.  To

the right of the title description is a column for the Notes indicator  ,
designating when a title has notes attached.

The upper right panel is the Notes/Reference Panel.  Here you can edit or add
notes on detail or title items.

The lower panel is the Grid Panel displaying either titles or detail items,
depending on what is highlighted in the Outline Panel.  Use the horizontal scroll

bar to view the columns off the right side of the screen.  The Freeze button 
locks the column to the left of the cursor so that it does not scroll off the left side

of the screen.  The Previous/Next buttons  move the Grid Panel view up or
down to the next title in the Outline Panel.
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Title Levels

The Level 1 titles in the ASM95A Assemblies database represent the 16 building
systems in the original CACES classification scheme used by the Army Corps of
Engineers.  The first two digits of each title's database ID is also referred to as its
system code.

Subsequent title levels represent further breakdown of the data under each system
classification.

Assembly Level

Assemblies are defined as titles at the lowest title level, just above the detail cost
items.  As each level is expanded in the Outline Panel, the assembly description
becomes more detailed until the Assembly Level (lowest level) is reached,

indicated by the Page Leaf symbol  marking that there are detail cost items
beneath.  In the supplied database, this is either Level 4 or 5, depending on the
breakdown in different areas.

Detail Level

Beneath each assembly title, the individual detail cost items that represent the
pieces of construction needed to make up the assembly are listed.  Detail items are

displayed in the Grid Panel when the Outline Panel Selection Indicator  is next

to a title that contains detail, indicated by the Page Leaf symbol .

Use the scroll bar to view the cost columns off the right side of the screen.  You
may edit some of the cost columns by clicking in the field and typing a new entry.

To view each cost item individually, click on the Item Form  or select Item
Form from the View Menu.
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14.2  Title Levels

Where to Add Titles

In order to add a new assembly you will always need to add a title at the Assembly
Level first.

How to Add Titles

Titles are added at the level displayed in the Grid Panel.  If you adding to an
existing list of titles, position the cursor on the parent title in the Outline Panel so
that the list of titles you are adding to is displayed in the Grid Panel.  Press the

Add Item icon  or select Add a New Record from the Edit menu.  An
Assembly Title Item Form is opened.

If no titles or detail cost items currently exist under a parent, then the Grid Panel

will be empty.  When you select Add New Record  , the message “Which type
of items do you wish to add” is displayed.  Select the Subtitle button and Item
Form is opened.

Enter the Assembly ID and description.  The assembly level quantity is generally
1 of a unit of measure.  This is because when the assembly is copied into an
estimate, it will be multiplied by the quantity of the item in the estimate.

It is desirable that you would also add enough notes to describe the use of the

assembly and it’s components.  After notes are added, the notes indicator  is
displayed in the Outline Panel and a “Yes” is displayed in the notes column of the
Grid Panel.

Field Descriptions

ID The database ID of the title.  Choose an ID to place the title
logically in the database.

Description Description of the assembly.

Quantity The quantity applied to the title.  In the Assemblies Database
this field is normally 1.

Unit of Measure The unit of measure applied to the title.

Note: The other fields are not used in the Assemblies Database.
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14.3  Assembly Detail Items

How to Add or Edit Detail Items

Once you have created an Assembly Title, you will need to add detail cost items.
These are generally items from the Unit Price Database, however the items may
also be copied from the Labor or Equipment Rates Database.

To add a new detail item, highlight the parent title in the Outline Panel and press

the Add New Record button  or select Add New Record from the Edit Menu.
If no items exist in the Grid Panel the message “Which type of items do you wish
to add” is displayed.  Select the Detail button and the Detail Item Form is opened.
Enter the required data in the fields (see the following section for field
descriptions) and press Close when finished.

Detail Item Form

The Item Form for detail items is shown in Figure 14.2

Figure 14.2: Detail Item Form, Assemblies Database
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Field Descriptions

It is necessary to fill out the following fields to create an assembly.  The other
fields may already be filled out if you are copying a cost item from the UPB, or
you may fill them out yourself if it is a USR created item.  See section x.xx for
full field descriptions.

Source Displayed in Grid only.  The program assigns USR for user-
created items.  Databases furnished with the program use MIL
for military building construction, CIV for civil works, and
other abbreviations.

WBS ID The ID of the items location in the Assemblies Database.  This
ID is made up of the ID’s of the upper level titles and a unique
ID assigned by the software, incremented by 5 each time an
new item is opened.

Database ID The ID of the cost item if copied from a Supporting Database.
Optional for user (USR) created items.

Description Name of the cost item.  This is filled in automatically when the
item is copied from another database.

Quantity The quantity of the cost item in relation to the assembly
quantity.

Units of Measure.  Units of the cost item.  This does not have to be
the same units as the assembly itself.

Unit Costs The unit cost of the labor, equipment, and material for the cost
item.  This is filled in automatically when the item is copied
from a Supporting Database.



The Assemblies Database 14-9

14.5  Summary Information

To edit overall Assemblies Database information such as the measurement units

or currency, click on the Summary Information button  or select Summary
Information from the File Menu with the Assemblies Database active.  Displayed
is a 2 tab Summary Information dialog box (Figure 14.3).

To add a new Assembly Rates Database, click on the New button  or select
New... from the File Menu.  After entering the new database ID and clicking OK,
the Summary Information screen is displayed.

Figure 14.3  Summary Information Screen, Assemblies Database

Click on the tabs at the top of the dialog box to move from the General Tab to the
Database References Tab.  When you have finished viewing or editing
information, click OK to close the window.  Click Cancel to exit without saving
changes.
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Field Descriptions

When the Summary Information dialog box is opened, the current database
description, directory path, and database ID are displayed.  You can edit the
following fields.

General Tab

Name Descriptive name of the database.

Measurement Unit of measure to be used for storage of the data and
display on screen.  Options are:
- Original Units
- U.S. Units
- Metric Units

Currency Description Name of the currency.

Currency Units Units for storing monetary values and displaying them
on screen.  Options are:
Ones
Tens
Hundreds
Thousands
Tens of thousands

Currency Units/US $ Ratio of the currency to one U.S. dollar.

Examples:

If you are working with Japanese yen and the exchange
rate is 135 yen per dollar, enter 135 in the Units per
U.S. dollar field.

If you are working with Kuwaiti dinars and the
exchange rate is 3.40 dollars per dinar, enter 0.29
(1/3.40 = 0.29) in the Units per U.S. Dollar field.

Database References Tab

Labor The name, ID, and path of the Labor Rates Database
used to price the current Assemblies Database.

Equipment The name, ID, and path of the Equipment Rates
Database used to price the current Assemblies
Database.
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Crews The name, ID, and path of the Crews Database used to
price the current Assemblies Database.

UPB The name, ID, and path of the Unit Price Book
Database used to price the current Assemblies
Database.

Reprice Use this button to access the Update All Pricing dialog
box which allows the selection of repricing of Labor
and Equipment and/or Material costs, and the selection
of different supporting databases for repricing.

Press the OK button to save the changes and exit the dialog box, or press Cancel
to return to the original entries without saving changes.
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Chapter 15

Working with Reports

Introduction

MCACES provides extensive and flexible reporting capabilities.  You can use
these capabilities to produce detailed estimates and a wide range of summary and
backup reports for the projects created in MCACES.  You can also print listings
of the contents of the supporting databases.  Reports can be sent to any available
Windows printer or to a disk file.  A Print Preview feature allows you to review
the report results on-screen as they would appear when printed.

In This Chapter

This chapter provides information on all setup and reporting options available in
MCACES.  The following sections are included:

15.1  Steps in Creating a Report
15.2  Report Setup
15.3  Print Setup
15.4  Print Preview
15.5  Print
15.6  Report Examples
15.7  Database Listings
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15.1   Steps in Creating a Report

This section summarizes the steps necessary to create reports in MCACES.

1. Create a project with the appropriate information columns and the title levels
required.  See chapter 5 for further information.

 Note: Printing a report automatically recalculates the project costs.  You do not
have to perform a separate recalculation of the project before running reports.

2. Select the setup options desired by using the Report Setup selection from the
File Menu.  See section 15.2 for detailed information.

3. Use the Print Setup selection from the file menu to choose the appropriate
printer and printer options.  See section 15.3

4. Optionally perform a Print Preview, if desired, to see what the output will
look like.  The project will be recalculated prior to display of the report on
your monitor.  See section 15.4.

5. Print the report from the Print option on the File Menu.  See section 15.5.

Hint: Once the Report Setup and Print Setup information have been configured as

desired for a specific project, simply clicking the Print button  at any time is
sufficient to create a new report.
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15.2   Report Setup

The MCACES Report Setup function is a selection on the File Menu.  This
command displays a tabbed dialog box which provides easy access to the various
setup options. Clicking on each tab will bring the information on that tab to the
front for view and input.  See Figure 15.1.

Figure 15.1 Select Reports Tab

Select Reports Tab

The Select Reports Tab contains options which enable you to easily choose from
among the many report types available in MCACES.  You can click on any option
desired in the appropriate box.  Each of the options will be discussed in this
section.

Print Direct Cost Detail Report

Choosing Print Direct Cost Detail Report will provide a complete listing of an
entire project.  The Detail Report shows each cost item and title in the project and
lists its Direct Costs.  The exact content and formatting of this report is
determined on the Format Detail Tab, discussed below.
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Select Project Summary Reports

This section provides options for reports which summarize cost information.
Project summaries and contractor summaries can be shown, as well as division
and system summaries.  Backup reports can also be selected for crew, labor and
equipment types.

Project summary reports summarize cost information for an estimate. You can
produce project summary reports that break down the estimate by Project Direct,
Indirect, and Owner Costs.  On all of these reports, you can show the cost
breakdown to whatever title level you choose.

Contractor summary reports list the costs associated with each contractor in an
estimate.  Reports are available for Project Direct and Indirect Costs, and can be
generated for the detail level and any title level in the report.

Backup reports provide additional information about a project by showing the
utilization of crews, labor, and equipment.  You can produce a Crew Detail
Backup Report as well as summary reports for crews, labor items, and equipment
items at any title level.  To generate backup reports, the Estimate Type must be
set to either A (Crews with Auto Reprice) or C (CACES Mode).

The Crew Summary Report lists for each title, the crew ID, description,
productivity value, and the total hours worked by the crew in the particular project
element represented by the title.

The Labor Backup Report lists labor cost items used in the project.  These items
are crew members belonging to crews used by project items.  The labor items are
stored as individual detail items in the Labor Rates Database.  For each labor
item, the report shows the detail information stored in the Labor Rates Database,
including Base Rate, Overtime, Taxes and Insurance, etc.  The report also lists the
number of hours each labor item is used.

The Equipment Backup Report lists the equipment items in the estimate.  These
items are the equipment crew members used by project cost items and stored in
the Equipment Rates Database.  For each item, the report shows detailed
information from the Equipment Rates Database as well as the total number of
hours each item is used.

Select Other Reports

Other Reports can be chosen from this selection as follows:

Print Second View Report - Select this option to print a report showing project
costs rearranged according to a 2nd View alternative title structure.  The report
can also be used to show comparisons of two or more projects.  You must produce
a 2nd View Report in order to automatically generate a 2nd View title structure
for a project.
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Note: Before running this report, you must first define the 2nd View breakdown
structure, columns, and exceptions options.  This definition is an advanced feature
currently available only in the MCACES GOLD (DOS version) software.

Project Owner/OT & Settings - Select this option to print a report showing all
option settings made for the project.  This report also shows the hierarchy of all
project titles and all settings for Owner Costs and Overtime.

Contractor Settings Report - Select this option to print a report showing all
settings made for contractors.

Link Listing Report - Select this option to print a report showing quantity links
and parameter worksheets within a project.

Labor Cost to Prime Report - Select this option to print a report listing labor cost
items used in the estimate.  These items are crew members in the crew database
belonging to crews used by project detail items, or individual project detail items
that have Labor/Equipment type defined as Laborer, Foreman, or Apprentice.
Under each selected project title, the report lists for each Labor ID type: the Labor
ID from the Labor rates database, the Labor ID description, the Labor type
(Laborer, Foreman or Apprentice), the number of hours this ID is called for under
this title, the database rate, the extended amount of the hours times the database
rate, the Cost-to-Prime extended amount (which includes Overtime, Adjust
Pricing, and Subcontractor Markups), and the cost-to-prime rate derived by
dividing the amount by the hours.

The Cost Summary Level

Profit Guidelines Report - Select this option to print a report for each contractor
that uses the Compute method to calculate the profit.  This report will display the
weights attached to each risk factor, as well as any notes attached.

Print Contingency Notes - Select this option to print Contingency Notes attached
to specific Owner Costs.  The Notes are printed at the head of the Owner
Summary Report.  Also, a column is displayed in that report which indicates
contingency note numbers, assigned for individual elements.

Load and Save Setup

The Load Setup button is used to load report settings that have been stored for a
particular project or kind of formatting.  The Save Setup button is used to store
report format and selections for later retrieval.
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Calculation Tab

The Calculation Tab is used to set various options which affect the way in which
the calculations are performed for during generation of reports. Each of the
options will be discussed in this section.  Figure 15.2 shows an example
Calculation Tab.

Figure 15.2 Calculation Tab Dialog Box

Estimate Type

The Estimate Type selection controls whether labor and equipment pricing
depend on the Crews Database, and whether to reprice crew-dependent labor and
equipment items automatically, using current Labor and Equipment Rates
Databases, each time reports are run.  Click on the down arrow to the right of the
box, and click on the selection.

This option is also available in the Summary Info dialog box.  See Section 5.4 for
additional details.
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Database References

The Database References section shows which supporting databases were last
used for repricing.  If the file or path for each of the four supporting database used
is still valid, the Database ID of each is displayed, otherwise the message
“Database Not Found or Unavailable” is displayed.

Reset References

The Reset References button brings up the Reprice dialog box.  See section 8.3
for further information.

Set Reporting Units

Click on a selection to determine the units of measurement used in quantity fields.
Options are:

• Original - the units originally entered in the estimate

• U.S.

• Metric

 Set Summaries Format

 This section includes various formatting options for summary reports.

 Round Reports - provides a pull-down list to indicate the degree of rounding to be
used on the summary reports.  The rounding affects only how the costs are
printed, not the way they are calculated or stored by the program.  Codes are:

 No rounding  Costs are not rounded (default)

 Tens  Costs are rounded to the nearest ten

 Hundreds  Costs are rounded to the nearest hundred.

 Thousands  Costs are rounded to the nearest thousand.

 Report in 1,000’s  Costs are rounded to the nearest thousand and
expressed in thousands.  For example, 10,875 would
be printed as 11.

 

 Display Markups As - provides a way to determine whether the summary totals
line of Indirect and Owner cost markups also include each markup’s unit cost or
the percentage of the running total of costs which that markup represents.  If
Percent of Total is chosen, the percentage printed for each markup is the
computed percentage (for all contractors) of the running total up to that markup.

 Note: This computed percentage is not necessarily the same as the running
percent that you might enter for a single contractor on a Contractor Entry Screen.
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 Options are:

• Unit Costs Only

• Percent of Total

• Do Not Display (Do not print unit costs or percentages)

 Print Grand Totals - check to include the printing of grand totals.

 First Alternate ID - the ID entered in this field will be the title selected as an
Alternate or Additive.  You have the capability to designate certain level one titles
as Alternates or Additives.  These titles will not be included in the total project
cost when printing a Level One Project Summary report.  They will be listed at
the bottom of the report under the title ALTERNATES.

 Show Markup at Level - provides a way to show Indirect and Owner markups at a
particular level, rather than at the project level, in summary reports.  This means
that if the “Show Markup at Level” is set to “1”, and you select a level 2 report,
the level 2 titles will be displayed and then the total of the level 1 title will be
displayed, followed by the markups for that one title.  Each level one title will be
followed by the markups for that title.

 The Print button on the bottom of this screen provides a shortcut to printing
reports, while the Preview button provides a shortcut to generating a print preview
of the report (see section 15.5).  The Setup button provides a shortcut to Printer
Setup (see section 15.4).
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 Format Columns Tab

 The Format Columns Tab is used to determine the characteristics of columns
when reports are printed.  Figure 15.3 shows an example Report Formats Tab.

 

 

 Figure 15.3 Format Columns Dialog Box

 Direct Costs

 Up to five direct cost columns can be specified for reports.  For each of the five
types of fields (Manhours, Labor, Equipment, Material, and User Named), you
can specify the column title and width.

 Indirect Costs

 Up to five indirect cost columns can be specified.  For each of the five types of
fields (Overhead, User Named, Profit, Bond, and Unused), you can specify the
column title, description and width.

 Owner Costs

 Up to five owner cost columns can be specified.  For each of the five types of
fields (Escalation, Contingency, User Named, Unused, and Unused), you can
specify the column title, description and width.
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 Other Column Widths

 Other column widths can be chosen for Quantity, Unit Cost and Total Cost.

 Note: A spin button  can be used to modify width value for the currently
selected column.  By clicking on the up or down arrow, you raise or lower the
value displayed.
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 Format Detail Tab

 The Format Detail Tab allows you to define the page format for the Detail Report.
This includes information on where subtotals are printed, and whether titles,
notes, and unit costs are shown.  Figure 15.4 shows an example Format Detail
Tab.

 Note: Depending on the printer characteristics selected, there may not be enough
horizontal space on the page to print all of the information you want to include.  If
necessary, the cost codes will be removed and the item description may be
truncated to make the information fit on one line.

 

 

 Figure 15.4 Format Detail Dialog Box

 Select Lines to Print

 This section allows you to choose each title level for which you want titles, totals,
and notes printed.

 UPB Titles

 This section allows you to choose to print one or more levels of UPB titles above
the detail item, for each detail item brought in from the Unit Price Database.  You
can also choose the characters to use as brackets around the UPB titles (for
improved visibility), and whether to print Notes attached to UPB titles.
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 Print Detail Columns

 This section contains options for detail item printing.  You may choose whether to
show a cost codes column (UPB Ids), a Crew Id and/or output column for each
item that references the Crews database, and a column that contains the calculated
unit cost for each title and detail item.

 Page Format

 The Page Format section contains options which determine characteristics of
pages on detail reports.  You may choose to print a table of contents and select the
number of levels to print.  You may choose to print a unit cost row and a page
footer, as well as setting page breaks to occur after a selected level.
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 Material Backup Tab

 The Material Backup Tab allows you to set up the Material Backup and Vendor
Backup Reports.  Figure 15.5 shows an example Format Detail Tab.

 

 

 Figure 15.5 Material Backup Tab Dialog Box

 

 Type of Report

 The type of report is used to select either the Material Backup Report or the
Vendor Backup Report for printing.

 Report Header

 A report description of up to 96 characters can be entered in this field and will be
printed in the header of each page of the report.

 Date Filter

 The date filter is used to include or exclude data based on specified dates.  You
can also choose to use no date filter and thus print all entries.

 ID’s Filter

 The ID’s Filter section allows you to select data for specific vendors or UPB Ids.
Leave the fields blank to include all entries.
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 Sources Filter

 The Sources Filter is used to include or exclude data based on specified sources.
You can also choose to use no source filter and thus print all entries.
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 15.3   Print Setup

 The Print Setup Dialog Box allows you to select the particular printer to be used
for generating reports.  Options such as the orientation and size of the page may
be selected.  Print Setup may be accessed from the Print Setup selection on the
File Menu. Figure 15.6 shows an example Print Setup dialog box.

 

 

 Figure 15.6 Print Setup Dialog Box
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 The following are Print Setup options:

 

 Printer  Within the Printer section, you can select the
Windows default printer or another printer which has
been installed on your copy of Windows.

 Orientation  The Orientation section allows you to choose
between portrait or landscape modes for printing
your report.  Be aware of the column limitations for
MCACES reports when choosing portrait orientation.

 Paper  The Paper section allows you to choose between the
paper size and source (tray) from which your report
will be printed.  The options will vary depending
upon the printer chosen.

 Options  The Options button provides additional setup
features for the particular printer selected.

 Network  The Network button is used to set up network
printers and printer queues
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 15.4   Print Preview

 Print Preview allows you to preview what your report will look without having to
send it to the printer.  The preview will reflect exactly the same selections and
options as if the report was printed.  A recalculation will take place automatically
when Print Preview is selected, to insure that all cost information is up to date.
Print Setup may be accessed from the Print Preview selection on the File menu or
the Preview button on the Report Setup dialog box.

 Figure 15.7 shows an example Print Preview screen.

 

 

 Figure 15.7 Print Preview Example

 

 Print...

 The Print... button allows you to send the report shown in the Print Preview to the
currently selected printer.

 Next Page

 The Next Page button displays the next page in sequence in the report.

 

 Prev Page

 The Prev Page button displays the previous page in sequence in the report.
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 One Page / Two Page

 This button switches between display of one or two pages.  It is only available at
the maximum Zoom Out resolution.

 Zoom In

 Increase the resolution of the preview screens, showing less area on the display.

 Zoom Out

 Decrease the resolution of the preview screens, showing more area on the display.

 Close

 Close the Print Preview screen and return to the previous display.

 Hint:  to go to any section of the report, use Zoom Out until the whole page is
visible on-screen.  Then drag the scroll bar “thumb” to the desired position in the
report.  For example, to go to the last page of the report, drag the scroll bar thumb
all the way to the bottom of the scroll bar.
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 15.5   Print

 The Print Dialog Box provides reporting options to be selected immediately prior
to printing.  Figure 15.8 shows an  example Print dialog box screen.

 

 

 Figure 15.8 Print Dialog Box
 Report Title:

 The Report Title box displays the current title selected for the report, and allows
this title to be changed as desired.

 Print Range

 The Print Range selection lets you choose between printing the entire estimate or
a selected item.  the selected item shown corresponds to the element whose title is
selected in the Outline Panel.

 Print Device

 The Print Device Selection lets you choose between three options:

• Print to Printer - print to the indicated printer.

• Print Preview - print to the screen for review.

• Print to File - Print to the indicated file. You may change the path and file ID
by typing in the selection box or using the ... button to browse and select.
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 15.6   Report Examples

 Detail Report

 The Detail Report provides a complete listing of an entire estimate.  This report
shows every cost item and title in the project and lists their Direct Costs.

 You can specify the exact content and formatting of this report by using the
Format Detail Tab, as discussed in 15.2.

 Cost Markups

 The costs in the Detail Report include the following markups:

 • Any markups specified through the Adjust Pricing Screen accessed from the
Compute Menu.

 • Sales Tax added to material, according to the amount specified on the Report
Titles Page Screen.

 • Markups for any contractors up to, but not including, the prime contractor
responsible for the work.  That is, the costs shown are the costs to the prime
contractor.

 Exception:  If you choose to print a unit cost row on the Detail Report (as in
Example 1, below), the costs shown in that row only do not include subcontractor
markups.

 These same cost markups are reflected in the summary costs shown for titles in
both the Detail Report and in Project Summary Reports.  The markups are also
included in the summary costs shown on title list and entry screens in the Project
Database (once the estimate has been recalculated).
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 Detail Report Example 1

 Figure 15.9 shows a section of the Detail Report for the DEMAIR Project.

 BSD
 International Airport Remodel - from Intermediate Construction
 DETAILED ESTIMATE  DETAIL PAGE    1
 001. BUILDING CONSTRUCTION
 -----------------------------------------------------------------------------------------------------------------------------------------------------------------------
 001-01. FOUNDATIONS QUANTITY   UOM MATERIAL LABOR OTHER TOTAL COST
 -----------------------------------------------------------------------------------------------------------------------------------------------------------------------
 
     STANDARD FOUNDATIONS
 
       SPREAD FOOTINGS
 
         WALL FOOTINGS
 
     EXCAVATION W/ 1/2CY 0.00 1.35 1.26 2.61
    481.00 CY  0  766 715 1,481
 
     TRIM BOTTOM OF EXCAVATION 0.00 0.19 0.08 0.27
  2786.00 SF 0 625 263 887
 
                 BACKFILL & COMPACT W/F.E. LOADER 0.00 2.37 1.49 3.86
    332.00 CY 0 928 584 1,512
 
       HAUL SURPLUS EXCAVATION OFF SITE 00.0 1.24 2.51 3.75
               149.00 CY   0 218 441 659
 
 FORMWORK - 3 USES 0.39 1.30 0.05 1.74
 2786.00 SF 1,266 4,273 164 5,704
 
                 4000 PSI CONCRETE PLACED BY  487694 12.72 2.12 63.53
          106.00 CY 6,089 1,591  265 7,944
 
                  #3 - #7 REINFORCEMENT GRADE 60 0.30 0.18 0.00 0.48
         4400.00 LB 1,555 934 0 2,490
 
             CURING W/BURLAP - 4 USES   0.02 0.05 0.00 0.07
                   2876.00 SF 760 164 0 235
         ---------- ---------- ---------- -----------
         WALL FOOTINGS 8,980 9,500 2,432  20,912
 
 
     ELEVATOR PIT FOOTINGS
 
         HAUL SURPLUS EXCAVATION OFF SITE 0.00 1.24 2.51  3.75
         217.00 CY 0  317 643 960
 
     FORMWORK TO EDGE - 1 USE 1.05 2.00 0.07 3.12
              811.00 SF  1,003 1,914 67 2,984

 Figure 15.9:  Sample Detail Report (Portion)

 Analysis of Example 1

 Example 1 is formatted according to the specifications entered on the Detail
Report Formatting Screen illustrated in Figure 15.9.  If you compare the two
figures, you can see the following:

 • Titles are printed at levels 3, 4, and 5 of the estimate.  (Levels 1 and 2 are not
selected since these titles are automatically printed in the headings of each
page.)

 • Totals are printed at Levels 3-6.  The total shown is for the Level 5 title, "Wall
Footings."

 • No Notes are printed on the report.

 • The Unit Cost row is printed above each cost item.  (Contrast with Example 2,
below.)

 • Cost Codes are not printed with items.
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 • No optional columns or UPB Titles are printed.

 Report Example 2

 Figure 15.10 shows the same portion of the Detail Report as is shown in Example
1.  The only difference is that the Unit Cost row is not printed with the detail
items.

 Normally, you would print the unit cost row for working versions of reports and
not print it on reports intended for presentation.

 BSD
 International Airport Remodel - from Intermediate Construction
 DETAILED ESTIMATE  DETAIL PAGE    1
 001. BUILDING CONSTRUCTION
 -----------------------------------------------------------------------------------------------------------------------------------------------------------------------
 001-01. FOUNDATIONS QUANTITY   UOM MATERIAL LABOR OTHER TOTAL COST
 -----------------------------------------------------------------------------------------------------------------------------------------------------------------------
 
     STANDARD FOUNDATIONS
 
       SPREAD FOOTINGS
 
         WALL FOOTINGS
 
     EXCAVATION W/ 1/2CY 481.00 CY  0  766 715 1,481
     TRIM BOTTOM OF EXCAVATION 2786.00 SF 0 625 263 887
 BACKFILL & COMPACT W/F.E. LOADER 332.00 CY 0 928 584 1,512
 HAUL SURPLUS EXCAVATION OFF SITE 149.00 CY   0 218 441 659
 FORMWORK - 3 USES 2786.00 SF 1,266 4,273 164 5,704
 4000 PSI CONCRETE PLACED BY 106.00 CY 6,089 1,591  265 7,944
 #3 - #7 REINFORCEMENT GRADE 60 4400.00 LB 1,555 934 0 2,490
 CURING W/BURLAP - 4 USES 2876.00 SF 760 164 0 235
         ---------- ---------- ---------- -----------
         WALL FOOTINGS 8,980 9,500 2,432  20,912
 
     ELEVATOR PIT FOOTINGS
 
 HAUL SURPLUS EXCAVATION OFF SITE 217.00 CY 0  317 643 960
 FORMWORK TO EDGE - 1 USE 811.00 SF  1,003 1,914 67 2,984

  Figure 15.10:  Sample Detail Report (Portion)
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 Project Summary Reports

 Project summary reports summarize cost information for an estimate.  You can
produce project summary reports that break down the estimate by Project Direct,
Indirect, and Owner Costs.  On all of these reports, you can show the cost
breakdown to whatever title level you choose.

 Example 3:  Project Owner Summary Report

 Report Example 3 (Figure 15.11) shows the Project Owner Cost summary section
of the report for the DEMAIR project, broken down to title Level 1.

 
 
 Thu 15 Sep 1994                                          MCACES 5.30                                         TIME 16:19:35
 Eff. Date  05/13/94    PROJECT DEMAIR:   International Airport Remodel - from Intermediate Construction
                                                  Example Renovations Estimate                                 SUMMARY PAGE    1
                                             ** PROJECT OWNER SUMMARY - Bid Item **
 
 -------------------------------------------------------------------------------------------------------------------------------
                      QUANTITY UOM    CONTRACT    ESCALATN    DSGN CNT    OTHR CNT    PRJ MGMT    IN HOUSE  TOTAL COST UNIT COST
 -------------------------------------------------------------------------------------------------------------------------------
 
 001  BUILDING CONST 371725.00 SF   28,183,102   1,583,992   2,679,038   1,297,845   2,699,518   2,186,610  38,630,105    103.92
 002  SITEWORK       371725.00 SF    3,506,453     197,075     333,318     161,474     335,866     272,051   4,806,236     12.93
 004  CONNECTOR        4966.00 SF      590,444      33,185      56,127      27,190      56,556      45,810     809,312    162.97
 005  NON-PUBLIC ARE 139945.00 SF    1,198,867      67,381     113,962      55,208     114,833      93,015   1,643,267     11.74
                                   ----------- ----------- ----------- ----------- ----------- ----------- -----------
      Air Terminal R 371725.00 SF   33,478,866   1,881,633   3,182,445   1,541,718   3,206,773   2,597,486  45,888,921    123.45
 
 

 Figure 15.11: Project Owner Summary Report

 Analysis of Example 3

 The sample Project Owner Summary Report contains the following parts:

 • The leftmost column shows the Level 1 titles defined for the DEMAIR project.
You could choose to show increasingly detailed breakdowns by entering Y for
additional title levels on the Report Selection Screen.

 • The Quantity/UOM column shows the quantity and unit of measure values as
entered on the entry screen for the Level 1 titles.

 • The Contract column indicates the sum of all Direct and Indirect Costs
attributed to each Level 1 title.  These costs are broken out in the following
two examples.

 • The next five columns are the Owner Cost columns defined for the project on
the Name Project Columns Screen.
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 • The value in the Total Cost column for each title is the sum of the preceding
six columns.

 • The Unit column shows the unit cost for each Level 1 title, figured as the Total
Cost divided by the title Quantity value.

 • The sum of the Total Cost column on the bottom row represents the total
amount of the estimate, since it includes all Direct, Indirect. and Owner Costs.

 Example 4:  Project Indirect Summary Report

 Report Example 4 (Figure 15.12) shows the Project Indirect Costs summarized at
title Level 1.

 
 
 Wed 14 Sep 1994                                          MCACES 5.30                                              TIME 15:49:50
 Eff. Date  05/13/94    PROJECT DEMAIR:   International Airport Remodel - from Intermediate Construction
                                                  Example Renovations Estimate                                 SUMMARY PAGE    1
                                            ** PROJECT INDIRECT SUMMARY - Bid Item **
 
 -------------------------------------------------------------------------------------------------------------------------------
                                  QUANTITY UOM      DIRECT    OVERHEAD    HOME OFF      PROFIT        BOND  TOTAL COST UNIT COST
 -------------------------------------------------------------------------------------------------------------------------------
 
 001  BUILDING CONSTRUCTION      371725.00 SF   22,609,026   1,865,245     978,971   1,908,993     820,867  28,183,102     75.82
 002  SITEWORK                   371725.00 SF    2,812,944     232,068     121,800     237,511     102,130   3,506,453      9.43
 004  CONNECTOR                    4966.00 SF      473,666      39,077      20,510      39,994      17,197     590,444    118.90
 005  NON-PUBLIC AREAS           139945.00 SF      961,754      79,345      41,644      81,206      34,918   1,198,867      8.57
                                               ----------- ----------- ----------- ----------- ----------- -----------
      Air Terminal Reconstructio 371725.00 SF   26,857,390   2,215,735   1,162,925   2,267,704     975,113  33,478,866     90.06
 
   Escalation Costs                                                                                          1,881,633      5.06
                                                                                                           -----------
     SUBTOTAL                                                                                               35,360,499     95.13
   Design Contingency                                                                                        3,182,445      8.56
                                                                                                           -----------
     SUBTOTAL                                                                                               38,542,944    103.69
   Phasing Contingency                                                                                       1,541,718      4.15
                                                                                                           -----------
     SUBTOTAL                                                                                               40,084,662    107.83
   Project Management Fees                                                                                   3,206,773      8.63
                                                                                                           -----------
     SUBTOTAL                                                                                               43,291,435    116.46
   Airport Authority Management                                                                              2,597,486      6.99
                                                                                                           -----------
     TOTAL INCL OWNER COSTS                                                                                 45,888,921    123.45
 
 

 

 Figure 15.12:  Project Indirect Summary Report
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 Analysis of Example 4

 The Project Indirect Summary Report for the DEMAIR project contains the
following elements:

 • Again, the leftmost column shows the Level 1 titles defined for the DEMAIR
Project.  This is again followed by a column showing the titles' Quantity and
Unit of Measure figures.

 • The Direct column indicates the sum of all Project Direct Costs for each title.
(The Direct Costs are shown in separate columns in Report Example 5.)  This
column's costs includes cost markups for subcontractors' work, as noted below.

 • The next four columns, Overhead, Home Office, Profit, and Bond, are the
Indirect Cost columns defined on the Name Project Columns Screen.  On this
report, they show the total of each cost markup for the project's prime
contractor only.  Subcontractors' markups are rolled into the Direct Costs and
are reflected in the Direct column.  (Subcontractors' markups are listed
separately in the Contractor Indirect Summary Report, described in the next
section.)

 • The Total Cost for each title is the sum of the preceding five columns.  Notice
that these costs are the same for each title as the corresponding figures in the
Contract Column in Report Example 3, since both represent the sum of Direct
and Indirect Costs.

 • As in Example 3, the Unit column shows the unit cost for each Level 1 title,
figured as the Total Cost divided by the title Quantity value.

 • Below the Total Cost column, the Project Owner Costs are added, one at a
time, and the resulting Subtotals listed.  Notice that the labels for the Owner
Costs are slightly different from those shown in Example 3.  These are the
extended titles entered for each Owner Cost column on the Other Report
Formatting Screen (Figure 15.x).

 • Finally, notice that the Total Including Owner Costs figure is the same as the
sum of the Total Costs in Example 3.  Again, this represents the total for the
estimate.
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 Example 5:  Project Direct Summary

 Report Example 5 (Figure 15.13) shows the Project Direct Summary Report for
the DEMAIR project, broken down to title Level 1.

 
 
 Wed 14 Sep 1994                                          MCACES 5.30                                              TIME 15:57:11
 Eff. Date  05/13/94    PROJECT DEMAIR:   International Airport Remodel - from Intermediate Construction
                                                  Example Renovations Estimate                                 SUMMARY PAGE    1
                                             ** PROJECT DIRECT SUMMARY - Bid Item **
 
 -------------------------------------------------------------------------------------------------------------------------------
                                                          QUANTITY UOM    MATERIAL       LABOR       OTHER  TOTAL COST UNIT COST
 -------------------------------------------------------------------------------------------------------------------------------
 
                   001  BUILDING CONSTRUCTION            371725.00 SF    8,154,708   4,032,089  10,422,229  22,609,026     60.82
                   002  SITEWORK                         371725.00 SF    1,124,513   1,013,630     674,802   2,812,944      7.57
                   004  CONNECTOR                          4966.00 SF      329,496     116,617      27,552     473,666     95.38
                   005  NON-PUBLIC AREAS                 139945.00 SF      274,070     164,218     523,466     961,754      6.87
                                                                       ----------- ----------- ----------- -----------
                  TOTAL Air Terminal Reconstruction      371725.00 SF    9,882,788   5,326,554  11,648,049  26,857,390     72.25
 
                     Prime Contractor's Overhead                                                             2,215,735      5.96
                                                                                                           -----------
                       SUBTOTAL                                                                             29,073,125     78.21
                     Prime's Home Office Expense                                                             1,162,925      3.13
                                                                                                           -----------
                       SUBTOTAL                                                                             30,236,050     81.34
                     Prime Contractor's Profit                                                               2,267,704      6.10
                                                                                                           -----------
                       SUBTOTAL                                                                             32,503,754     87.44
                     Prime's Bond Costs                                                                        975,113      2.62
                                                                                                           -----------
                       TOTAL INCL INDIRECTS                                                                 33,478,866     90.06
                     Escalation Costs                                                                        1,881,633      5.06
                                                                                                           -----------
                       SUBTOTAL                                                                             35,360,499     95.13
                     Design Contingency                                                                      3,182,445      8.56
                                                                                                           -----------
                       SUBTOTAL                                                                             38,542,944    103.69
                     Phasing Contingency                                                                     1,541,718      4.15
                                                                                                           -----------
                       SUBTOTAL                                                                             40,084,662    107.83
                     Project Management Fees                                                                 3,206,773      8.63
                                                                                                           -----------
                       SUBTOTAL                                                                             43,291,435    116.46
                     Airport Authority Management                                                            2,597,486      6.99
                                                                                                           -----------
                       TOTAL INCL OWNER COSTS                                                               45,888,921    123.45
 
 

 

 Figure 15.13:  Project Direct Summary Report
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 Analysis of Example 5

 Example 5 is similar in its components to Example 4.  The main differences are as
follows:

 • The individual cost columns show the Direct Costs defined for the DEMAIR
Project:  Material, Labor, and Other.  As mentioned previously, the costs
shown include subcontractor markups and therefore represent the costs to the
prime contractor.  The Material Costs include the Sales Tax markup of 7% as
defined on the Report Title Page Screen for the project.

 • The costs added below the Total Cost column now include the Indirect Costs
as well as the Owner Costs, with the Indirect Costs added in first.  Once again,
the extended column titles are used.
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 Contractor Summary Reports

 Contractor summary reports list the costs associated with each contractor in an
estimate.  Reports are available for Project Direct and Indirect Costs, and can be
generated for the detail level and any title level in the project.

 Example 6:  Contractor Indirect Summary Report

 The Contractor Indirect Summary Report shows a breakdown, by contractor, of
all the Indirect Costs computed for a project.  Figure 15.14 shows an example of a
portion of the Contractor Indirect Summary Report for Level 1 of the DEMAIR
Project.

 
 
 Wed 14 Sep 1994                                          MCACES 5.30                                              TIME 16:02:04
 Eff. Date  05/13/94    PROJECT DEMAIR:   International Airport Remodel - from Intermediate Construction
                                                  Example Renovations Estimate                                 SUMMARY PAGE    1
                                          ** CONTRACTOR INDIRECT SUMMARY - Bid Item **
 
 -------------------------------------------------------------------------------------------------------------------------------
                                                    DIRECT    OVERHEAD    HOME OFF      PROFIT        BOND  TOTAL COST UNIT COST
 -------------------------------------------------------------------------------------------------------------------------------
 
 BUILDING CONSTRUCTION
 PM  Prime Contractor
    BC  Building Construction                    7,902,808     395,140     165,959     677,113     182,820   9,323,840     25.08
    ME  Mechanical and Electrical                6,051,655     363,099      64,148     518,312      69,972   7,067,186     19.01
 -------------------------------------------------------------------------------------------------------------------------------
 Subtotal Subcontract Work                      13,954,463     758,240     230,107   1,195,425     252,793  16,391,026     44.09
 
 Indirect on Subcontracts                       16,391,026   1,352,260     709,731   1,383,976     595,110  20,432,103     54.97
 Indirect on Own Work                            6,218,000     512,985     269,239     525,017     225,757   7,750,998     20.85
 -------------------------------------------------------------------------------------------------------------------------------
 PM  Prime Contractor                           22,609,026   1,865,245     978,971   1,908,993     820,867  28,183,102     75.82
 
 SITEWORK
 PM  Prime Contractor
    ME  Mechanical and Electrical                  876,107      52,566       9,287      75,037      10,130   1,023,127      2.75
    SW  Sitework                                 1,504,521     135,407           0     114,795      35,094   1,789,817      4.81
 -------------------------------------------------------------------------------------------------------------------------------
 Subtotal Subcontract Work                       2,380,628     187,973       9,287     189,832      45,224   2,812,944      7.57
 
 Indirect on Subcontracts                        2,812,944     232,068     121,800     237,511     102,130   3,506,453      9.43
 -------------------------------------------------------------------------------------------------------------------------------
 PM  Prime Contractor                            2,812,944     232,068     121,800     237,511     102,130   3,506,453      9.43
 
 

 

 Figure 15.14:  Contractor Indirect Summary Report (Portion)
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 Analysis of Example 6

 Example 6 has the following elements:

 • The leftmost column shows the Level 1 titles defined for the DEMAIR Project.
Beneath each title, the contractors assigned within that project element are
listed with their two-character contractor IDs.

 • The Direct column shows the sum of the Direct costs for work performed by
each contractor.

 • The next four columns are the Indirect Cost Columns defined for the Project on
the Name Project Columns Screen.  On this report, the columns show each
contractor's markups on the associated Direct Costs.

 • The Total Cost for each row is the sum of the preceding five columns.  A Unit
Cost column, based on each title's Quantity value, is also shown.

 • Subcontractors' IDs and names are indented under their parent contractors.
Under the first title, Building Construction, the Prime Contractor (PM) is
listed, followed by listings for his subcontractors BC and ME.

 • Following a list of indented subcontractors, the next row shows the subtotals
for the parent contractor for subcontracted work.  Under Building
Construction, the row is labelled "PM Subtotal Subcontract Work."

 • The next row ("labelled PM Indirect on Subcontracts") shows the cost markups
of the parent contractor on his subcontractors' work.  Notice that the Total Cost
from the previous row becomes the Direct Cost for this row (16,391,026 in the
example).  That is, the total cost of subcontracted work, including the
subcontractors' markups, becomes the total Direct Cost to the parent contract.
In the rest of this row, the parent contractors markups on this subcontracted
work are added in.

 • The following row ("PM Indirect on Own Work") shows the Direct Costs for
work under this title performed by the parent contractor, and his markups on
that work.

 • Finally, the preceding two rows are added to show the total of the Direct Costs
and markups for the parent contractor for this title element.
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 Example 7:  Contractor Direct Summary Report

 The Contractor Direct Summary Report is similar to the Contractor Indirect
Summary report, except that the Direct Cost columns defined for the project are
shown.  Figure 15.15 shows an example section of this report at title Level 1.

 
 
 Wed 14 Sep 1994                                          MCACES 5.30                                              TIME 16:05:54
 Eff. Date  05/13/94    PROJECT DEMAIR:   International Airport Remodel - from Intermediate Construction
                                                  Example Renovations Estimate                                 SUMMARY PAGE    1
                                           ** CONTRACTOR DIRECT SUMMARY - Bid Item **
 
 -------------------------------------------------------------------------------------------------------------------------------
                                                                    QUANTITY UOM    MATERIAL       LABOR       OTHER  TOTAL COST
 -------------------------------------------------------------------------------------------------------------------------------
 
 BUILDING CONSTRUCTION
 PM  Prime Contractor
    BC  Building Construction                                      371725.00 SF    5,000,741   2,274,490     627,577   7,902,808
    ME  Mechanical and Electrical                                  371725.00 SF    1,930,764   1,154,823   2,966,067   6,051,655
 -------------------------------------------------------------------------------------------------------------------------------
 Subtotal Subcontract Work                                         371725.00 SF    6,931,505   3,429,313   3,593,645  13,954,463
 
 Subcontracts Incl Indirect                                        371725.00 SF    8,154,708   4,032,089   4,204,229  16,391,026
 Contractor's Own Work                                             371725.00 SF            0           0   6,218,000   6,218,000
 -------------------------------------------------------------------------------------------------------------------------------
 PM  Prime Contractor                                              371725.00 SF    8,154,708   4,032,089  10,422,229  22,609,026
 
 
 SITEWORK
 PM  Prime Contractor
    ME  Mechanical and Electrical                                  371725.00 SF      599,363     276,744           0     876,107
    SW  Sitework                                                   371725.00 SF      356,893     580,389     567,238   1,504,521
 -------------------------------------------------------------------------------------------------------------------------------
 Subtotal Subcontract Work                                         371725.00 SF      956,257     857,133     567,238   2,380,628
 
 Subcontracts Incl Indirect                                        371725.00 SF    1,124,513   1,013,630     674,802   2,812,944
 -------------------------------------------------------------------------------------------------------------------------------
 PM  Prime Contractor                                              371725.00 SF    1,124,513   1,013,630     674,802   2,812,944
 
 

 

 Figure 15.15:  Contractor Direct Summary Report (Portion)
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 Analysis of Example 7

 Notice the following about Example 7:

 • Subcontractors' Direct Costs are printed in indented rows beneath the names of
their parent contractors.  The Direct Cost columns are the ones defined on the
Name Project Columns Screen.

 • A subtotal line is then printed ("Subtotal Subcontract Work").  This line shows
the totals for the parent contractor's subcontracted work.  This line does not
include any Indirect Cost markups.

 • The next line ("Subcontracts Incl Indirect") shows the totals for the
subcontracted work with the subcontractors' markups included.  (These costs,
including the markups, are considered Direct Costs to the parent contractor.)

 • If appropriate, the next line (labelled "Contractor's Own Work") shows the
Direct Costs for work performed by the parent contractor.

 • Finally, the total line for each title shows the total Direct Costs in each column
for the parent contractor.
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 Division Summary Reports

 Division summary reports break down a project's costs according to the 16
Construction Specifications Institute (CSI) Divisions.  These divisions are the
same as the Level 1 titles in the supplied Unit Price Database.

 These reports accumulate project cost items with a database ID that places them
within a CSI division.  That is, the first two characters of their database ID
matches one of the UPB Level 1 titles.  Items with missing or non-matching IDs
are accumulated and shown in a Not Identified category on the report.  Items with
cost overrides at a title level at not listed.

 You can produce division summary reports of Project Direct, Indirect, and Owner
Costs, showing costs at the detail level and any title level.

 Example 8:  Division Direct Summary Report

 Report Example 8 (Figure 15.16) illustrates part of a title Level 1 Division Direct
Summary Report for the DEMAIR project.

 
 
 Wed 14 Sep 1994                                          MCACES 5.30                                              TIME 16:09:31
 Eff. Date  05/13/94    PROJECT DEMAIR:   International Airport Remodel - from Intermediate Construction
                                                  Example Renovations Estimate                                 SUMMARY PAGE    2
                                            ** DIVISION DIRECT SUMMARY - Bid Item **
 
 -------------------------------------------------------------------------------------------------------------------------------
                                                                                    MATERIAL       LABOR       OTHER  TOTAL COST
 -------------------------------------------------------------------------------------------------------------------------------
 
 BUILDING CONSTRUCTION
                                             02 Site Work                            284,083     220,896     186,206     691,185
                                             03 Concrete                             742,723     570,451      63,782   1,376,957
                                             04 Masonry                              225,762     291,564         369     517,695
                                             05 Metals                             2,446,700     546,307     160,951   3,153,958
                                             06 Wood And Plastic                      10,838       6,750      28,316      45,903
                                             07 Thermal And Moisture Protection      630,658     249,408      85,744     965,810
                                             08 Doors And Windows                    602,896      71,148         327     674,370
                                             09 Finishes                             828,549     707,157      19,470   1,555,176
                                             10 Specialties                          127,732      19,794     195,259     342,785
                                             14 Conveying Systems                                          6,218,000   6,218,000
                                             15 Mechanical                           897,783     991,803   2,504,378   4,393,964
                                             16 Electrical                         1,356,984     356,812     959,427   2,673,222
                                                                                 ----------- ----------- ----------- -----------
                                                                                   8,154,708   4,032,089  10,422,229  22,609,026
 
 SITEWORK
                                             02 Site Work                            424,570     690,446     674,802   1,789,817
                                             15 Mechanical                           681,131     314,997                 996,129
                                             16 Electrical                            18,811       8,187                  26,998
                                                                                 ----------- ----------- ----------- -----------
                                                                                   1,124,513   1,013,630     674,802   2,812,944
 
 

 

 Figure 15.16:  Division Direct Summary Report (Portion)



Working With Reports 15-33

 Analysis of Example 8

 Following are the components of Report Example 8:

 • The leftmost column shows the Level 1 titles.

 • For each title, the report then lists the CSI Divisions for which cost items are
defined.

 • The cost columns show the Direct Costs defined for the Project.  The figures in
each column represent the accumulated costs for the title of all cost items
belonging to the specified CSI division.

 Division Indirect Summary Report

 The Division Indirect Summary Report is similar to the Direct Summary Report
except that the Indirect Cost columns defined for the project are shown.

 The first cost column shows the total Direct Cost for each CSI Division, and the
subsequent columns show the various markups on those Direct Costs.  The Total
Cost column represents the sum, per CSI division, of all Direct and Indirect Costs.

 Division Owner Summary Report

 The Division Owner Summary Report shows the Owner Cost columns defined for
the project.

 The first cost column shows the total of Direct and Indirect Costs for each CSI
Division.  Subsequent columns list the various Owner Costs as distributed over
those summed costs.  The Total Cost column represents the sum, per CSI
Division, of all Direct, Indirect, and Owner Costs.
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 System Summary Reports

 System summary reports break down a project's costs according to the 16 system
codes of the building systems classification.  The 16 building systems represented
by these codes are the same as the Level 1 titles in the supplied Assemblies
Database

 The system summary reports classify cost items according to the value in the
Work Category field on the detail item entry screen.  For this report to be valid,
the first two characters in the Work Category field must equal the system code for
the appropriate building system.  (If you work with the supplied Assemblies
Database, GOLD automatically fills the Work Category field according to the title
hierarchy of that database.  In other cases, you can fill in the Work Category field
as needed.)

 You can produce system summary reports of Project Direct, Indirect, and Owner
Costs, showing costs at the detail level and any title level.
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 Example 9:  System Direct Summary Report

 Report Example 9 (Figure 15.17) illustrates part of a title Level 1 System Direct
Summary Report for the DEMAIR project.

 

 Wed 20 Jul 1994               U.S. Army Corps of Engineers                   TIME
10:16:54
 Eff. Date  05/13/92    PROJECT DEMAIR:   International Airport Remodel
                               Example Renovations Estimate               SUMMARY PAGE
2
                          ** SYSTEM DIRECT SUMMARY - Bid Item **
 
 -----------------------------------------------------------------------------------------
-
                                               MATERIAL       LABOR       OTHER  TOTAL
COST
 -----------------------------------------------------------------------------------------
-
 
 BUILDING CONSTRUCTION
        01 Substructure                         370,025     291,028     180,641
841,694
        02 Structural Frame                     143,344     111,785      22,563
277,691
        03 Roofing                            2,617,452     965,844     284,282
3,867,577
        04 Exterior Closure                     649,810     440,885      12,905
1,103,600
        05 Interior Construction                412,950      77,092       9,504
499,546
        06 Interior Finishes                  1,706,361     796,841     230,530
2,733,732
        07 Specialties                                                6,218,000
6,218,000
        08 Plumbing                             897,783     991,803   2,504,378
4,393,964
        09 Heating,ventilation & Air Condit   1,356,984     356,812     959,427
2,673,222
                                            ----------- ----------- ----------- ----------
-
                                              8,154,708   4,032,089  10,422,229
22,609,026
 
 SITEWORK
        12 Special Interior Electrical Syst   1,124,513   1,013,630     674,802
2,812,944
                                            ----------- ----------- ----------- ----------
-
 

 Figure 15.17:  System Direct Summary Report (Portion)

 Analysis of Example 9

 Report Example 9 includes the following parts:

 • The leftmost column shows the Level 1 titles.

 • For each title, the report then lists the building systems to which cost items are
attributed in their Work Category fields.
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 • The cost columns show the Direct Costs defined for the Project.  The figures in
each column represent the accumulated costs for the title of all cost items
belonging to each building system.
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 System Indirect Summary Report

 The System Indirect Summary Report is similar to the Direct Summary Report
except that the Indirect Cost columns defined for the project are shown.

 The first cost column shows the total Direct Cost attributed to each building
system, and the subsequent columns show the markups on those Direct Costs.
The Total Cost column represents the sum, for each system, of all Direct and
Indirect Costs.

 System Owner Summary Report

 The System Owner Summary Report shows the Owner Cost columns defined for
the project.

 The first cost column shows the total of Direct and Indirect Costs for each
building system.  Subsequent columns list the various Owner Costs as distributed
over those summed costs.  The Total Cost column represents the sum, for each
system, of all Direct, Indirect, and Owner Costs.
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 Shipping Summary Report

 The Shipping Summary Report provides a listing of the shipping costs for
materials in a Project Database.  The costs are summarized by CSI Division.

 Producing the Report

 The Shipping Summary Report is automatically produced when you choose to
generate either project summary reports or a Detail Report, provided that the
following are true:

 • Shipping is selected as a predefined Direct Cost column for the project.

 • A shipping rate has been entered on the Adjust Pricing Screen and non-zero
shipping costs have therefore been generated and stored in the project.

 Refer to Section 6.8 for instructions on working with shipping costs.
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 Backup Reports

 Backup reports provide additional information about a project by showing the
utilization of crews, labor, and equipment.

 You can produce a Crew Detail Backup Report as well as summary reports for
crews, labor items, and equipment items at any title level.

 To generate backup reports, the Estimate Type must be set to either A (Crews
with Auto Reprice) or C (CACES Mode).

 Example 10:  Detail Crew Report

 Report Example 10 (Figure 15.18) shows part of the Detail Crew Backup Report
for the sample MILEXM Project.  The first three crews listed on the report are
shown.

 
 
 Wed 14 Sep 1994                                          MCACES 5.30                                              TIME 17:03:49
 Eff. Date  05/15/94               PROJECT MILEXM:   Storage Building - Battalion Headquarters
                                                    Military Example Project                                   BACKUP PAGE     1
                                                        ** CREW BACKUP **
 
 --------------------------------------------------------------------------     **** LABOR ****     **** EQUIP ****        TOTAL
 SRC  ITEM ID    DESCRIPTION                             NO. UOM       RATE     HOURS      COST     HOURS      COST         COST
 -------------------------------------------------------------------------------------------------------------------------------
 
       AASBC       2 B-asbtswkr + Small Tools                              PROD =   100%                    CREW HOURS =     5
 MIL   B-ASBTSWKRL Asbestos Workers                     2.00 HR       25.09      2.00     50.17                            50.17
 MIL   B-ASBTSWKRF Asbestos Workers                     0.50 HR       25.59      0.50     12.79                            12.79
 MIL   XMIXX020  E Small Tools                          0.68 HR        1.45                          0.68      0.99         0.99
 -------------------------------------------------------------------------------------------------------------------------------
       TOTAL                                                                     2.50     62.97      0.68      0.99        63.95
 
       ACARA       1 B-carpnter + Small Tools                              PROD =   100%                    CREW HOURS =     8
 MIL   B-CARPNTERL Carpenters                           1.00 HR       22.87      1.00     22.87                            22.87
 MIL   B-CARPNTERF Carpenters                           0.25 HR       23.37      0.25      5.84                             5.84
 MIL   XMIXX020  E Small Tools                          0.31 HR        1.45                          0.31      0.45         0.45
 -------------------------------------------------------------------------------------------------------------------------------
       TOTAL                                                                     1.25     28.71      0.31      0.45        29.16
 
       ACARB       2 B-carpnter + Small Tools                              PROD =   100%                    CREW HOURS =    13
 MIL   B-CARPNTERF Carpenters                           0.50 HR       23.37      0.50     11.69                            11.69
 MIL   B-CARPNTERL Carpenters                           2.00 HR       22.87      2.00     45.74                            45.74
 MIL   XMIXX020  E Small Tools                          0.66 HR        1.45                          0.66      0.96         0.96
 -------------------------------------------------------------------------------------------------------------------------------
       TOTAL                                                                     2.50     57.43      0.66      0.96        58.38
 
 

 Figure 15.18:  Detail Crew Backup Report (Portion)
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 Analysis of Example 10

 Example 10 includes the following elements:

 • For each crew, a subheading shows the Crews Database ID of the crew and its
Description.  The Productivity figure stored for the Crew in the Crews
Database and used to adjust each project cost item is also shown.  The Crew
Hours figure shows the total number of hours that this crew is used in the
entire project.

 • Below the subheading, each member of the crew is listed.  The information
shown is the detailed data stored for each member in the Crews Database.

 • The Total row below each crew shows the total hours and hourly cost for all
labor and equipment members, as well as the total hourly cost for the entire
crew.

 Crew Summary Reports

 Crew Summary Reports can be produced for any title level of the project.

 For each title, these reports list the crew ID, description, productivity value, and
the total hours worked by the crew in the particular project element represented
by the title.

 Labor Backup Reports

 Labor backup reports list labor cost items used in the estimate.  These items are
crew members belonging to crews used by project items.  The labor items are
stored as individual detail items in the Labor Rates Database.

 For each labor item, the report shows the detail information stored in the Labor
Rates Database, including Base Rate, Overtime, Taxes and Insurance, etc.  The
report also lists the number of hours each labor item is used.

 You can produce reports that summarize the entire project or summary
breakdowns for any title level.
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 Labor Cost-to-Prime Backup Report

 The Labor Cost-to-Prime backup report lists labor cost items used in the estimate.
These items are crew members belonging to crews used by project items or labor
IDs that are individual detail items.  Under each selected project title, the report
lists for each Labor ID type: the Labor ID from the Labor rates database, the
Labor ID description, the Labor type (Laborer, Foreman or Apprentice), the
number of hours this ID is called for under this title, the database rate, the
extended amount of the hours times the database rate, the Cost-to-Prime rate
(which includes Overtime, Adjust Pricing, and Subcontractor Markups), and the
extended amount of the hours times the Cost-to-Prime rate.

 Equipment Backup Reports

 Equipment backup reports list the equipment items in the estimate.  These items
are the equipment crew members used by project cost items and stored in the
Equipment Rates Database.

 For each item, the report shows detailed information from the Equipment Rates
Database as well as the total number of hours each item is used.

 As with labor backup reports, you can produce equipment reports for an entire
project or summary breakdowns by title level.
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 Settings Reports

 Settings reports are selected from the top rows of the Report Selection Screen.
These reports provide supporting information about an estimate by listing the
software settings used to determine various aspects of project structure.

 Three separate settings reports are available:

 • Project Settings Report
 • Contractor Settings Report
 • Link Listing Report

 Note:  The Link Listing Report is only available with the optional Models
Module and is described in Volume 2, Advanced Options..

 Project Settings Report

 The Project Settings Report lists all the entries currently recorded for the project
on the following screens:

 • Name Project Columns
 • Set Breakdown Structure
 • Detail Report Formatting
 • Other Report Formatting
 • Report Selection

 In addition, this will automatically generate a report called the Owner, Overtime,
and Adjustments Settings Report.  This report will list any Owner Cost Markups
applied at the default Owner Cost level, as well as any Owner Cost markups that
have been applied at the lowest title level.  In addition to the Owner Cost
markups, the settings report will print any title on which Overtime has been
applied, displaying the Overtime information that has been input on the OTHER
screen at the lowest title level. (This includes days per week, hours per day, hours
per shift, shifts per day, and the overtime percentage for labor.)  Any titles for
which adjustments have been made using the Adjust Pricing screen will also be
printed, along with the requested adjustments as displayed on the Adjust Pricing
screen.

 Contractor Settings Report

 The Contractor Settings Report lists each contractor in the project.  For each
contractor, the method chosen to compute each Indirect Cost column is shown,
along with the currently set percentage, separate percentage, or amount.

 If the compute method is used for figuring profit, the values entered for the
various weighting factors are also listed.
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 Profit Weighted Guidelines Report

 The Profit Weighted Guidelines Report may be selected to display the weights
attached to each risk factor, when the Compute method is used to calculate the
Profit for a contractor.  The report displays the Risk Factor, the Rate (percentage
out of 100 that this factor carries), the Weight of each factor (from .03 to .12), and
the resulting value for each risk factor.  The user can also attach notes, using the
F7 function key from the Profit Weighted Guidelines screen.  Typically these
notes will describe the reasons for each of the weights assigned to the risk factors.
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 15.7   Database Listings

 Purpose

 This procedure can be used to print all or part of Unit Price, Crews, Labor Rates,
and Equipment Rates Databases. The MCACES Database Listings function is a
selection on the File Menu.  This command displays a tabbed dialog box which
provides access to the various options. Clicking on each tab will bring the
information on that tab to the front for view and input.  See Figure 15.19.

 Note: Supporting databases used with MCACES can be extremely large and can
take a long time to print.  You might want to select a portion of a database, to
avoid printing data you don't need.

 

 Figure 15.19:  Current Databases Tab Display

 Current Databases Tab

 The Current Databases Tab displays information on the four databases.

 Report Header

 Use this field to enter a title of up to 96 characters to be printed on the top of
every page.
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 Unit Price Database

 This allows you to select the particular Unit Price Database to be printed.  Use the
button to the right of the path identification to browse for the correct database.

 Crews Database

 Using this, you can select the particular Crews Database to be printed.  Use the
button to the right of the path identification to browse for the correct database.

 Labor Database

 This allows you to select the particular Labor Database to be printed.  Use the
button to the right of the path identification to browse for the correct database.

 Equipment Database

 Using this, you can select the particular Equipment Database to be printed.  Use
the button to the right of the path identification to browse for the correct database.
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 Database Ranges Tab

 The Database Ranges Tab includes options available when generating the
Database Listings.  This includes specified ranges to list a subset of the full
database. Figure 15.20 shows the Database Ranges Tab.

 

 

 Figure 15.20:  Database Range Tab

 The four option radio buttons are mutually exclusive: only one can be selected at
a time.

• No Database Listing - do not generate a listing for this database

• Include Specified Range - list only items in the range specified

• Exclude Specified Range - do not include items in the range specified

• List Entire Database - list all items in a database
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 Filters and Formats Tab

 The Filters and Formats Tab includes further options available when generating
the Database Listings.  Figure 15.21 shows the Filters and Formats Tab.

 

 

 Figure 15.21:  Filters and Formats Tab

 General Format

 These options determine the formatting of the report or reports.  Options are:

• Print with Single Line Description - Single Line Description - The report
shows only a single line of data for each detail item.

• Print with full Multi-Line Description - The report includes full listings of any
additional Notes attached to items.

• Print as File Dump (No Page Breaks) - This option produces an ASCII text file
of the report for the purposes of data transfer.  It is not intended for printing,
since the file will contain lines of more than 130 characters.
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 Date Filter

 These options let you include or exclude  items according to the date their prices
were last updated.  This option applies to the Unit Price Database (material prices)
and to the Labor and Equipment Rates Databases.

• No Date Filter - Include items for all dates.

• Include Specified Dates - Include items within the date range specified.

• Exclude Specified Dates - Exclude items within the date range specified.

• This Date or Older - Specify the cutoff date.

 UPB Listing Options

 These are specific options for Unit Price Book Listings.

• Print UPB Material Indicator Info - Choose this option to include information
about material price adjustment indicators entered at title levels.  For any titles
where material adjustments are pending, the report will list the adjustment
data.

• Print UPB Table of Contents - Choose this option to print a table of contents
with the UPB listing.

• Print UPB with Single Unit Costs - Choose this option to

 Sources Filter (MIL, CIV, etc.)

 These options are used to include or exclude specific source IDs from the listing.

• No Sources Filter

• Include Listed Sources

• Exclude Listed Sources
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Material Backup Tab

The Material Backup Tab includes options available when generating the Material
Backup Listings.

Figure 15.21:  Filters and Formats Tab

Type of Report

The type of report is used to select either the Material Backup Report or the
Vendor Backup Report for printing.

Date Filter

This option is used to include or exclude data based on specified dates.  You can
also choose to use no date filter and thus print all entries.

IDs Filter

The ID’s Filter section allows you to select data for specific vendors or UPB Ids.
Leave the fields blank to include all entries.

Sources Filter

The Sources Filter is used to include or exclude data based on specified sources.
You can also choose to use no source filter and thus print all entries.
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Chapter 16

Command and Menu Reference

In This Chapter

This chapter provides a guide to the Toolbar and the various Menus available in
MCACES. The following sections are included:

16.1  Toolbar
16.2  File Menu
16.3  Edit Menu
16.4  View Menu
16.5  Outline Menu
16.6  Tools Menu
16.7  Window Menu
16.8  Help Menu
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16.1  Toolbar

About the Toolbar

The toolbar provides a mouse shortcut to and graphical display of the most
frequently used menu commands.  The following describes the toolbar
capabilities.

To hide or display the toolbar, turn it off through the Toolbar function, located on
the View Menu.

New.  Create a new Project, Assemblies, Unit Price, Crew, Labor, or
Equipment database.

Open.  Open an existing Project, Assemblies, Unit Price, Crew, Labor, or
Equipment database.

Cut.  In an edit field or notes panel, remove the selected text and place it
on the clipboard.  In the Grid Panel, place the current row or selected rows on the
clipboard.  If a paste action is completed in the same database (project), mark the
selected items for deletion. See also Cut and Paste (Move).

Copy.  In an edit field or notes panel, copy the selected text to the
clipboard.  In the Grid Panel, place the current row or selected rows on the
clipboard. See also Copy and Paste.

Paste.  In an edit field or notes panel,  place any text from the clipboard at
the current cursor position.  In the Grid Panel, copy any records that are on the
clipboard at the current position.

Undo.  Reverses all changes made to the current record since the last
commit of the record’s data.  May be used like the escape key without bringing
the form down.

Print.  Open a dialog box which provides access to reporting options to be
selected immediately prior to printing.  This includes Report Title, Print Range,
and Print Device..  On confirmation, runs the current report selection to the
default printer.

Calculate.  Perform a process to reprice and update all totals.

Find.  Provide a dialog box for entering a description and Matching ID.
Perform a search on the description in the active database/document.  If a search
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was performed previously in this software session, allow choosing from the list of
items last found.  Once the choice is made, position the database to the desired
item

Go to Parent.  Position the outline selection arrow and grid highlight to
their respective parent items.

Go to Child.  Position the outline selection arrow to the item currently
highlighted in the grid, and update the grid accordingly.

Toggle Outline Panel.  Display or Hide the Outline Panel in the
current Main Window.

Toggle Grid Panel.  Display or Hide the Grid Panel in the current
Main Window.

Toggle Notes/Reference Panel.  Display or Hide the Notes /
Reference Panel in the current Main Window.

Summary Information.   Provides access to database-wide information.
For the project, this includes report title page information, cost column setup,
WBS setup, default owner cost setup, and supporting database selection.

Toggle Item Form.  Display or Hide  the Item Form (Edit Window) for the
Item selected in the Grid Panel.  This form shows on top of, and partially obscures
the panels beneath; it may be moved as needed.

Add.  Place a new item in the currently active grid.  When adding titles,
the item ID is defaulted to a value incremented beyond the ID of the last  title
displayed in the grid. Other data fields may also obtain default values as
appropriate.

Lookup Contractor.  Access the Contractor data in the current project.

Lookup Assemblies.  Access the Assemblies database if already open or
accessible.  Otherwise,  the File Open dialog box is displayed to select the desired
database.  The software then positions as closely as possible to the ID selected in
the Grid panel.

Lookup UPB.  Access the Unit Price Book database if already open or
accessible.  Otherwise,  the File Open dialog box is displayed to select the desired
database.  The software then positions as closely as possible to the ID selected in
the Grid panel.

Lookup Crews.  Access the Crews database if already open or accessible.
Otherwise,  the File Open dialog box is displayed to select the desired database.
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The software then positions as closely as possible to the ID selected in the Grid
panel.

Lookup Labor Rates.  Access the Labor Rates database if already open or
accessible.  Otherwise,  the File Open dialog box is displayed to select the desired
database.  The software then positions as closely as possible to the ID selected in
the Grid panel.

Lookup Equipment.  Access the Equipment Rates database if already open
or accessible.  Otherwise,  the File Open dialog box is displayed to select the
desired database.  The software then positions as closely as possible to the ID
selected in the Grid panel.

Help.  Produce a special mouse cursor which, when clicked on buttons,
menus, and windows, opens context-sensitive help.
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Menu Overview

The MCACES for Windows Menu bar reads as follows:

File Edit View Outline    Tools      Window       Help

The following sections briefly describe each menu and menu option available.
Some of the menu options not covered elsewhere in the User Manual are
discussed in detail following the table listing the options on each menu.

Note that a menu option trailed by an ellipsis (...), by Windows convention, leads
to a dialog box in which the user is prompted with a dialog box before
proceeding.
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16.2  File Menu

The File Menu allows new databases to be opened or created and mediates
between any open databases and the computing environment.

File Menu Selection Action

New... Permits creating a new project database.

Open... Opens a database of project, assemblies, unit price, crew, labor, or equipment
type.

Close Closes the active database window and saves current data without exiting the
software.

Report Setup... Opens a dialog box which provides button access to reporting options to be
selected.  This includes Report Selection, Calculation, Column Formatting,
Report Formatting and Selection of Material and/or Vendor Backup Reports.

Database Listings... Provides access to a tabbed dialog box which prints selected ranges in the Unit
Price, Crews, Labor, or Equipment databases.  This selection may be accessed
even if the databases are not open.

Print... Opens a dialog box which provides button access to reporting options to be
selected immediately prior to printing.  This includes Report Title, Print
Range, and Print Device. On confirmation, runs the current report selection to
the default printer  This selection opens the Print Dialog Box.

Print Setup... Brings up the standard Windows Printer Setup Dialog Box.

Print Preview Runs current report selection to a window and provides an option to print to a
printer.

Summary Info... Provides access to database-wide information of all types via a dialog box.

Copy Database... Copies a database from and to directly readable or compressed format.

Save to Compressed Saves one or more databases to compressed files on floppy disk or hard disk.
The databases are compressed to be compatible with PKZIP version 2.04.  To
retrieve the databases and expand them, you must use the Load from
Compressed selection.

Load from
Compressed

Expand and reload one or more databases previously saved to a compressed
file using the Saved to Compressed selection.

Pack Data... Packs a database, i.e. permanently removes any records marked for deletion.

Reset Index... Removes all indexes associated with a database.  These are automatically
regenerated the next time the database is opened.  This may recover
apparently corrupted data in the wake of a power failure.

Delete Database... Removes a database from disk.

Exit Commits any pending changes to open databases, closes them, and exits
MCACES for Windows.
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Save to compressed

MCACES allows you to store your databases in a compressed form, either on a
diskette or onto your hard drive.

Procedure

Under the File menu, choose Save to Compressed.

Result: The Save to Compressed Databases(s) from dialog box is displayed:

If you want to save to compressed from the directory currently displayed in the
dialog box, simply click OK.  If needed, you can change the drive and path here
and then click OK.

Result: You will be presented with a list of the databases in the chosen directory.

Click on the leftmost box next to each database that you want to save.

If you want to save to a drive other than your A:\ drive, then click on the “to”
button.  This will allow you to change the drive and path of the location where the
compressed database will be stored.

If there is already a compressed file on the destination drive, you will be asked
whether to keep the current databases.
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You can keep any or all of the previously saved databases be leaving them
selected and clicking OK.  All of them are selected to be saved by default.

The software will create a temporary workfile and will compress the new and the
old databases into the temporary file.

You will then receive the following message:

Click OK to continue.

You will then receive the following message:

You must click Yes to continue with the process.

Note that any other files on this diskette (other than the databases that we asked
the system to save) will be deleted by this process.

When the process is completed, the prompt at the bottom of your screen will say
“Save Database(s) to Compressed Completed.

It is always a good idea to test load the database before shipping it to someone
else or deleting the original from your hard drive.



Command and Menu Reference 16-9

16.3  Edit Menu

The Edit Menu handles menu actions relating to placing new data in the estimate
or modifying current data.  It also handles data searches.

Edit Menu
Selection

Action

Undo Record
Changes

Reverses all changes made to the current record since the last commit of the record’s data.

Cut In an edit field or notes panel, remove the selected text and place it on the clipboard. In the Grid
Panel, place the durrent row or selected rows on the clipboard.  If a paste action is completed in
the same database (project), mark the selected items for deletion.

Copy In an edit field or notes panel, copy the selected text to the clipboard. In the Grid Panel, place
the current row or selected rows on the clipboard.

Paste In an edit field or notes panel,  place any text on the clipboard at the current cursor position. In
the Grid Panel, copy any records that are on the clipboard at the current position.

Insert New
Record

Place a new row in the currently active grid above the current cursor position. The item ID is
defaulted to a value midway between the item IDs displayed above and below it in the grid.
Other data fields may also obtain default values as appropriate.

Add New
Record

Place a new row in the currently active grid following the last item in the grid. In the Project or
Assembly Databases, the item ID is defaulted to a value incremented beyond the ID of the last
item displayed in the grid. Other data fields may also obtain default values as appropriate.

Delete Current
Record

Mark for deletion the current row in a grid and, if applicable and after confirmation, any
children it may have.

Find... Perform fuzzy match search on description and ID in the active database/document.  If a search
was performed previously in this software session, allow choosing from the list of items last
found.  Once the choice is made, position the database to the desired item.
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16.4  View Menu

The View Menu controls how the user views the data.  This includes the panels
and windows that are displayed as well as other objects on the desktop such as the
Toolbar and Status Line.

View Menu
Selection

Action

Item Form Toggle the Item Form floating window open or closed.

Outline Panel Toggle the Outline Panel open or closed.

Notes/
Reference
Panel

Toggle the Notes/Reference Panel open or closed.

Grid Panel Toggle the Grid Panel open or closed.

Grid Title Bar Remove or replace the Grid Title Bar

Tool Bar Remove or replace the Tool Bar

Status Bar Remove or replace the Status Bar
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16.5  Outline Menu

The Outline Menu allows the Estimate Outline display to be configured

Outline
Menu
Selection

Action

Expand Title Expand titles hierarchy subordinate to the highlighted title - one level only

Expand Branch Expand all titles hierarchy subordinate to the highlighted title

Collapse
Branch

Collapse all titles hierarchy subordinate to the highlighted title

Go To Parent Position the outline selection arrow and grid highlight to their respective parent items

Go To Child Position the outline selection arrow to the item currently highlighted in the grid, and update the
grid accordingly.

Show Parent
Titles Only

Suppress (or restore) display of any siblings of the direct ancestors of the item focused in the
grid. This reduces the display to be similar to the MCACES GOLD Titles Box.
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16.6  Tools Menu

The Tools Menu provides access to dialog boxes which provide special
functionality to the software.  It also allows the setting of options, including
display of grids.

Tools Menu
Selection

Action

Calculate Run the recalculation engine to update all totals.

Update All
Pricing...

Provide dialog box to prepare for repricing.  Choose updating material, labor, or both.

Reprice Item
Labor/Equip

Reprice Labor and Equipment on a single (i.e. the currently focused) Detail Cost Item.

Reprice Item
Material

Reprice material on a single (i.e. the currently focused) Detail Cost Item.

Export
Calculations

Create a dBase-compatible file containing all data elements used to calculate the currently
selected reports.

Lookup Select and open the most recently used supporting databases.

Customize
Grid...

Provide a dialog box for customizing the short and long presentations of the Grid Panel in the
active database/document.

Save Panel
Layout

Save the configuration of the 3-panel display so that the same configuration will be used the
next time a database of this type is opened.

Get From
Table

This command lets you view reference table data stored in an electronic file.  You can also copy
data back to an input field on an MCACES window.

Customize
Tools...

Provide a dialog box to choose other applications to run directly from MCACES for Windows.
The selected applications then appear as choices at the bottom of the Tools Menu.
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Get from Table

Purpose

The View and Capture ASCII Data capability allows you to view on the screen
reference table data stored electronically in ASCII file format.  You can also copy
data from the ASCII file back to any input field on a MCACES screen.  This
makes it easy to input data that might otherwise have to be looked up in reference
books and keyed in manually.

Supplied Data Files

Ten ASCII files representing construction productivity factors are supplied with
the current release of MCACES and are stored in the
TRACES\MCACES\TABLES subdirectory:

• Swell Voids and Load Factors
• Weight of Materials
• Bearing Powers
• Bucket Fill Factors
• Angle of Repose of Various Materials
• Coefficient of Traction Factors
• Typical Rolling Resistance Factors
• Speed Conversions
• Curve Superelevation
• Grade in Degrees and Percents

Procedure

Use this procedure to look up and copy ASCII file data.  Begin on any MCACES
screen.

1. Choose Get From Table from the Tools Menu.

Result:  A window called Select Text Table is displayed with a listing of the
available ASCII files in the TRACES\MCACES\TABLES subdirectory.
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2. Move the highlight to the ASCII file you want to view, then click the OK
button.

Result:  The selected ASCII file is displayed on the screen.

3. To copy data back to the MCACES screen, do the following:

• Highlight the part of the text screen that you want to copy into your
project.

• Click on Copy.  You will get a notice that the text you copied is being
copied to the Windows Clipboard.

• Click on OK.

• Click on the field in your project where you want to copy the data and

then click on the Paste icon  .

Adding Data Files

You can add ASCII data files to be used for viewing and capturing at any time.
Any software that can write data in ASCII format can be used to create the files.
Just don't use tabs in editing.  The first line of your text file will become the title
of your table.  You might want to create tables for any data that you frequently
need to access.  For example, you can create a table with any escalation factors
stored, tables with Unit of Measures Stored, Contractor ID and names stored, just
to name a few.
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You can store as many as 30 files in the TRACES\MCACES\TABLES directory.
The maximum dimensions are 100 rows by 125 columns.  That is, MCACES will
access up to 100 rows and 125 columns of an ASCII file.

Customize Tools

MCACES allows you to add frequently used applications to the MCACES Tools
menu.  You use the Customize Tools function to add new applications to your
Tools menu.  Once they have been added, you simply click on Tools and then the
menu name for the newly added application in order to run that application while
in MCACES.

One application has already been added for you.  This is Notepad, and it is set up
to allow access to the errors.txt file that gets created when you recalculate a
project and that project has errors:
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Procedure:

Command Line

To add an application as a new menu choice, click on Tools | Customize Tools.

Click on the Add Item button.

Result: You  will be presented with a Select Command Line dialog box:

You can then select the Command Line, which is the executable file that will start
the application that you are adding to the Tools menu.  If you know the drive and
path, you can simply type in the drive, path and executable file, rather than
selecting it from the dialog box.  After clicking OK, you will be returned to the
Edit Menu Items section of the Customize Tools menu.

Arguments

Enter any DOS command line arguments to use when starting the program.  In the
case of the Notepad application we have set up, we input the file name of
errors.txt so that when Notepad opens it will automatically open the errors.txt file.

Menu Text

Enter the command name you want to appear on the Tools Menu.

Initial Directory

Enter the path for the initial working directory to be used by the program when
the application is started.

To Complete

When all fields have been filled in, click on OK.

Result: The application has been added to your Tools menu and you can start the
application by choosing it from the Tool menu.
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Command Buttons

Choose this button... To...

Add Item Add a new custom command item to the menu.

Delete Item Delete the current custom command item.

OK Exit the dialog box and save your changes.

Cancel Exit without saving your changes.

MCACES allows you to set up 9 different applications using the Customize Tools
function.
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16.7  Window Menu

The Window Menu  provides access to standard commands for arranging and
displaying windows.

Window
Menu
Selection

Action

Next Panel Move focus to the next database window in sequence, if multiple windows are selected.

Cascade Nests windows beginning at upper left corner

Tile Vertically Arranges windows vertically as non-overlapping tiles

Tile
Horizontally

Arranges windows horizontally as non-overlapping tiles

Arrange Icons When several MCACES for Windows databases are open but have been reduced to icons, arranges
them on the desktop.
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16.8  Help Menu

The Help menu provides access to the Help system and to the "About" Box.

Help Menu
selection

Action

Contents Provides entry point to Help topics in an outline structure.

Search for Help
on...

Provides entry point to Help search capability.

Using Help Provides "Help on Help".

About
MCACES for
Windows

Posts message box showing version number, Copyright and Restricted Rights Legend, and
software logo.
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Chapter 17

Using the Help System

In This Chapter

This chapter provides information on the On-line Help System available in
MCACES.

17.1  Overview
17.2  Contents
17.3  Searching
17.4  Context-Sensitive Help
17.5  Status Bar
17.6  Toolbar Tips
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17.1   Overview

The MCACES On-Line Help System utilizes the Microsoft Help System
capabilities built into Windows.  It provides an easy-to-use, but powerful, way to
find information about the features and use of MCACES.

There are a number of ways to access the Help System while you are using
MCACES.

1. The Help Menu provides access to the following selections:

• Contents - a table of contents guide to the help information available

• Search for Help On... - an alphabetized search capability

• Using Help - a comprehensive section describing how to use the Help
System

• About MCACES for Windows - information about this version of
MCACES

       Figure 17.1 shows the Help Menu selections.

 

 

 Figure 17.1 Help Menu
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 2. Context-sensitive help allows you to ask for help in the particular area of
MCACES in which you are working.

 3. Status Bar messages (along the bottom line of the window) give helpful hints
about the next operation to be carried out.

 4. A cross-reference system (also known as hypertext help) is available in the
help topics.  This will guide you to topics which are related to the one you
have displayed.  It includes hotspots, which are similar to see also references
in a printed document, except that you click on the hotspot to view the
referenced information.

 Note: Help Windows can be moved, resized, maximized or minimized just like
any other window.

 

 17.2   Contents

 The Help Table of Contents is used to find help on a specific topic by starting
with a broad subject and working down through more specific levels of the Table
of Contents outline to the particular topic desired.  The MCACES Contents
section includes the following sections:

• MCACES for Windows Overview - a quick way to introduce yourself to
MCACES for Windows.

• Using MCACES for Windows - detailed instructions on MCACES databases
and report capabilities.

• General Reference - Guides to the Toolbar, Menus and other important
information.

• On-Line Help System - Information to help you get the most out of on-line
help.

• Windows Tips - Techniques for effective operation of Windows applications.

• Technical Support - How to get support for MCACES for Windows.

17.3   Searching

The MCACES Help Search capability allows you to enter the name of a topic and
have that topic looked up in an alphabetized list of all MCACES help topics.  You
may also scroll through the list to find the appropriate topic.  Once the topic is
found, you may examine it.
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17.4   Context-Sensitive Help

The context-sensitive help feature will allow you to ask for help in the particular
area of MCACES in which you are working.  Help buttons are available at many
points in the software, or you may press the F1 key to bring up context-sensitive
help.  Context sensitive help may also be obtained by clicking a toolbar button
and then pointing the mouse to the on-screen feature you are interested in.

Each of the panels in the 3-panel display, including the different Notes /
Reference Panel options, has context-sensitive help available.

17.5   Status Bar

Help on each menu selection is available for display in the status bar (bottom line
of window).  The status bar messages will be displayed when a menu selection is
opened and the mouse cursor is moved over top of the particular selection.  The
Status Bar then contains a brief description of the function to be performed.

17.6   Toolbar Tips

If you move the mouse cursor slowly across the toolbar, the Toolbar Tips ( a
small pop-up over the toolbar button) will appear.  These tips contain brief
function descriptions which will assist you in remembering the functions included
on the toolbar.
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Appendix A

Terms and Definitions

Button A raised square on the window, usually with a drawing within
the button, which may be depressed by the mouse or pointing
device to select and activate a certain operation.

Child Item An item in the database hierarchy at a level immediately below
another item.

Cost to Owner Sum of cost to prime plus prime contractor indirect cost.  Also
known as the bid amount or construction contract cost.

Cost to Prime Sum of the Direct Costs plus any Sales Tax, Subcontractor
Markups, and Adjust Pricing that have been applied in the
project.

Detail Item A record type that accrues direct costs as opposed to a title item
which serves to categorize costs.

Dialog Box A “pop-up” used in the Microsoft Windows environment.  Used
for display and/or editing of data, as well as for informative
messages.

Direct Costs Sum of the direct cost columns as selected in the Column Setup
tab, which are typically labor, equipment, material and
sometimes shipping and other user defined costs.  The direct
costs include overtime adjustment for labor and equipment costs.

Distributed Costs Any costs that are distributed over all or part of the project.
These include Contractor Markups or Owner Costs.

Drag To click and hold down the mouse button on a location to be
selected, then move the cursor pointer (while still holding the
mouse button down) to a destination location.

Drop To position the mouse cursor over a target location and release
the mouse button, thus transferring information at that location.

Element, Title A title at any hierarchy level plus all of the subtitles and detail
items beneath it.  If a database hierarchy is envisioned as a tree
structure, then a title element can be said to represent one branch
of that tree.

Estimate Type A selection which determines which options are used for pricing
and repricing the project database.  The options include: U - Unit
Costs, No Crews; K - Crews with Reprice Key; A - Crews with
Auto Reprice; C - CACES Mode (with Auto).
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Grid Panel An area in the bottom portion of an MCACES three-panel
display.  The Grid Panel contains either title or detail items.  It is
the primary panel for performing work with a database.  An item
must be highlighted in the Grid Panel before modifications can
be made to that item.  Items highlighted in the Grid Panel are
always one level below whatever is highlighted in the Outline
Panel.

Hotspots Areas on the window denoted by either an icon or different
colored text, which cause operations to occur when selected by a
mouse click.

Indirect Costs Prime contractor markups which are distributed over an entire
project estimate or some portion of an estimate.  Indirect costs
can include contractors’ overhead, profit, and bond as well as
other distributed costs.

Level The relative position of a title in the database hierarchy.  The top
level is considered level 1, and the lowest is level 6 in the project
database hierarchy.

Notes/Reference Panel An area in the upper right portion of an MCACES three-panel
display.  The Notes/Reference Panel brings any of several
features within easy reach.  In addition to Notes, this panel can
also show Cost Summary, Owner Markups, or Adjust Pricing at
various title levels.

Outline Panel An area in the upper left portion of an MCACES three-panel
display.  The Outline Panel shows a hierarchical breakdown of
titles in the selected database.  It provides ways to navigate
through the titles, as well as a display of descriptive data for each
title entry.

Owner Cost Level Identifies the default project level (0-6) at which owner costs
such as Contingency and Escalation will be applied.

Owner Costs Owner Costs may include escalation, contingency, supervisory
costs, and so on.  Like Indirect Costs, they are distributed over
all or part of a project.  Owner Costs are computed after cost to
owner (Direct plus Indirect Costs) and are used to estimate costs
outside typical construction contracts.

Parent Item An item in the database hierarchy at a level immediately above
another item.

Project Cost Sum of Direct, Indirect, and Owner costs for the project.
Sometimes call Total Project Cost.
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Pulldown List A vertical list of selections which is “pulled down” by clicking
with the mouse or pointing device on the down arrow next to the
name of the menu item.  The particular selection is made by
moving the mouse down the list and highlighting the item
desired.  The keyboard may also be used to make selections from
a Pulldown List.

Scroll Bars Indicators found to the right and bottom of a window which
contains more than one screen’s worth of data.  Scroll bars are
provided as an easy method of navigating vertically or
horizontally through the data, using a mouse or other pointing
device.

Status Bar A line at the bottom of the MCACES window which displays
prompt messages.  These messages provide help at each step of
use, and will vary depending on the operation being performed.

Tabbed Dialog Box A series of overlapping dialog boxes with names of each on file-
type tabs at the top of each panel.  Each of the panels can be
selected by clicking the pointing device on the appropriate tab.

Template A prototype estimate (with or without titles) used to begin a new
estimate from scratch. Note that any existing estimate may be
used as a template.

Title Items A record type for categorizing costs in a database.  Also applies
to the database record representing that category.  Up to six
levels of titles can be defined in a project database hierarchy.

Toolbar A row of buttons across the top of the MCACES screen, where
each button contains a graphical representation of a function to
be performed.  The toolbar provides a quick way to select the
most frequently used features of MCACES, using a mouse or
other pointing device.

Windows Clipboard A storage area used by Windows to store data which has been
placed there by a cut, copy, or other operation.  The data may
then be pasted or otherwise placed in a target location.

Work Breakdown
Structure (WBS)

The overall hierarchy breakdown used in an MCACES estimate.
Each level has a number, and each entry has a unique identifier.
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Appendix B

File and Location Information

The following is a list of each directory utilized by MCACES and the files
installed on each.  This list assumes the default installation path of C:\TRACES.
Directory of C:\WINDOWS\SYSTEM

CMDIALOG VBX VBX Custom Controls
SPIN     VBX
SSDATA2  VBX
SSIDXTAB VBX
THREED   VBX
TRUEGRID VBX
COMMDLG  DLL Dynamic Link Libraries
COMPOBJ  DLL
CTL3D    DLL
MFC250   DLL
MFCO250  DLL
MFCOLEUI DLL
MSAJT112 DLL
MSAJT200 DLL
OLE2     DLL
OLE2CONV DLL
OLE2DISP DLL
OLE2NLS  DLL
OLE2PROX DLL
STORAGE  DLL
TYPELIB  DLL
VBDB300  DLL
VBOA300  DLL
VER      DLL
XBS200   DLL
STDOLE   TLB
OLE2     REG OLE 2.0 Registration File

Directory of C:\WINDOWS

MCACES   INI MCACES Initialization File

Directory of C:\TRACES\MCACES

AWARE    VBX VBX Custom Controls
AWAREBB  VBX
AWAREMM  VBX
FPTAB11  VBX
SSPP20   VBX
CB5NTX   DLL Dynamic Link Libraries
DUNZIP   DLL
DZIP     DLL
FPRUN300 DLL
MFWCC    DLL
MFWRL    DLL
MFWRW    DLL
MFWUT    DLL
MCACES   EXE MCACES Executable File
MCACES   HLP MCACES Help File
MFWDLOGS EXE MCACES Dialogs Executable File
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README   TXT Readme Information File
MFWSETUP LOG Installation Log File
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Directory of C:\TRACES\MCACES\DATA

            Used for Database Storage

Directory of C:\TRACES\MCACES\EQTABLES

APPD-A   TXT Equipment Data Files
APPD-B   TXT
APPD-C   TXT
APPD-D   TXT
APPD-G   TXT
APPD-L   TXT
APPD-M   TXT
APPD-P   TXT
APPD-R   TXT
APPD-S   TXT
APPD-T   TXT
APPD-W   TXT

Directory of C:\TRACES\MCACES\PROJECT

CHAPELPB DBF Military Programs Sample Project Files
CHAPELPB DBT
CHAPELPP DBF
CHAPELPP DBT
MILEXMPB DBF
MILEXMPB DBT
MILEXMPP DBF
MILEXMPP DBT
MILEXMP2 DBF
MILEXMP2 DBT
CIVEXMPB DBF Civil Works Sample Project Files
CIVEXMPB DBT
CIVEXMPP DBF
CIVEXMPP DBT
CIVTMPPB DBF Civil Works Template Files
CIVTMPPB DBT
CIVTMPPP DBF
CIVTMPPP DBT
HTWTMPPB DBF HTRW Template Files
HTWTMPPB DBT
HTWTMPPP DBF
HTWTMPPP DBT Military Template Files
MILTM2PB DBF
MILTM2PB DBT
MILTM2PP DBF
MILTM2PP DBT

Directory of C:\TRACES\MCACES\TABLES

AROFVM   TXT Equipment Information Text Files
BEARPOWS TXT
BFILLFCT TXT
COTRCFCT TXT
CRVSUPEL TXT
GRDEGPER TXT
SPEEDCNV TXT
SVLFACTS TXT
TROLREST TXT
WGTOFMAT TXT
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Directory of C:\TRACES\MCACES\REPORTS

            Used for Storage of Export Calculations Files

 Directory of C:\TRACES\MCACES\SYSDATA

BSDTMPAA DBF MCACES System Data Files
BSDTMPAA DBT
BSDTMPAD DBF
BSDTMPAF DBF
BSDTMPAF DBT
BSDTMPAR DBF
BSDTMPAS DBF
BSDTMPAS DBT
BSDTMPAT DBF
BSDTMPCC DBF
BSDTMPCC DBT
BSDTMPCW DBF
BSDTMPCW DBT
BSDTMPEE DBF
BSDTMPEE DBT
BSDTMPEQ DBF
BSDTMPEQ DBT
BSDTMPLL DBF
BSDTMPLL DBT
BSDTMPLR DBF
BSDTMPLR DBT
BSDTMPMD DBF
BSDTMPMG DBF
BSDTMPMG DBT
BSDTMPMM DBF
BSDTMPMM DBT
BSDTMPMO DBF
BSDTMPMO DBT
BSDTMPMR DBF
BSDTMPMT DBF
BSDTMPP2 DBF
BSDTMPP2 DBT
BSDTMPP6 DBF
BSDTMPP6 DBT
BSDTMPP8 DBF
BSDTMPP8 DBT
BSDTMPPB DBF
BSDTMPPB DBT
BSDTMPPD DBF
BSDTMPPH DBF
BSDTMPPH DBT
BSDTMPPP DBF
BSDTMPPP DBT
BSDTMPPR DBF
BSDTMPPT DBF
BSDTMPPW DBF
BSDTMPU5 DBF
BSDTMPU5 DBT
BSDTMPU7 DBF
BSDTMPU7 DBT
BSDTMPUD DBF
BSDTMPUD DBT
BSDTMPUT DBF
BSDTMPUT DBT
BSDTMPUV DBF
BSDTMPUV DBT
CG_HLPHI DBF
CG_HLPHI DBT



File Locations and Sizes B-5

CATCODES DBF
UOMCODES DBF
APPD     DBF NAT95A Equipment Files
APPE     DBF
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Appendix C

Microsoft Windows Tips

The following is a list of tips on the use of Microsoft Windows for users new to
this environment.  For additional help, consult the Basic Skills section of the
Microsoft Windows User’s Guide.

Using a Mouse

Learning to use a mouse (or other available pointing device) is an important step
in becoming proficient in the Windows environment. Since Windows was
designed to be used with a pointing device, most operations are much easier and
faster using one.  Almost all operations can still be performed with a keyboard,
but using a mouse is the preferred method, and becomes quite natural after some
practice.

The two most frequently operations used are point and click.  Pointing means
moving the mouse, and thus the pointer on the screen to a particular location of
interest.  The click (depressing the left mouse button) is then normally used to
select an item of data or operation.

The double click (depressing the left mouse button twice in succession) is often
used for selection of items in file menus and other similar user selections.

The drag operation means holding down the left mouse button while moving
across a series of items, thus selecting all of them.  Often the term drag and drop
is used, meaning to select a group of items by dragging and then placing them in
another location as a group (dropping).

Menus

Menus provide a convenient method for choosing an operation to be performed
from among a large list of choices.  Windows menus are known as pull-downs,
providing a logical and consistent grouping of options in a series of vertical lists
found on the top of a window. Menus can be accessed using either the mouse or
keyboard.

Tool Bars

Tool Bars provide a shortcut method to initiate operations without having to make
selections from the menu.  Icons on the face of the buttons provide a pictoral
representation of what function is to be performed.  The mouse is used to click the
appropriate button.
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Dialog Boxes

A Dialog Box is displayed on top of your main windows screen.  It is usually
smaller than full screen size, and normally provides options and input fields for
the user to fill in.  Menu selections will often bring up dialog boxes for the input
of needed information.  Menus and toolbars on the screen under a dialog box
cannot normally be accessed when a Dialog box is active; the Dialog Box must
first be closed.

Scroll Bars

Scroll bars may be found to the right and bottom of screens and are provided as an
easy method of navigating through lists, documents, selections, etc.  The mouse
can be used to click on the arrows for small moves, or within the scroll bar on
either side of the placement button for large moves.  The placement button may be
moved directly for movement relative to the beginning or end.

Resizing Windows

Windows may be resized in a number of ways.  Resizing can be used to display
more than one window or dialog box on the screen at once.  The Minimize and
Maximize buttons are located in the upper right hand side of the Windows screen.
Incremental sizing is usually accomplished by dragging the lower right hand side
of the window.  Windows may be moved by dragging the Title Bar at the top of a
window.
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Appendix D

Error and Informational Messages

The following is a list of error messages in MCACES, along with an explanation and
possible corrective action.

Message Explanation

20 - Creating File An error was encountered during a database file creation.
May be caused by having a FILES= value in
CONFIG.SYS too small.   If increasing that value does
not correct the error, notify Building Systems Design.

60 - Opening File An error was encountered during a database file open
operation.  May be caused by having a FILES= value in
CONFIG.SYS too small. If increasing that value does not
correct the error, notify Building Systems Design.

70 - Reading File An error was encountered during a database file read
operation.  Try performing a Reset Index operation.  If the
error persists, notify Building Systems Design.

490 - Unrecognized Value An internal software error was encountered during a
database operation. Please report to Building Systems
Design if you receive this message.

910 - Unexpected Information An internal software error was encountered during a
database operation. Please report to Building Systems
Design if you receive this message.

930 - Unexpected Parameter An internal software error was encountered during a
database operation. Please report to Building Systems
Design if you receive this message.

A change made to the data was not
saved - NOT a Fatal Error

An informational message.  Please report to Building
Systems Design if you receive this message.

Another user or process has the data
locked.

Another program is sharing the MCACES Data and has
locked the data temporarily.  Examples are: MCACES
Gold or MCACES Schedule Interface (which you may be
running under Windows) or another user on your local
area network running MCACES for Windows.

Are you sure you want to stop
processing?

You clicked the cancel button on a process such as
repricing a database.  The process will not be complete if
you confirm this message.

Are you sure you wish to delete the
current modifier line?

You are asked to confirm deletion of the current modifier
line.  Project modifier lines cannot be undeleted.
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Message Explanation

Cannot add this record because the ID is
invalid. No titles can be added at this
level  (under specified parent title).

For the Id you chose to be legal, it must be added at a
different level.  Choose another ID.

Cannot add this record because the ID is
invalid. There is no title this ID can be
added under.

Because of the existing ID structure in the database title
file, the ID you chose is illegal.  Choose another ID.

Cannot add this record because the ID is
invalid. Title has subtitles and cannot
accommodate non-title items.

The ID you chose is not valid for a detail item because the
title it falls under has subtitles.  Choose another ID.

Cannot add this record because the ID is
invalid. To add a title here you must be
at specified level.

Because of the existing ID structure in the database, a title
with this ID cannot be added at this level.  Choose another
ID.

Cannot run the application from initial
directory due to an error changing
directories.

You are using Customize Tools and the directory you
specified cannot be located.

Cannot run the application from initial
directory due to an error changing
drives.

You are using Customize Tools and the drive you
specified cannot be located.

Cannot save the current record because
the specified ID already exists. Enter a
different ID.

You have selected an ID that already exists or have
revised the default ID.  Choose another ID.

Changing this value may disrupt smart
assembly linkages prepared in
MCACES Gold. Are you sure?

The software has detected a Smart Assembly constructed
using MCACES Gold.  Proceeding may cause errors in
the Smart Assembly relationships should you continue to
use them in MCACES Gold.

Corrupt Data - Project Header is
Corrupt.

The Project database files have been damaged.  Restore
from a backup version to resume operation.

Could not Locate File.  Unable to Start
Application.

You are using Customize Tools and the executable you
specified cannot be located.

Mark for deletion this item and all
subordinate items. Are you sure?

You are asked to confirm deletion of one or more
subordinate items.

More levels of hierarchy are defined in
the source of your copy action than in
the target.  Should the software
automatically define new levels in the
target based on the source hierarchy?

To copy the project element you have selected without
losing title levels, the software must create additional
levels in the project you are copying to.

No modifiers in the currently selected
Unit Price Database can be applied to
the current Unit Price ID.

The Unit Price ID for this project detail item does not
have any modifiers that can affect it.

No preceding (following) item exists at
the Grid Panel's current level.

You are using the  buttons to move the Grid
Panel to the preceding (or following) group, and no items
preceding (or following) the current group exist.
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Message Explanation

No unit of measure conversion is
available between two items. No
conversion was performed.

You have changed the UOM on a detail item and the
system cannot convert the costs from the old UOM to the
new UOM.

OLE 2.0 initialization failed.  Make sure
that the OLE libraries are the correct
version.

One or more OLE 2.0 system files necessary to perform
this operation are not the correct version or cannot be
found.  Check for accidental deletion / modification of
files or reload the software.

Project is in Gold 5.20 or earlier format.
Use Gold 5.30 to convert.

You are attempting to load an MCACES Gold 5.20
project file.  MCACES for Windows cannot automatically
convert this file for use.  Please use MCACES Gold 5.30
software to perform this conversion.

Some of the records to be copied under
title ID could not be copied because
there are no additional legal ID's that
can be generated under that title.

Because of the existing ID structure in the database, the
record(s) cannot be copied.  Project titles are being copied
into a level for which the ID length is one character only,
and all available character Ids are used up.

The database is already open. You a attempting to open a database which you previously
opened.

The exported calculations have been
saved to specified file IDs.

An informational message which informs you of the path
and file names where the exported files are located.

The field  was not located - Fatal Error. You should not receive this message during normal
operation.  Please contact Building Systems Design if you
should receive it.

The file could not be opened as a text
file.

The Get from Table operation cannot properly open a
database in other than ASCII text format.  The Get From
Table dialog box defaults to text files with a .TXT
extension.

The file is too long to be read in its
entirety. The first 32,766 characters will
be read.

The Get from Table operation requires an ASCII text
format file less than 32K in size.

The Gold Help File CG_HLPHI.DBF is
missing from the SYSDATA
subdirectory.  Profit-Weighted
Guidelines will use default values.

A file necessary for Profit Weighted Guidelines cannot be
located where expected.  It may have been accidentally
deleted or moved.  Reinstall the software to make use of
other than default values in the future, or use DOS copy or
File Manager to copy CG_HLPHI.* from an existing
MCACES Gold installation.

The Gold Help File CG_HLPHI.DBF is
missing Profit and Bond data. Default
values will be used.

The CG_HLPHI file has likely been corrupted.  Reinstall
the software to make use of other than default values in
the future.

The ID you entered does not match the
title you are currently under. Do you
wish to add the item under this Title?

When adding data to supporting databases, the ID of an
item being added under a title normally conforms to the
ID of the title above it.  If you confirm, the software will
attempt to add the item based on the ID you have entered.
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Message Explanation

The item was not repriced because an
associated Crew database could not be
located.

A Crew Database necessary for repricing could not be
located.  Check to see if the database has been moved or
deleted, or open another Crew Database.

The item was not repriced because an
associated Labor or Equipment database
could not be located.

A Labor or Equipment Database necessary for repricing
could not be located.  Check to see if the databases have
been moved or deleted, or open another Labor or
Equipment Database.

The item was not repriced because no
Crew is associated with the item.

The Crew ID is blank or N/A.

The item was not repriced because the
Crew Id could not be located in the
selected Crew database.

A Crew Database was located, but an entry matching the
Crew ID in the item could not be found.

The item was not repriced because the
hourly output is zero.

If an item has an hourly output of zero, no repricing will
be done.

The item was not repriced because the
Labor or Equipment Id could not be
located in the selected database.

An entry matching the ID in the item in the Labor or
Equipment databases could not be found.

The line on which the cursor is placed
does not have a valid subcategory code.
No information has been transferred.

Using Get from Table to copy Appendix D information
into a new Equipment Item, the selected line must have a
subcategory code other than 00 or blank in order to be
transferred into the new equipment item.

The simple assembly could not be
updated because the data remained
locked by another user or process.

Another program is sharing the MCACES Data and has
locked the data temporarily.  Examples are: MCACES
Gold or MCACES Schedule Interface (which you may be
running under Windows) or another user on your local
area network running MCACES for Windows.

The Subcategory Code you entered does
not represent valid EP data for the
current Equipment ID.  The item is
being treated as outside EP 1110.

Only items containing valid subcategory codes can be
entered for the current Equipment ID for the rates to be
automatically calculated by the software.  The item is
being treated s “non-EP”, i.e. the software allows direct
entry of equipment rate components.

The total tire cost exceeds allowable
value.

Check allowable tire cost parameters in EP 1110.

The specified year will be used. The
equipment is overaged.

Equipment determined to be overaged will have a year
automatically assigned, based on the date of the
Equipment database.

There is not room to insert the required
number of records at the location you
specified.  Place the records at the end
of the currently displayed group?

When copying data items to the Project Database, there
was not enough room given the current ID numbering to
insert the items.  You have the option to copy the items at
the bottom of the group.

This detail item is linked to its parent
title. Do you want to change the ratio of
the item to its parent?

You have attempted to change a quantity on a detail item
in a simple assembly.
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Message Explanation

This item has a reference to other data
as part of a smart assembly. Do you
want to convert its reference to no
reference?

You are attempting to change a quantity which, in the
MCACES Gold-generated Smart Assembly, is dependent
on other data.  Confirming will break this Smart
Assembly link.

This item has already been added. Use
the move (Cut+Paste or Shift+
Drag/Drop) capability instead.

Cut + Paste and Shift+Drag/Drop of existing items can be
used to make room to add the item where desired.

This item's quantity is dependent on
another value in a smart linkage.
Confirm changing the quantity and
adjust the ratio accordingly?

You are asked to confirm changing an item’s quantity and
ratio when a dependency exists to an MCACES Gold-
generated Smart Assembly linkage.  The linkage will not
be broken but the ratio will change.

To provide a full display of the Cost
Summary Panel, the estimate must be
recalculated.  Proceed to recalculate?

The Cost Summary Panel may require recalculation of the
Project Database for all fields to be available for display,
in order to create a “PJ” file containing complete markup
information.

Unable to create HCAS record. A problem occurred when attempting to create an HCAS
entry.  Check the HCAS documentation section for
information on requirements.

Unable to open  Material backup files. The Material Backup database files cannot be located. If
damaged or lost, restore from a backup version to resume
operation.

Undo marks for deletion for this item
and all subordinate items. Are you sure?

Say Yes to UNDELETE a title and all subordinate items.

Windows returned an error code when
attempting to start the specified file.

A Windows error occurred when attempting run an
executable file specified in Customize Tools.  Check to
insure the executable will run under Windows.

You cannot add a title with this ID
because it would 'capture' titles that
already have a parent title.

In supporting databases, the ID of an item being added
under a title must conform to the ID of the title above it

You cannot add this title here - To add
an item with this ID you must be at the
specified level.

Because of the existing ID structure in the database, the
record with this ID cannot be added at this level.

You cannot add titles. Your titles
database appears to have levels out of
sequence. Try reindexing the database.

The database appears to be damaged.  If reindexing the
database does not correct the problem, restore from a
backup copy of the database.

You cannot copy a record to itself. You have attempted to copy an item to its own ID in a
drag / drop or copy / paste operation.
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Message Explanation

You cannot Move records between
different databases (i.e., automatically
delete records at the point of origin). Do
you wish to proceed with Copying
instead?

You have used the Cut command in one window together
with paste in a different window, or depressed the shift
key while dragging between two databases.  The deleting
of records left behind only takes place in same-database
operation.  Confirm if you want a copy of the records
placed in the new database.

You have previously marked records for
copying in this database.  Do you want
to retain those records for copying along
with those just selected?

If you use the copy command to copy one or more records
in a database and then do not paste those records before
using copy again in the same database, the software
allows you to retain those earlier records on the clipboard
for later pasting.  Confirm to retain the earlier copied
records or choose No to remove them from the clipboard.

You must enter a Contractor ID to add a
new Contractor.

A Contractor cannot be added without an ID.

You must select (highlight) a row or
part of a row in order to choose
equipment.

In using Get from Table to transfer Appendix information
to a new piece of equipment, you must highlight part of
the row using a mouse drag or shift + arrow keys
operation in order to “copy” the line for the piece of
equipment.

You must select (highlight) text in order
to copy it to the clipboard.

The Copy command will only operate if text or items have
first been selected.
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Appendix E

Valid Units of Measure

Introduction

The following tables list the Metric and corresponding  U.S. units of measure
recognized by MCACES, along with their abbreviations.  Use these abbreviations
in the Unit of Measure fields on MCACES screens to assure proper calculation of
values.

Area

Metric U.S.

Abbrv. Unit Abbrv. Unit

CM2 Square Centimeters SI Square Inches

M2 Square Meters SF Square Feet

CSF 100 Square Feet

MSF 1000 Square Feet

SY Square Yards

CSY 100 Square Yards

MSY 1000 Square Yards

HEC Hectars ACR Acres

KM2 Square Kilometers MI2 Square Miles
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Distance

Metric U.S.

Abbrv. Unit Abbrv. Unit

MM Millimeters IN Inches

CM Centimeters FT Feet

M Meters YD Yards

LF Liner Feet

VLF Vertical Linear Feet

CLF 100 Linear Feet

MLF 1000 Linear Feet

KM Kilometers MI Miles (Statute)

Flow

Metric U.S.

Abbrv. Unit Abbrv. Unit

CCS Cubic
Centimeters/Second

CMM Cubic
Meters/Minute

CFM Cubic Feet/Minute

CMH Cubic Meters/Hour MF3 1000 Cubic
Feet/Minute

Liquid

Metric U.S.

Abbrv. Unit Abbrv. Unit

LIT Liters GAL Gallons (US)
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Miscellaneous

ABBRV. UNIT

EA Each

LS Lump Sum

SET Set

PR Pair

OPN Opening

FLR Floor

SQ Square (Roofing)

SEA Seat

RSR Riser

LAN Lane

BBL Barrel

Time

ABBRV. UNIT

HR Hours

DAY Days

WK Weeks

MO Months

YR Years
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Volume

Metric U.S.

Abbrv. Unit Abbrv. Unit

CC Cubic Centimeters CI Cubic Inches

M3 Cubic Meters CF Cubic Feet

CCF 100 Cubic Feet

MCF 1000 Cubic Feet

CY Cubic Yards

CCY 100 Cubic Yards

MCY 1000 Cubic Yards

BF Board Feet

MBF 1000 Board Feet

Weight

Metric U.S.

Abbrv. Unit Abbrv. Unit

G Grams OZ Ounces

KG Kilograms LB Pounds
(Avoirdupois)

MT Metric Tons TON Tons (Short)
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INDEX

A
About MCACES for Windows, 16-12
Actual Price, 13-9
Add New Record, 16-7
Adding Additional Titles at Same Level, 6-3
Adding Subtitles, 6-4
Adding Titles, 6-2
Adjust Pricing, 4-14, 6-35
Adjust Pricing Panel, 6-36, 6-40
Adjusting Crew Output, 6-29
Adjusting Linked Values, 6-35, 6-45
Alternate Costs, 5-27, 6-47
Amount, Column Type 7-10
Applying Different Rates, 6-14
Apprentice, 11-11
Apprentice Percentage, 11-14
Area Factors Tab, 13-13
Arrange Icons, 16-11
Assemblies, 6-42
Assemblies Database, 14-1
Assemblies Database References Tab, 14-11
Assemblies Database Structure, 14-3
Assemblies General Tab, 14-11
Assembly Detail Item Form, 14-7
Assembly Detail Items, 14-7
Assembly Summary Information, 14-10
Assembly Title Levels, 14-6
Assist, 7-15
Attachments 1 and 2, 13-10

B
Backup, 6-20
Backup Reports, 15-46
Basic Rate, 12-8
Begin a New Project window, 5-3, 5-4
Bond Class, 7-12
Bond Column, 5-23
Bond Costs, Computing, 7-12
Bond Data, 7-12
Breakdown Structure, Setting, 5-26
Building a Sample Estimate, 3-18
Building Systems Classification, 14-1
Building Systems Design, 1-1
Button, A-1

C
Calculation Tab, 4-19, 15-6
Calculation Tab, Accessing, 5-12
Cancel Deletion, 6-27
Canceling and Erasing Data, 6-5

Cascade, 16-11
Category Code, 6-9
Child Item, A-1
CIVEXM Project, 5-6
Close, 15-18, 16-6
Cntr, 4-9
Col Type, 5-25
Collapse Branch, 16-9
Column Setup Tab, 4-19
Column Setup Tab, Accessing, 5-19
Column Title, 5-25
Column Titles, 5-20
Column Types, 5-20
Compounded Cost Markups, 7-3
Configuration Controls, 4-4, 4-7
Construction Specifications Institute (CSI), 10-1
Construction Time, Estimated, 5-16
Contents, 16-12
Context-Sensitive Help, 17-15
Contingency Column, 5-24
Contingency Notes, 7-21
Contract Costs, A-1
Contractor, 6-9, 6-19, 7-5, 10-6
Contractor Direct Summary Report, 15-35
Contractor Ids, 7-8
Contractor Indirect Summary Report, 15-32
Contractor Item Form, Accessing, 7-5
Contractor Markups Tab, 7-6
Contractor Markups, Adding, 3-14
Contractor Override, 6-9
Contractor Settings Report, 15-50
Contractor Summary Reports, 15-32
Contractor Tiering, 7-3
Contractors' Costs, 7-2
Contractors, Applying to Costs, 7-16
Contractors, Default, 7-17
Contractors, Defining, 7-5
Contractors, Override, 7-17
Copy, 16-7
Copy a Project or Assemblies Database Item, 6-13
Copy and Paste, 9-6
Copy Database, 16-6
Copying a Crew as an Assembly, 6-31
Copying a Labor or Equipment Item, 6-14
Copying a Unit Price Database Item, 6-12
Copying an Assembly into Project, 6-42
Copying from the Windows Clipboard, 5-30
Cost Items, Adding, 6-12
Cost Markups, 15-21
Cost Override, 6-9
Cost Override Field, 14-9
Cost Summary, 4-13
Cost to Owner, 4-9, A-1
Cost to Prime, 4-9, A-1
Cost to Prime, Extended Cost, 6-8
Cost to Prime, Unit Cost, 6-8
Cost-of-Money Rate (Adjusted), 13-14
Cost-of-Money Rate (Full Rate), 13-14
Costs Tab, 6-7, 6-18
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Creating Your Own Cost Item, 6-15
Crew, 4-9, 6-17, 10-6
Crew Costs in Tandem, 6-30
Crew Costs, Calculating, 6-33
Crew Detail Items, 11-8
Crew ID, 11-10
Crew Information in the the Grid Panel, 11-9
Crew Summary Information, 11-13
Crew Summary Reports, 15-48
Crew Totals, 11-12
Crews, 6-31, 11-14, 14-12
Crews as Assemblies, 6-10, 6-31, 11-6
Crews Database, 11-1
Crews Database, Structure, 11-2
Crews, Reference, 11-4
CSI Classification, 14-2
Currency Description, 5-13, 5-17, 11-14, 12-9, 13-13,

14-11
Currency Fields, 10-11
Currency Symbol, 11-14, 12-9, 13-13, 14-11
Currency Units, 5-13, 5-18, 11-14, 12-9, 13-13, 14-11
Currency Units/US $, 5-13, 5-18, 11-14, 12-9, 13-13,

14-11
Customize Grid, 16-10
Customize Tools, 16-10
Cut, 16-7

D
Database ID, 4-10, 6-6, 6-17, 10-11, 11-10, 14-8
Database Listings, 15-52, 16-6
Database References, 5-13, 5-17, 15-7
Database References Tab, 10-11
Database, Opening, 9-2
Databases, MCACES, 2-4
Date, 10-9
Date Filter, 15-13
Default Data, 6-4, 6-15
Default Mat'l, 10-9
Default Productivity, 11-14
Default Rate, 12-7, 13-9
Delete Current Record, 16-7
Delete, 16-6
Deleting Cost Items, 9-7
Deleting Titles, 9-7
Deleting Titles or Items, 6-26
Depreciation, 13-9, 13-10
Designed By, 5-10
Detail Crew Report, 15-46
Detail Item, A-1
Detail Item Form, 6-16
Detail Item Form, Material Backup Tab, 10-8
Detail Items, Adding, 9-5
Detail Level - Crew Members, 11-4
Detail Report, 15-21
Detail Report Example, 15-22
Detailless Assemblies, 14-9
Dialog Boxes, 2-5, A-1
Diesel Cost per Gallon (Off Road), 13-14
Diesel Cost per Gallon (On Road), 13-14
Diff, 7-15

Differences from MCACES GOLD, 2-9
Direct Cost, 4-11
Direct Costs, 15-9, A-1
Display, Modifying, 4-16
Distributed Costs, A-1
Division Direct Summary Report, 15-38
Division Indirect Summary Report, 15-40
Division Owner Summary Report, 15-40
Division Summary Reports, 15-38
Down Arrow, 4-7
Drag and Drop, 9-6, A-1
Duration, 4-9, 6-10, 6-21
Duration Unit of Measure, 6-10

E
Econ. Key, 13-8
Edit Menu, 16-7
Editing a Title or Detail Item, 6-26
Editing Cost Items, 9-7
Editing Database Summary Information, 9-8
Editing Titles, 9-7
Eff. Pricing Date, 5-10
Electricity Cost Per KWH, 13-14
EP-1110-1-8, 13-1
Equip, 11-12
Equip Hours, 11-12
Equip Hours (Eq hr), 11-10
Equipment, 5-21, 10-7, 11-14, 14-11
Equipment Average, 11-11
Equipment Backup Reports, 15-49
Equipment Cost, 11-11
Equipment Costs, 13-6
Equipment ID, 13-8, 13-9, 13-10
Equipment Rate Detail Items, 13-6
Equipment Rates Database, 13-1
Equipment Rates Database Structure, 13-2
Equipment Rates Title Levels, 13-5
Equipment Severe, 11-11
Equipment Standby, 11-11
Equiv Wt, 10-8
Equiv. Shipping Wt, 6-20
Escal. Index Date, 5-10
Escalation Column, 5-24
Escalation End, 7-20
Escalation Fields, 7-20
Escalation Start, 7-20
Est. Construction Time, 5-12
Estimate Type, 5-6, 5-12, 15-6, A-2
Estimate Type A, 5-15
Estimate Type and Repricing, 5-14
Estimate Type C, 5-16
Estimate Type K, 5-15
Estimate Type U, 5-14
Estimate Type, Changing, 5-16
Estimate Type, Selecting, 5-14
Estimated By, 5-10
Estimating Process, Overview, 4-1
Existing Projects, 8-1
Exit, 16-6
Expand Branch, 16-9
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Expand Title, 16-9
Expand/Collapse, 2-13
Export Calculations, 16-10
Extended, 6-18
Extended Cost, 6-7

F
Facilities Capital Cost of Money, 13-9, 13-10
Field Type, 5-24, 5-25
File Menu, 16-6
File Path, 5-10, 10-11
Filling in the Item Form, 6-5
Find Keyword, 6-24
Find Keyword, Using, 3-12
Find What, 6-24
Find, 16-7
First Alternate ID, 15-8
FOG Extra, 13-11
Foreman, 11-11
Foreman Additional Amount, 11-14
Format Columns Tab, 15-9
Format Detail Tab, 15-11
Freeze Button, 4-6
Freight Rate Tab, 13-14
Freight Rates, 13-14
Fringe Benefits, 12-8
Fuel Type, 13-10

G
Gasoline Cost Per Gallon, 13-14
General Information (General Tab), 5-9
General Tab, 4-19
General Tab, Editing, 5-10
Go to Child, 4-4, 16-9
Go to Parent, 4-4, 16-9
Grid Panel, 2-4, 4-6, 16-8, A-2
Grid Panel Display, Customizing, 4-11
Grid Panel, Navigating, 2-13
Grid Symbol, 4-6
Grid Title Bar, 4-6, 16-8

H
HAG, 2-16
Hardware Requirements, 1-2
HCAS, 6-9
Help Menu, 16-12
Help System, 2-7, 17-12
Help Table of Contents, 17-14
Historical Analysis Module, 2-16
Horizontal Scroll Bar, 4-7
Hot Spots, 2-13, A-2

I
ID, 6-35, 14-6
ID’s Filter, 15-13
Indirect Cost Columns, 5-25

Indirect Costs, 7-2, 15-9, A-2
Inherited Characteristics, 5-1
Insert New Record, 16-7
Invest, 7-15
Issue Date, 10-11
Item, 6-25
Item Form, 4-18, 16-8

L
L/E Type, 6-22, 11-11
Labor, 4-9, 5-21, 10-7, 11-12, 11-14, 14-11
Labor Adjustment Factor (LAF), 13-13
Labor Backup Reports, 15-48
Labor Cost, 11-11
Labor Cost-to-Prime Backup Report, 15-49
Labor Hours, 11-12
Labor ID, 12-7
Labor Rate Detail Items, 12-6
Labor Rates Database, 12-1
Labor Rates Database, Structure, 12-2
Labor Rates Detail Item Form, 12-6
Labor Rates Summary Information, 12-9
Labor Title ID, 12-5
Laborer, 11-11
Level, A-2
Level 1 Titles, Creating, 3-4
Level 2 and Lower Titles, Creating, 3-5
Level Name, 5-28
Life Cycle Cost Module, 2-17
Link as Assembly, 6-9
List Price, 13-9
Load from Compressed, 16-6
Locate Selected Template, 5-4
Location of Files, 1-5
Lookup, 16-11

M
Manhours, 4-11, 5-20
Manhrs, 10-7
Mat’l Update, 4-11
Material, 5-21, 10-7, 10-9
Material Backup Tab, 15-13
Material Price Updated, 6-22
Material Updated, 10-9
Maximize Window, 2-14
MCACES GOLD, 2-16
MCACES GOLD 5.30, 1-1
MCACES ID, 5-10
Measurement, 5-13, 5-17, 10-11
Member Override, 11-11
Member Quantity, 6-32
Menu Bar, 2-4
Menus, 2-14
Method, Applying Indirect Costs, 7-10
Metric Units, 5-17
MILEXM Project, 5-6
Minimize Window, 2-15
Minus Symbol, 4-4
Mod, 4-11
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Model, 13-8, 13-9, 13-10
Modifiers, 6-20, 6-44
Modifiers, UPB, 10-12
Multiple Databases, 9-9
Multiple Databases, Display, 2-5

N
Name, 10-11, 11-14, 12-5, 12-9, 13-13, 14-11
Navigating in a Database, 9-2
Navigation, 2-11
Navigation Controls, 4-7
Network, 15-16
New Features, 2-8
New, 16-6
Next Page, 15-17
No. of Chars, 5-28
No. of Work Days, 6-11
Note, 13-8
Notes, 11-7, 12-5
Notes Tab, 4-19
Notes Tab, Accessing, 5-29
Notes/Reference Panel, 2-4, 4-12, 16-8, A-2

O
One Page / Two Page, 15-18
Open, 16-6
Operating Exp, 13-9
Operation of MCACES, 1-10
Operators 1 and 2, 13-10
Options, 15-16
Options Tab, 6-8, 6-19
Orientation, 15-16
Original Units, 5-17
Other Column Widths, 15-10
Outline Menu, 16-9
Outline Panel, 2-3, 16-8, A-2
Outline Panel, Navigating, 2-12
Outline Toolbar, 4-4
Output/HR, 6-21, 10-6
Overhead Column, 5-23
Overhead Items, 7-11
Override, 11-11
Override - Blank, 6-18
Override - Labor/Equipment, 6-18
Override - Material, 6-18
Overtime, 12-8
Overtime Differential, 6-11
Overtime Percentage, 6-11
Overtime, Adjusting for, 6-34
Ovrd, 4-11
Own Work, 7-7
Owner Cost Columns, 5-25
Owner Cost Grid, 7-19
Owner Cost Level, 5-28, A-2
Owner Cost Markups, Adding, 3-17
Owner Costs, 4-15, 7-18, 15-9, A-2
Owner Costs, Calculating, 7-20
Ownership, 13-9

P
Pack Data, 16-6
Page (Leaf) symbol, 4-4
Page Format, 15-12
Paintbrush Symbol, 10-12
Panel Display, Changing, 2-11
Panels, Hiding, 4-16
Paper, 15-16
Parameter Based Modeling, 2-16
Parent Item, A-3
Paste, 16-7
Payroll Taxes & Insurance, 12-8
PBM, 2-16
PC-Cost, 2-16
Pct %, 7-11
Percent of Running, 7-10
Period, 7-15
Plus symbol, 4-4
Preparation Date, 5-10
Prepared By, 5-10
Prev Page, 15-17
Prime Contractor, 7-3
Print Detail Columns, 15-11
Print Device, 15-19
Print Dialog Box, 15-19
Print Preview, 15-17, 16-6
Print Range, 15-19
Print Setup, 15-15, 16-6
Print, 15-17, 16-6
Printer, 15-16
Productivity, 6-10
Profit Column, 5-23
Profit Weighted Guidelines Report, 15-51
Profit Weighted Guidelines Tab, 7-14
Project Breakdown Structure, 5-7
Project Columns, 5-6
Project Columns, Naming, 5-19
Project Cost, 4-9, A-3
Project Cost, Extended Cost, 6-8
Project Cost, Unit Cost, 6-8
Project Database, 4-1
Project Database, Creating, 5-2
Project Database, Repricing, 8-5
Project Direct Cost Types, 5-20
Project Direct Summary, 15-29
Project Indirect Cost Types, 5-22
Project Indirect Summary Report, 15-26
Project Level Notes, 5-29
Project Notes, Adding or Editing, 5-29
Project Owner Cost Types, 5-23
Project Settings Report, 15-50
Project Structure, Defining, 5-7
Project Summary Reports, 15-24
Project Templates, 8-3
Project Title, 5-10
Pulldown Lists, A-3
Purchase Year, 13-9
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Q
Quantity, 4-8, 4-10, 6-6, 6-17, 14-6, 14-8
Quantity and Unit of Measure, 7-7
Quick Start, 3-18

R
Rate, 11-11, 11-12
Report Examples, 15-21
Report Header, 15-13
Report Setup, 15-3
Report Setup, 16-6
Report Title, 15-19
Report, Print Direct Cost Detail, 15-3
Report, Project Summary, 15-4
Reports, 2-7, 15-1
Reports, Load and Save Setup, 15-5
Reports, Printing, 3-19
Reports, Steps in Creating, 15-2
Reprice, 11-15, 14-12
Reprice Item Labor/Equip, 16-10
Reprice Item Material, 16-10
Repricing a Database, 9-9
Reset Index, 16-6
Reset References, 15-7
Restrict Search To, 6-24
Risk, 7-15

S
Sales Tax, 5-13, 5-17
Save Panel Layout, 16-10
Save to Compressed, 16-6
Schedule Tab, 6-10, 6-21
Scheduling Interface, 2-16
Scroll Bars, 2-14, A-3
Search for Help on, 16-12
Searching, 17-14
Select Lines to Print, 15-11
Select Reports Tab, 15-3
Selected, 10-9
Selecting the Estimate Type (Calculation Tab), 5-12
Selection Indicator, 4-4
Sequence Code, 11-11
Sequence ID, 6-17
Set Reporting Units, 15-7
Set Summaries Format, 15-7
Settings Reports, 15-50
Setup, 15-20
SHARE.EXE Considerations, 1-8
Shifts/Day, 6-11
Shipping, 5-21
Shipping Costs, 6-35, 6-39
Shipping Rates, 6-40
Shipping Summary Report, 15-45
Shipping Volume, 6-20
Shipping Weight, 6-20, 13-9
Show Markup at Level, 15-8
Show Parent Titles Only, 16-9
Single Shift Rate, 13-9

Size, 7-15, 13-10
Software Requirements, 1-2
Source, 6-20, 10-6, 11-10, 12-7, 13-8
Sources Filter, 15-14
Src, 4-10
Standby Rate, 13-9
Starting MCACES, 1-9
State Sales or Import Tax Rate, 13-13
Status Bar, 16-8, 17-15, A-3
Subbed Work, 7-7
Subcat, 13-8
Subcon, 7-15
Subcontractor, 7-3
Summary Info, 16-6
Summary Information, 4-19
Summary Information, Equipment Database, 13-12
Supporting Databases, Printing, 9-11
Symbol, 10-11
System Code, 14-5
System Direct Summary Report, 15-42
System Indirect Summary Report, 15-44
System Owner Summary Report, 15-44
System Summary Reports, 15-41

T
T/D, 6-25
Tabbed Dialog Boxes, 2-14, A-3
Template, A-3
Template, Creating, 8-4
Tile Horizontally, 16-11
Tile Vertically, 16-11
Tire Cost, 13-11
Tire Type, 13-11
Title, 6-2
Title Element, 6-2, A-1
Title ID, 4-8, 11-7
Title Items, A-3
Title Levels, 5-7, 9-4
Titles, Adding, 9-4
Tool Bar, 16-8, A-3
Toolbar, 2-4, 16-2
Toolbar Tips, 17-15
Tools Menu, 16-10
Total, 13-11
Total Hours per Day, 6-11
Total Labor Rate, 12-8
Total Markup, 7-11
Total Ownership Rate, 13-10
Total Unit Cost, 4-9
TRACES, 1-1
TRACES Applications, 2-16
Trail Sep, 5-28
Travel/Subsistence, 12-8
Type of Report, 15-13

U
U.S. Units, 5-17
Undo Record Changes, 16-7
UNIFORMAT, 14-1
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Unit Cost, 5-22, 6-7, 6-18
Unit Costs, 14-8
Unit of Measure, 6-6, 6-17, 14-6
Unit Price  ID, 10-6
Unit Price Database, 10-1
Units, 4-8, 10-6, 10-11, 11-10, 12-7, 13-8
Units/US, 10-11
UOM, 13-14
UPB, 10-1, 11-14, 14-12
UPB Database Structure, 10-2
UPB Detail Items, 10-5
UPB Summary Information, 10-10
UPB Titles, 10-4, 15-11
Update All Pricing, 16-10
Updated, 11-11, 12-8, 13-9
User Named, 5-22
Using Help, 16-12

V
Vendor ID, 10-9
Vendor Name, 10-9
Vertical Scroll Bar, 4-7

View Menu, 16-8
Volume, 10-8

W
WBS, 6-6, 7-7
WBS Definition Tab, 4-19
WBS Definition Tab, Accessing, 5-26
WBS ID, 6-6, 14-8
Weight, 10-8
What’s New, 2-8
Window Menu, 16-11
Windows Application, 2-8
Windows Clipboard, A-3
Work Breakdown Structure (WBS), A-3
Work Cat, 6-21
Working Hours per Year, 13-13

Z
Zoom In, 15-18
Zoom Out, 15-18


